Concordance®
User Guide
Concordance, version 10.22

- Getting Started
- Basic Searching
- Advanced Searching
- Saving Searches
- Basic Tagging
- Advanced Tagging
- Sorting Documents
- Editing Records
- Working with Images
- Working with Transcripts
- Concatenating Databases
- Printing
- Productions
- Protecting Data
# Table of Contents

## Chapter 1 About Concordance

1. Getting Started ......................................................................................................................... 32
   - Accessing Concordance ........................................................................................................... 32
   - Navigating Concordance ......................................................................................................... 34
   - Opening a database .................................................................................................................. 47
   - Viewing records ...................................................................................................................... 48
   - Customizing view fonts ........................................................................................................... 50
   - Defining preferences ............................................................................................................... 53

## Chapter 2 About Concordance Native Viewer

2. Basic Searching .......................................................................................................................... 70
   - About searching ...................................................................................................................... 70
   - Available search tools ............................................................................................................ 75
   - Running quick searches ......................................................................................................... 75
   - Running simple searches ....................................................................................................... 76
   - Using persistent search .......................................................................................................... 78
   - Finding attachments ............................................................................................................... 80

## Chapter 3 About Concordance FYI Server and FYI Reviewer

3. Advanced Searching .................................................................................................................. 82
   - About advanced searching ..................................................................................................... 82
   - Running full-text searches ..................................................................................................... 83
   - Using the Advanced Search panel ......................................................................................... 87
   - Running relational searches .................................................................................................. 93
   - Running complex clause searches ....................................................................................... 97
   - Searching by tally .................................................................................................................. 103
   - Searching by tags and issues ................................................................................................. 104
   - Creating a synonyms list ....................................................................................................... 105

## Chapter 4 What's New in Concordance

4. Saving Searches ......................................................................................................................... 108
   - Saving search history .............................................................................................................. 108
   - Saving search queries ............................................................................................................. 108
   - Reviewing search queries ...................................................................................................... 110
   - Running previous search queries ......................................................................................... 111

## Chapter 5 Using Concordance

5. Basic Tagging ............................................................................................................................. 112
   - About tagging ......................................................................................................................... 112
   - Tagging records ..................................................................................................................... 114

6. Advanced Tagging ....................................................................................................................... 119
   - Organizing tags ...................................................................................................................... 119
   - Creating queries from tags .................................................................................................... 122

© 2018 LexisNexis. All rights reserved.
7 Sorting Records

Sorting documents ........................................................................................................... 127
Using sorting layouts ...................................................................................................... 128
Using table layouts ......................................................................................................... 131

8 Editing Records

About editing records ....................................................................................................... 134
Creating edit layouts ........................................................................................................ 137
Editing records ................................................................................................................ 140
Formatting field text ........................................................................................................ 145
Creating new records ...................................................................................................... 147
Searching for edited records ........................................................................................... 152
Deleting records ............................................................................................................... 152

9 Working with Transcripts

About transcripts .............................................................................................................. 154
Adding Quick Marks to transcripts ................................................................................. 156
Adding notes to transcripts ............................................................................................... 156
Applying issue tags to transcripts ..................................................................................... 160
Adding attachments to transcripts .................................................................................... 162
Reviewing transcript notes ............................................................................................... 164
Printing transcript annotations ........................................................................................ 166

10 Concatenating Databases

About concatenating databases ....................................................................................... 171
Joining multiple databases ............................................................................................... 172
Indexing and reindexing concatenated databases ............................................................. 174
Saving searches in concatenated databases .................................................................... 174
Printing from concatenated databases ............................................................................ 175
Saving a concatenated file set ......................................................................................... 175
Opening a concatenated file set ........................................................................................ 176
Deleting a concatenated file set ........................................................................................ 177

11 Printing

About printing .................................................................................................................... 177
Printing documents in Concordance ............................................................................... 180
Printing options ............................................................................................................... 180
Printing individual records and transcripts ..................................................................... 180
Printing standard reports ................................................................................................. 181
Exporting Concordance data ........................................................................................... 188
Using Equivio with Concordance ..................................................................................... 191
Tallying records for reports ............................................................................................... 196
Printing transcript annotations ........................................................................................ 198

Printing documents in CNV ............................................................................................. 203
Printing individual documents .......................................................................................... 203
Printing document sets in Concordance .......................................................................... 207
Modifying print headers/footers and watermarks .............................................................. 214
Monitoring print jobs ........................................................................................................ 217

Printing in Concordance Image ....................................................................................... 218
Printing images ................................................................................................................. 218

12 Productions

About productions .............................................................................................................. 222
Learning more about productions ..................................................................................... 224
Chapter 1

About Concordance
About Concordance

Concordance® is an electronic discovery, litigation document management, and litigation support tool. Concordance makes it easy to identify, organize and analyze case-critical information so that you can collaborate and share—across your firm or around the world.

Key Benefits and Features

Concordance gives you the most effective, cost-efficient way to manage the high volume of documents—scanned paper, email and other e-documents—generated during litigation.

Here are some of the key benefits and features Concordance offers:

- Holds documents of all types
- Contains a fast and efficient search engine
- Categorizes records with folders, tags, and issues
- Secures confidential data at various administrative levels
- Integrates with other litigation technology
- Offers remote access while traveling or in the court room

Using Concordance for Document Review

Document review typically involves searching for and marking up documents:

- Relevant to turn over to opposing counsel.
- Containing privileged or confidential information that you do not want turned over to opposing counsel.
- Containing evidential information to support your case.
Concordance
Document Review Workflow

An Administrator loads a set of data into Concordance, creating the case database from which you’ll work. He or she also sets up passwords and may enable or disable certain functionality.

Typically, you’ll be assigned a set of documents to review, which may be organized for you. Your administrator will most likely set up tags in the database for categorizing documents as privileged or confidential, for example.

There are four types of data that can be loaded: electronic documents (e-docs), scanned paper documents (images and OCR text), email, and transcripts.

Reviewing & Producing Documents for Opposing Counsel

If you’re reviewing documents to produce for opposing counsel, you’ll most likely perform a page-by-page review. You might use simple search techniques on each document or just read through them. You will need to tag and mark-up documents as you review them. The objective of this review is to find those documents you do not want to produce to the other side and tag them as “privileged” or “confidential” (or redact them) so that only the appropriate information is handed over.

Reviewing Documents for Deposition or Trial

If you’re reviewing documents for evidence to support your client, you’ll be using more sophisticated searching, tagging, and document mark-up tools to analyze and review documents for key issues.

The objective of this review is to find documents that support your case, which may involve reviewing hundreds of documents to find perhaps only a dozen that you want to present as evidence.

Produce documents from Concordance for opposing counsel.

Print documents for deposition, send to CaseMap, or send to an exhibit tool for trial presentation.

© 2018 LexisNexis. All rights reserved.
### Database Capacity

<table>
<thead>
<tr>
<th>Database</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of documents</td>
<td>33 million</td>
</tr>
<tr>
<td>Concatenated databases</td>
<td>You can join up to 128 databases</td>
</tr>
<tr>
<td>Concatenated documents</td>
<td>Over four billion</td>
</tr>
<tr>
<td>Document Size</td>
<td>3 billion characters</td>
</tr>
<tr>
<td>Fields</td>
<td>250 custom fields</td>
</tr>
<tr>
<td>Characters per field</td>
<td>12 million</td>
</tr>
<tr>
<td>Database .ivt file</td>
<td>1/2 terabyte (512 gigabytes)</td>
</tr>
<tr>
<td>Database dictionary</td>
<td>1 terabyte</td>
</tr>
</tbody>
</table>

### Product Integrations

Concordance integrates with other leading industry technology tools and providers to assist you in maximizing the functionality you currently have in managing your case records and history, while allowing you to add on or transition data to other programs as you move through the litigation process.

Concordance integrates with the following tools:

- LexisNexis® Litigation Services product offerings:
  - Concordance Native Viewer
  - Concordance Image
  - FYI Server
  - FYI Reviewer
  - CaseMap®
  - LAW PreDiscovery®
  - Sanction®
- E.L. Native Review – Native review application by Electronic Legal Software
- Equivio® – Data redundancy management software by Equivio (Concordance version 10.19 or earlier)
- IPRO Tech – Litigation image viewer by IPRO Tech, Inc.
- Synthetix Search® – Linguistic patterning software by Syngence®
Chapter 2

About Concordance Native Viewer
About Concordance Native Viewer

Introduction to Concordance Native Viewer

Concordance Native Viewer allows you to view electronic files, emails, and attachments without the need to have the source software program installed. The viewer maintains the formatting of the files so that you can see them as they were originally created. The new viewer provides an easy to use interface and markup tools for the review process. You can view markup history as well as document and image information without having to switch back to Concordance.

Concordance Native Viewer 1.0 and later is compatible with Concordance, version 10.10 or later. If you have an older version of Concordance and want to use Concordance Native Viewer, please contact Concordance Sales by e-mail at LitigationSalesGroup@ReedElsevier.com or phone at 1-800-421-8398.

Key Benefits and Features

Concordance Native Viewer provides:

- Near-native review of documents and images
- A new intuitive user interface for navigating and reviewing documents
- A single Concordance Image Base (CIB) SQLite database file to store both native and image information
- Advanced markup tools to review and annotate documents and images
- Track document markups added or removed during a review
- Produce color or grayscale images to PDF or TIFF
- Silent install for installing on multiple workstations

With Concordance Native Viewer you can easily convert and view existing Concordance Image versions 3.x-5.x imagebase files. However, it is recommended that Concordance Native Viewer be used with new Concordance databases. Redlines applied to Concordance Image imagebase files prior to converting to Concordance Native Viewer Imagebase are not compatible with the new viewer and will not be converted with the image files.
Concordance
User Guide

About Concordance FYI Server and FYI Reviewer
Concordance® FYI™ Server provides a secure, centralized server, offering remote access from the Internet and from your installed Concordance software while away from the office. With FYI Server you can bring your satellite offices, co-counsel, experts and clients together to collaborate on discovery documents in real time. As an Application Service Provider (ASP), you can host data for your client’s cases.

**What is FYI Server?**

The Concordance FYI Server is a software product that provides secure, remote access to Concordance, Concordance Native Viewer, and Concordance Image through the Internet. Concordance users access databases and images as if they were accessing them from a local drive or server – there is no learning curve and generally all features work the same. FYI Reviewer™, an ActiveX control designed for Microsoft® Internet Explorer®, provides Web access to Concordance databases and is streamlined in functionality for reviewers.

Concordance version 10.x or later or FYI Reviewer version 4.x or later is required to access databases from FYI Server version 4.x or later. Concordance Native Viewer version 1.0 or Concordance Image version 5.x or later is required to access native documents and/or images. These products are licensed separately and are not included with FYI Server.

The secure, centralized FYI Server offers remote access from both a Web browser and the installed Concordance software. FYI Server is also highly optimized with data compression and RSA encryption for efficient and secure remote access, the same RSA 128-bit encryption that banks use for online transactions.

When implementing FYI Server, you are essentially installing two servers on your network with two services: one pointing to the client and one pointing to the administrator.

**Concordance FYI Server includes:**

- **FYI Server** – sends data to Concordance, Concordance Native Viewer, and Concordance Image (Opticon) clients. This is where most of the work is done.
- **FYI Administration Console Server** – works with the FYI Admin Console to control FYI Server.
- **FYI Admin Console** – user interface to manage FYI Server allowing administrators to publish databases, restrict access and change security settings, set performance parameters, and generate usage reports.

### Network Distinctions between Concordance and FYI Server:

<table>
<thead>
<tr>
<th>Differences</th>
<th>Concordance</th>
<th>FYI Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM used for processing searches, indexing databases</td>
<td>End-user machines</td>
<td>Server</td>
</tr>
<tr>
<td>Set IP address restrictions for connections</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Load data</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Reset Concordance password for all user’s databases</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Broadcast messages to online users</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Kill user sessions</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Set Job Schedules</td>
<td>X</td>
<td>✓</td>
</tr>
</tbody>
</table>
Network Distinctions: Concordance versus FYI Server

<table>
<thead>
<tr>
<th>Feature</th>
<th>Concordance</th>
<th>FYI Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Usage History</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Send Watchdog Notifications</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Can take databases offline</td>
<td>✓</td>
<td>✗</td>
</tr>
</tbody>
</table>

FYI Admin Console

All administrative functions are managed from the FYI Admin Console, which is installed during a typical installation. You can also perform administrative tasks from anywhere, at any time, if you perform a custom installation of the Administration Console and set it up for remote access.
The FYI Admin Console contains a series of tabs that allow you to manage the FYI Server and conduct your administrative tasks.

**FYI Admin Console tabs include:**
- **Connect** – initial logon window
- **Server** – shows basic activity load
- **Management** – used to register databases and manage users
- **FYI Licenses** – used to activate new license keys
- **Connections** – shows current connections, allows message broadcasts and killing of sessions
- **Jobs** – used to schedule index, reindex, and packing tasks
- **Firewalls** – sets server-wide IP address restrictions
- **Administrators** – used to create and manage administrators who can access the console
- **Network maps** – controls the UNC path and drive letter associations
- **Settings** – controls basic properties of the server, including port numbers
- **Log** – displays recent server activity

**FYI Server administrative tasks include:**
- Logging on
- Starting and stopping the FYI Server
- Registering and publishing databases
- Adding, deleting, and enabling user accounts
- Licensing FYI Reviewer seats
- Monitoring user status
- Broadcasting messages to online users
- Automating administrative jobs
- Managing firewalls
- Adding additional administrators
- Mapping network drives
- Modifying server settings
- Viewing log files

**FYI Server with Concordance and FYI Reviewer**

FYI Server allows users to access Concordance in two ways, depending on your client’s or organization’s licensing and remote access needs.

**Users can access Concordance databases in two ways:**
- **Concordance .FYI** – (thick-client) full version of Concordance that includes administration functionality, such as indexing, reindexing, and security.
- **FYI Reviewer** – (thin client) streamlined version of Concordance specific to reviewer
functionality with an embedded image viewer.

Client Distinctions: Concordance .FYI versus FYI Reviewer

<table>
<thead>
<tr>
<th>Features</th>
<th>Concordance .FYI</th>
<th>FYI Reviewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local databases</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Remote databases</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Runs in Microsoft Internet Explorer</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Editing and searching</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Importing</td>
<td>✓</td>
<td>Transcripts only</td>
</tr>
<tr>
<td>Administrative features</td>
<td>✓</td>
<td>X</td>
</tr>
</tbody>
</table>

**Working with Concordance .FYI**

In the FYI Admin Console, you can create .fyi files that allow users to launch Concordance and open remote databases through the FYI Server.

A full version of Concordance needs to be installed on the client’s computer and Internet access needs to be available. Users can access native documents and/or images if Concordance Native Viewer or Concordance Image (Opticon) is installed on their computer.
- FYI Server and FYI Reviewer versions 5.6 and later and Concordance 10.10 and later are compatible with Concordance Native Viewer version 1.0
- FYI Server and FYI Reviewer versions 4.x and 5.x are compatible with Concordance version 10.x and Concordance Image version 5.x.
- FYI Server and FYI Reviewer version 3.x are compatible with Concordance 2007, version 9.5, and Concordance Image version 4.50.

Concordance .FYI users have full Concordance functionality, except for modifying the database structure. Concordance .FYI users cannot access the Modify command on the File menu.

The .fyi file contains the connection information needed to address the FYI Server and request the database. It includes the server IP address and port number, which can be viewed in a text editor program. Users receive access when you email them the .fyi file pointing to the database, along with their Concordance user name and password.

For more information about the Concordance FYI file, see Working with FYI files and Distributing the FYI file to users.

**Working with FYI Reviewer**

FYI Reviewer is a Web browser plug-in, also known as an ActiveX control that runs inside Microsoft Internet Explorer 6.x or later, providing access to FYI Server databases. You do not need Concordance, Concordance Native Viewer, and Concordance Image (Opticon) software to use FYI Reviewer, because FYI Reviewer is a thin client and server application. The image viewer is included as part of the FYI Reviewer software.
FYI Reviewer can run on any modern workstation or laptop that runs the latest version of Microsoft® Windows® and Internet Explorer with access to the Internet.

The FYI Server administrator publishes databases for FYI Reviewer users in the FYI Admin Console. Users can view the published databases when they log on to FYI Reviewer (if they have security access to the database). Users receive access when an e-mail is sent containing the URL or Web site address to FYI Reviewer, along with their FYI Reviewer user name and password, and specified server and port address information.

For more information about publishing databases, see Publishing databases.

For more information about FYI Reviewer, see Installing FYI Reviewer and Distributing FYI Reviewer to users.

## Hosted FYI

If your organization does not want to host its own Concordance databases, LexisNexis can do it for you – providing a secure, centralized data hosting server environment with a multi-user review tool to access your data via the Internet.

Hosted FYI allows you to outsource risks and technology burdens by offloading that responsibility to LexisNexis. Doing so helps you by:
• Improving your financial control by reducing internal administration and infrastructure costs.

• Charging you only for what you use (users, document hosting, etc.) with simplified billing in one statement,

• Employing fail-safe disaster recovery with high security user log-in and exclusive public/private folder access to your data.

LexisNexis has a proven review platform and an industry standard, award-winning interface that is successfully employed by the largest cases litigated today. With a trusted third-party like LexisNexis hosting your data, you can regain the freedom of focusing on case strategy.
What's New in Concordance
What's New in Concordance

The following enhancements are included in the Concordance version 10 release. For more release information, see the Release Notes.

Concordance v10.21

- **E-documents database creation improvements**

  E-document database creation has been streamlined to improve performance of data creation. The new E-document database creation engine processes and normalizes the data for improved functionality across all forms of native documents, creating a consistent document display (PDF formatted files) and improved doc-to-doc navigation for Concordance Native Viewer. For more information, see Creating an E-documents database.

- **Appending existing E-documents database improvements**

  Quickly add new documents to an existing E-documents database using a simple file drag-and-drop operation. For more information, see Adding eDocuments.

- **Tag management improvements**

  Organize tags and folders within the Tag and Issues Management dialog or the Tags task pane using a drag-and-drop operation. For more information, see Organizing tags and Managing tags and folders

- **Native file production**

  The Native File Production feature produces a copy of an original native file(s) to a production destination and renames the file(s) using defined production parameters. The produced documents do not include any markups or annotations. For more information, see Running a Native production.

- **Concordance Native Viewer keyboard shortcuts**

  Keyboard shortcuts are now available for Concordance Native Viewer. For more information, see Keyboard shortcuts.

Concordance v10.20 and earlier

- **Previous enhancements:**

  - **Persistent Search Hit Highlighting**
Save time during review using the new Persistent Search Hit Highlighting. Persistent Search stores a list of search terms that can be easily executed within a database to find records that contain the specified term(s) and highlights them in the Browse View. For more information, see Using Persistent Search.

**Find Attachments Search feature**

When searching a database that has documents and attachments, the Find Attachments feature, scans the database to return the documents and any related attachments with the search results. For more information, see Finding attachments.

**Tag documents and attachments feature**

The Tag all documents & attachments feature has been added to the Tags panel to quickly tag records and any related attachments. For more information, see Tagging records.

**Edit View Layouts**

Edit view layouts specify which fields and the order the fields are displayed within the Edit view. Each database may contain multiple edit layouts that can be quickly accessed from the Edit menu. Similar to Table and Sorting layouts, the Edit View layout is saved as a .Editlayout file in the database folder and can be shared between databases and with other users. For more information, see Creating edit layouts.

**Streamlined Data Import Wizard**

The New Database Creation Wizard provides a step-by-step workflow for creating new load file, E-documents, and E-mail databases. For more information, see Creating a database with load files, Creating an E-documents database, and Creating an Email and Attachments database.

**Concordance Native Viewer Sticky Zoom and Sticky Rotate**

The Sticky Zoom and Sticky Rotate features make review much easier by changing the page layout to a landscape or portrait view and maintains the zoom and position while navigating between records. For more information, see Magnifying native files.

**Performance improvements for importing E-documents**

The E-documents import feature has been redesigned for better performance when loading electronic documents into a Concordance E-documents database. For more information, see Importing eDocuments.

**Managing page count for Concordance Native Viewer**

New page count feature for managing document page counts for the imagebase. For more information, see Setting page count.

**Backup and Restore Tag Utility**
Utilizing Windows Services, the Backup and Restore Tag Utility scans specified database directories, locates the TRK file and saves a copy of the file. When a damaged or non-functioning TRK file is detected, the utility automatically sends an email notification and provides tools to restore the file to an earlier point in time. For more information, see Scheduling tag backups.

**Sorting Layouts for Records**

Create and save record sorting layouts for individual databases that can be accessed from any workstation. For more information, see Sorting documents.

**Field selection for Edit view**

To make editing easier, Concordance Edit command provides the option to view only those fields that require editing and arrange the fields in any order to fit your editing needs. For more information, see About editing records.

**Concordance FYI Server Dual Authentication**

Authentication of users against one or two Active Directory LDAP Servers. This option gives administrators the ability to have outside reviewers (outside meaning co-counsel, corporate clients, or reviewers outside the firm) to be on a separate Active Directory LDAP server and not on the internal network server. For more information, see Setting authentication types.

**Delimited Text Database Creation Wizard**

The Delimited Text Database Creation Wizard provides the easiest way to create a database, import data, OCR text and link media files for viewing in Concordance Native Viewer or Concordance Image. For more information, see Using the database wizard.

**OCR on the Fly**

Concordance Native Viewer version 1.03 provides OCR processing for a single page or an entire document and writes the data back to a specified field in the corresponding Concordance record for indexing and searching. For more information, see About OCR processing.

**Import and Export Tags**

Streamline tag creation using the Import and Export Tag options in the Tag and Issue Management dialog box. Import a list of tags and folders into a database from a text formatted (.txt) file or export the tags and folders in an existing database to a text file that you can then import into another database. For more information, see Importing and Exporting Tags.

**Integration of the TagToField and FieldToTag CPLs**

Write Tags to a specified field or create Tags from values within a specified field from the Tag and Issues Management dialog box in Concordance. For more information, see Creating and applying tags and Backing up tags.
Performance improvements for loading and converting imagebase files

Improved performance when loading imagebase files for Concordance Native Viewer or converting existing Concordance Image imagebase files for use with Concordance Native Viewer.

BulkBackupTag Utility

Create a backup of the contents of multiple database .TRK files within a single directory, including all sub-directories when specified, in the associated database .GAT files. For more information, see Backing up tags.

Configure FYI Server SMTP Port

FYI Server SMTP Port is now configurable to match your company's outgoing mail transport server. For more information, see Adding additional administrators.

Individual company branding for FYI Reviewer

Customize FYI Reviewer by adding your company logo to the FYI Reviewer login page. For more information, see Hosting FYI Reviewer locally.

Support for silent installation of Concordance Native Viewer

Concordance Native Viewer version 1.01 includes support for silent installation, allowing you to install the application on multiple workstations from one location. For more information, see Performing silent installs.

Native Viewer for Concordance

Using Concordance with the new Concordance Native Viewer you can view near-native documents and images without the need to open a document in its native application. For more information, see Working with media files.

Manage imagebases and productions from Concordance

Concordance Native Viewer imagebases and productions can now be managed and processed through Concordance. Using the new imagebase management tools (File > Administration > Image Base Management), you can rename paths and folders, rename media keys/aliases, and export multiple imagebases to a single OPT formatted file. For more information, see About CNV imagebase management.

The new production module in Concordance provides all the tools you need to produce color or grayscale TIFF or PDF files. For more information, see About productions.

Bulk printing for Concordance Native Viewer documents

The new print module in Concordance provides all the tools you need to print documents in color or grayscale. For more information, see Printing document sets in Concordance.

Initial Browse Path mapping

Always Map Initial Browse Path option ensures that any instance of a Concordance install opens the default path that is defined on the server. For more information, see Defining
FYI Server email notifications

FYI Server administrators can now choose to receive email notifications for jobs that have succeeded and/or failed. For more information, see Adding additional administrators.

Support for Microsoft Windows 7 and Windows Server 2008

Concordance, Concordance Native Viewer, Concordance Image, and FYI Server are now compatible with Microsoft Windows 7, Windows Server 2008 SP2 and Windows Server 2008 R2.

As a result of changes to the location of the application data files, if you are upgrading to the latest version of Concordance, Concordance Image, or FYI Server, depending on the version you currently have installed you may be required to uninstall the older version prior to installing these applications. The new default location for application data files is C:\Documents and Settings\All Users\Application Data\LexisNexis\...(Windows XP) or C: \ProgramData\LexisNexis\...(Windows 7).

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
<th>Uninstall required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concordance</td>
<td>8.x or 9.x</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>10.7 or earlier</td>
<td>Yes</td>
</tr>
<tr>
<td>Concordance Image</td>
<td>4.x or earlier</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>5.04 or earlier</td>
<td>Yes</td>
</tr>
<tr>
<td>FYI Server</td>
<td>4.x or earlier</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>5.02 or earlier</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For more information about installing, see Installing Concordance, Installing Concordance Image, or Installing FYI Server.

Tags and Tag Folder renaming

Tags and tag folders can now be renamed in the Tags and Issues Management dialog box. Similar to renaming a folder on your computer, simply click the Rename button and type the new tag or folder name. Concordance automatically updates all tagged records with the new tag name.

For more information about renaming tags, see Renaming tags and folders.

Support for the Unicode™ Standard

In Concordance version 10, the Unicode Standard is supported in Arabic, Chinese, English, Hebrew, Japanese, Korean, Russian, and other languages.

For more information about support for the Unicode Standard, see About the Unicode Standard.

New Browse Option
The Issue coding option is now available on the Browsing panel in the Preferences dialog box.

The Issue coding option allows the user to choose whether to code issues by simply clicking a tag when text is selected or requiring the shift key to be held down. The default is shift-left-click.

For more information about the Issue coding option, see Defining preferences.

**Menu Security Restricts Interface Access**

When access to a menu item is restricted, access to that functionality is restricted in all parts of the interface. This includes the navigation bar, keyboard shortcuts, and toolbars.

For more information about menu security, see Setting up security.

**Conversion Report**

The Conversion Report, a comma-delimited conversion log file, is now generated at the end of the database conversion process when you are converting databases to Concordance version 10.x or later. When the database conversion completes, Concordance generates and saves the Conversion Report - [database name]-[date].csv file in the same directory as the converted databases.
You can convert individual databases using the Convert Single Database utility or convert multiple databases at one time using the Bulk Convert Databases to Current Version utility from the Administration option under the File menu.

For more information about the Conversion Report, see About the Conversion Report.

For more information about converting databases, see Converting databases.

- **Integration with Equivio (Concordance version 10.19 or earlier)**

Equivio is an optional companion product for Concordance E-mail and Attachments databases. In Concordance, Equivio highlights the textual differences between two e-mail documents. Equivio helps you identify and skip redundant text during document reviews in Concordance, allowing you to focus on the unique text in each e-mail message.

For more information about using Equivio with Concordance, see Using Equivio with Concordance.

- **TRK Maintenance Tool**

The TRK Maintenance Tool is now available from the Administration option under the File menu in Concordance. Administrators can use the TRK Maintenance Tool to scan all tags in the currently opened database, and, if necessary, repair tagging inconsistencies in the TRK file.

For more information about the TRK Maintenance Tool, see Scanning and repairing the .TRK file.

- **Bulk Field Format Reset**

The Bulk Field Format Reset feature is now available from the Administration option under the File menu in Concordance. The Bulk Field Format Reset feature allows you to remove rich text formatting from a field in multiple records at one time to save space or remove certain text formatting that affects the precision of hit highlighting when searching in Concordance.

For more information about the Bulk Field Format Reset feature, see Removing rich text from multiple records.
Chapter 5

Using Concordance
Using Concordance

Getting Started

Accessing Concordance

If your Concordance administrator set up security requiring users to log on to a Concordance database, you will be prompted to enter your user name and password to access the database in Concordance. The first time you log on, you will be prompted to create and confirm your password. You can change your password anytime you log on.

To log on to Concordance for the first time

1. Open Concordance.

   The Logon dialog box opens with your user name displayed in the User field. The name of the database is displayed at the top of the logon dialog box.

2. Type your new password in the Password field.

   The Concordance administrator only creates your user name when adding you to a database. You create your password when you first log on to Concordance.

3. Click OK.

   Clicking OK opens the Confirm New User/Password dialog box.

4. Retype your new password in the Password field.

5. Click OK to log on and save your new password.

   Remember to write down your password and keep it in a secure place.
To log on to Concordance

1. Open Concordance.

   The Logon dialog box opens with your username displayed in the User field. The name of the database is displayed at the top of the Logon dialog box.

   ![Logon dialog box]

2. Type your password in the Password field.

3. Click OK to log on.

To change your password

1. Open Concordance.

   The Logon dialog box opens with your user name displayed in the User field. The name of the database is displayed at the top of the Logon dialog box.

2. Type your old password immediately followed by a forward slash and the new password in the Password field.

   For example, old password/new password.

3. Click OK.

   Clicking OK opens the Confirm New User/Password dialog box.

   ![Confirm New User/Password dialog box]

4. Type your new password in the Password field.

5. Click OK to log on and save your new password.
Remember to write down your password and keep it in a secure place.

Navigating Concordance

The Concordance user interface is similar to FYI Reviewer and Microsoft Outlook.

The left side of the window is the Navigation pane where you can navigate to Concordance tasks to search, tag, sort, and add notes to documents. The right side of the window is your Workspace pane where you can tab to multiple databases. You can view databases in the Browse, Table, Edit, or Review views.

The Dynamic toolbar at the bottom of the window changes according to the views selected.
### Key Feature Description

<table>
<thead>
<tr>
<th>Key</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Navigation pane</strong></td>
<td>Provides tools for performing tasks on the current database, such as searching and tagging.</td>
</tr>
<tr>
<td>A</td>
<td>Task pane</td>
<td>Displays database tools in work areas called <em>panels</em>.</td>
</tr>
<tr>
<td>B</td>
<td>Pin</td>
<td>Allows you to dock the navigation pane by pinning, or hide the navigation pane by unpinning.</td>
</tr>
<tr>
<td>C</td>
<td>Navigation buttons</td>
<td>Opens task panes on the Navigation pane.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Workspace pane</strong></td>
<td>Displays databases in various views.</td>
</tr>
<tr>
<td>D</td>
<td>Tabs</td>
<td>Allows you to move between different open databases.</td>
</tr>
<tr>
<td>E</td>
<td>Table view</td>
<td>Displays a list of document records.</td>
</tr>
<tr>
<td>F</td>
<td>Browse view</td>
<td>Displays one document record at a time.</td>
</tr>
<tr>
<td>3</td>
<td>Title bar</td>
<td>Displays the current database name and information regarding the current document record.</td>
</tr>
<tr>
<td>4</td>
<td>Menu bar</td>
<td>Contains menus, each responsible for a set of tasks.</td>
</tr>
<tr>
<td>5</td>
<td>Standard toolbar</td>
<td>Contains buttons that let you access standard views and tools.</td>
</tr>
<tr>
<td>6</td>
<td>Quick Search</td>
<td>Allows you to quickly enter and execute simple and advanced searches while browsing document records.</td>
</tr>
<tr>
<td>7</td>
<td>Dynamic toolbar</td>
<td>Contains buttons for tools corresponding to the current views.</td>
</tr>
<tr>
<td>8</td>
<td>Status bar</td>
<td>Displays status information, such as the current document record count.</td>
</tr>
</tbody>
</table>

#### The Navigation Pane

The Navigation pane allows you to manage your case record review, control database access, and conduct your daily search, sort, and tagging tasks.

The Navigation pane contains a task pane plus navigation buttons for accessing each type of task pane. The Task pane is divided into work areas called *panels*. The Task pane is resizeable and can be moved or pinned based on your personal preference.
Notice the pin icon in the upper right corner of the Task pane. By clicking this icon, you can keep the Task pane visible all times (pinned) or tucked away, available when you click the Task pane tab (unpinned).

<table>
<thead>
<tr>
<th>Pane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Databases</td>
<td>Allows you to open and concatenate multiple databases, take a snapshot of a query session, quickly scan recently reviewed databases, and identify the current database you are reviewing and whether it needs updating.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows you to perform simple to advanced queries with fast search results, save and reopen queries, clear search history, and access the dictionary and field lists.</td>
</tr>
</tbody>
</table>
The Workspace Pane

The Workspace pane is located on the right side of the Concordance interface, and displays database items in various views. When you open a database in Concordance, a tab is created for the database in the Workspace pane.

The Workspace pane is not the same as the Workspace tab. The Workspace tab is used to display internal or external web pages. For more information about the Workspace tab, see Customizing the start-up view.

The Title Bar
The Title bar displays information regarding the current document.

Concordance transcript databases automatically set the Title bar to the name, date and volume of the current document. For non-transcript databases, you can define the Concordance field you want to display using the Select the field to display in the title bar while browsing field in the Preferences dialog box. The selected field is displayed on the Title bar in the Browse view, Table view, and Edit view.

When reviewing standard records in the Browse, Table and Edit views, displaying the BEGNO field on the Title bar can help you keep track of record numbering.

- The values in the BEGNO field represent the Bates numbering system, which is a unique serial number corresponding to each record in the database. BEGNO stands for beginning number, and ENDNO for ending number.

The Menu Bar

The Menu bar contains the Concordance menus that are responsible for a set of Concordance tasks. Some of the menu commands are the same as the toolbar functions.

File Edit View Search Documents Tools Help

File Menu

File menu commands allow you to create, maintain, and manipulate databases and the files used by the databases. From the File menu, you can also send data from Concordance to other applications, such as CaseMap and Sanction, and edit and run Concordance programs.
The Edit menu commands allow you to edit and set data validation options for the documents in your databases.

The Undo, Cut, Copy, Paste, Ditto, and Replace menu commands are only available when actively editing in the Edit view. You can use the Copy command to copy text in both the Edit and Browse view. The Copy Document Data command on the Edit menu is only available in the Browse view.
The View menu commands allow you to open images in your viewer, work with documents in the Edit, Browse, Review, or Table view, change data and field font sizes, split your screen, and select the status bar and toolbars.

Search Menu

The Search menu commands provide access to the Simple Search and Advanced Search panels in the Search task pane, access to the Form Search - Query by Example dialog box, the Persistent Search and Find Attachments commands.
The Search menu commands also allow you to save your query session to a file, re-execute a saved query session, clear all searches, and search for documents that have been edited or marked for deletion. The Save Search Results and Activate Selected Query commands on the Search menu are only available in the Review view.

Documents Menu

The Documents menu commands allow you to navigate documents and search results, import, export, print, and create reports in your Concordance databases. Most Documents menu commands operate on the current query. If your last search found zero documents, some the commands on the Documents menu will be unavailable.
Tools Menu

The Tools menu commands allow you to:

- Display empty fields
- Check for duplicate records
- Manage list files
- Manage tags and issues
- Replicate and Synchronize the database
- Customize your preferences

Do not confuse the Tools button on the Standard toolbar with the Tools menu. Clicking the Tools button on the Standard toolbar opens the Preferences dialog box. You can also open the Preferences dialog box by clicking Preferences on the Tools menu.

Help Menu

The Help menu commands allow you to access the Concordance Help system, activate Concordance, and view information about the Concordance version and contacting customer support.

The Standard Toolbar
The Standard toolbar contains buttons for accessing the Concordance views and related tools, including Print and Help.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Opens the Browse view. The Browse view allows you to view the documents in the database. You can also add and edit tags, notes, and issues to documents in the Browse view, and send selected text to other programs. When you open the Browse view you will be viewing the first document in the current query or the first document in the database if no query has been entered.</td>
</tr>
<tr>
<td>Table</td>
<td>Opens the Table view. The Table view displays documents from the current search in a tabular format, similar to a spreadsheet, with one document per row. In the Table view, you can add and edit tags to documents, define which fields are displayed in the view, the field order, and modify the style and color of the font displayed in the view.</td>
</tr>
<tr>
<td>Review</td>
<td>Opens the Review view. The Review view displays all searches performed since the current database was opened, indexed, reindexed, or the search history was cleared. The Review view includes the search number, number of search hits, number of documents containing the search terms, and the search terms for each search.</td>
</tr>
<tr>
<td>All</td>
<td>Selects the entire database and returns the sort order of all records to the order in which they were added to the database. This function is sometimes referred to as Zero Query. The document last displayed in the Browse view remains the active record. The documents that come before and after are the documents that physically precede and follow it in the database. When you want to return to the last query, simply click the All button again. Performing a search also resets the All button.</td>
</tr>
<tr>
<td>Sorting</td>
<td>Opens the Sorting layouts dialog box. The Sorting layout feature provides additional tools to customize and save how records are sorted in the Browse view to display the desired result.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit view. The Edit view allows you to edit the contents of the documents in the database. The Edit view also provides additional tools needed to create and save custom edit layouts that can be applied to display only the fields specified in the selected layout in the Edit view.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print documents dialog box. In the Print documents dialog box you can print records located from a search. You can underline search terms and produce key-word-in-context reports. Printed output can be routed to your printer or to a file. You can select a range of documents within the current query and specify the fields within the database.</td>
</tr>
</tbody>
</table>
Standard Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Report" /></td>
<td>Opens the Report Writer dialog box. When you click the arrow next to the Report view button, you can open the Report Writer or Annotation Report dialog box. The Report Writer dialog box is used to create columnar reports for database data. The Annotation Report dialog box is used to create the Annotation Report for transcript databases.</td>
</tr>
<tr>
<td><img src="image" alt="Tools" /></td>
<td>Opens the Preferences dialog box. In the Preferences dialog box you can customize how you use Concordance, including customizing the Workspace tab, search hit color, title bar, issue coding, and indexing.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Opens the Concordance Answer Center.</td>
</tr>
</tbody>
</table>

- Do not confuse the Tools button on the Standard toolbar with the Tools menu. Clicking the Tools button on the Standard toolbar opens the Preferences dialog box. You can also open the Preferences dialog box by clicking Preferences on the Tools menu.

Quick Search

The Quick Search field is located below the Standard toolbar and can be used in any view. Quick Search allows you to enter basic one-word searches, as well as more complex combinations, while reviewing your documents, without having to open the Search task pane. See Running quick searches.

The Dynamic Toolbar

The Dynamic toolbar is located at the bottom left of the Concordance window. Each toolbar corresponds to a particular Concordance view.

Button Definitions
### Dynamic Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>First</strong></td>
<td>Opens the first document in the current query in the Browse view, or opens the first document in the database if you are using zero query.</td>
</tr>
<tr>
<td></td>
<td><strong>Previous</strong></td>
<td>Opens the previous document in the Browse view.</td>
</tr>
<tr>
<td></td>
<td><strong>Next</strong></td>
<td>Opens the next document in the Browse view.</td>
</tr>
<tr>
<td></td>
<td><strong>Last</strong></td>
<td>Opens the last document in the current query in the Browse view.</td>
</tr>
<tr>
<td></td>
<td><strong>Go to</strong></td>
<td>Opens the Goto dialog box where you can enter the number of the document you want to view from the current query. Concordance opens the document in the Browse view. For Transcripts, use the Goto dialog box, to enter the number for the document, page, or line you want to view.</td>
</tr>
<tr>
<td></td>
<td><strong>Previous Hit</strong></td>
<td>Moves the cursor to the previous search hit in the Browse view. If the document was edited since the last reindex, the document containing the search hits is displayed but the search terms are not highlighted.</td>
</tr>
<tr>
<td></td>
<td><strong>Next Hit</strong></td>
<td>Moves the cursor to the next search hit in the Browse view. If the document was edited since the last reindex, the document containing the search hits is displayed but search terms are not highlighted. If there isn't a next search hit to display, the next document is displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>View Image</strong></td>
<td>Displays the image associated with the current document. Once you click the View Image button, it automatically stays selected and displays the image associated with each record in the image viewer. Click the View Image button again to release the button. This button only works when images are enabled in Concordance.</td>
</tr>
<tr>
<td></td>
<td><strong>Copy</strong></td>
<td>Opens the Copy dialog box. In the Copy dialog box, you can copy document data from selected fields to the output destination you specify.</td>
</tr>
<tr>
<td></td>
<td><strong>Font</strong></td>
<td>Opens the Font dialog box. When you modify the font in the Browse view, you are modifying the font for data displayed in the Browse view for the entire database. When you modify the font in the Table view, you are modifying the font for data displayed in the Table view for the entire database. If you are viewing a concatenated database, the font change only affects the database for the current selected...</td>
</tr>
</tbody>
</table>
### Dynamic Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>record.</td>
<td></td>
</tr>
<tr>
<td><img src="image1" alt="Edit" /></td>
<td>Edit</td>
<td>Adds the search terms of a selected query to the Search task pane for editing.</td>
</tr>
<tr>
<td><img src="image2" alt="Activate" /></td>
<td>Activate</td>
<td>Select a search in the Review view and click the Activate button to activate a previous search and make it the current search. Clicking the Activate button opens the documents in the Browse view.</td>
</tr>
<tr>
<td><img src="image3" alt="Fields" /></td>
<td>Fields</td>
<td>Opens the Fields dialog box. The Fields dialog box contains a list of all fields available for editing. Select a field from the list and click the Insert button to move your cursor to the selected field in the Edit view.</td>
</tr>
<tr>
<td><img src="image4" alt="Ditto" /></td>
<td>Ditto</td>
<td>Opens the Duplicate dialog box. In the Duplicate dialog box, you can copy field data from one record to another record or to another field in the current record.</td>
</tr>
<tr>
<td><img src="image5" alt="Delete" /></td>
<td>Delete</td>
<td>Marks and unmarks a record for deletion. Records marked for deletion are removed from the database when the database is packed.</td>
</tr>
<tr>
<td><img src="image6" alt="Undo" /></td>
<td>Undo</td>
<td>Opens the Edit Options dialog box. In the Edit Options dialog box, you can undo edits, mark and unmark the record for deletion, or erase all content from the document.</td>
</tr>
</tbody>
</table>

### Browse view

- ![Previous](image7)
- ![Stop](image8)
- ![Next](image9)
- ![Forward](image10)
- ![Back](image11)
- ![Reload](image12)
- ![Full Screen](image13)
- ![Print](image14)
- ![PDF](image15)

### Table view

- ![Sort Ascending](image16)
- ![Sort Descending](image17)
- ![Group](image18)
- ![Filter](image19)

### Review view

- ![Zoom In](image20)
- ![Zoom Out](image21)

### Edit view
The Status Bar

The Status bar at the bottom of the Concordance window displays the selected toolbar button's functionality, tracks the document number being edited, and the total number of documents in the current set. The number in brackets is the document's location in the physical database. Document indicators are also displayed here for documents that are tagged (TAG), marked for deletion (DEL), and/or locked (LCK) by another user.

A document locked by another user cannot be saved. A locked document is displayed for editing so that you can copy the document data to another document or program. When a record is locked, the record is grayed out.

This Status bar example indicates you are viewing document 1 out of 203 total documents, the document is the first record in the physical database, and the document has been tagged.

Opening a database

You can open as many databases as you want to review and search in any Concordance session. Each database is accessible by clicking the named database tab.

We recommend not having more than three databases open at a time, and only one if you are actively working within it. As with any application, when you jump too quickly between functions you can cause system processing delays.

To open a database

1. Do one of the following:
   - On the File menu, click Open.
   - In the Databases task pane, click Open.
2. Locate and open the .dcb or .fyi database file.
If you are attempting to open a Concordance version 10.20 or earlier database in Concordance version 10.21 or later, you are prompted that the imagebase is not compatible with the Concordance version 10.21 imagebase and given the option to convert the imagebase.

The database is displayed on a tab next to the Workspace tab.

If you have recently opened a database, you can also open a databases by selecting the database from the Recent panel database list in the Databases task pane.

Clicking a database tab activates the standard and dynamic toolbars in Concordance, as well as the task panes in the Navigation pane.

To close a database

Click the X in the upper-right corner of the Workspace pane.

Viewing records

There are three ways to display records in Concordance:

- **Browse View** - displays the entire record content in a scrollable pane (default view)
- **Table View** - displays a list of documents in a spreadsheet view
- **Split Screen** - allows you to view both simultaneously (vertical or horizontal)

Browse view

The Browse view is the default setting for the Concordance window and allows you to read an entire document summary.

Use the Dynamic toolbar at the lower left of the Navigation pane to navigate between records. The document number and record count display in the Status bar. The document title displays in the window’s title bar and is a helpful reference when reviewing lengthy documents. See also, Navigating in Concordance.

When you run searches in Concordance, any words located in a search (search hits), are highlighted in the Browse view. You can quickly navigate search hits in the Browse view using the Previous Hit and Next Hit buttons on the Dynamic toolbar.

When viewing records in the Browse view, you can use the Empties command on the Tools menu to hide fields without data, which can help tighten the screen view when reading records. A check mark next to the Empties command on the Tools menu indicates empty fields are hidden in the Browse view. If a field is not displayed in the Browse view, even when the Empties command is deselected, you may not have viewing privileges for the field. Contact your Concordance administrator for more information.

In the Browse view, you can customize the font and color of the field and record text displayed in the view, unless the record contains rich-text format. Changing the text font...
and color does not affect the record's original text, which is stored as a rich text file (.rtf) that keeps the original format secure. You or your Concordance administrator can also customize the Browse view preference settings in the Preferences dialog box. Browse view setting in the Preferences dialog box are saved in your Microsoft Windows registry settings.

For more information about customizing fonts, see Modifying fonts in the Browse and Table views.

For more information about Browse view preference settings, see Defining preferences.

Table view

The Table view displays documents from the current search in a tabular format, similar to a spreadsheet, with one document per row. Use the Dynamic toolbar or Documents menu to navigate records in the Table view. The view's default document sort order is the original import order for records entered in the system. Clicking a field column header will sort data in ascending and descending order. You can adjust the column widths by dragging a column header's break.

You can customize which fields are displayed in the view, as well as the field order, using table layouts. You can create multiple custom table layouts for the Table view. For more information about layouts, see Using table layouts.

You can also modify the font and color of the record text displayed in the Table view. Changing the text font and color does not affect the record's original text, which is stored as a rich text file (.rtf) that keeps the original format secure. For more information about modifying fonts, see Modifying fonts in the Browse and Table views.

To review the contents of a specific document in the Table view, double-click the document to open the document in the Browse view.

The Table view also offers the Tally feature. The Tally feature is a great tool for gaining an item count for a specific field to help you organize your document collection and for quality assurance checks. For more information about the Tally feature, see Searching by tally.

Split Screen view

The Split Screen view allows you to display two views simultaneously. You can have the two views display from top to bottom or left to right. You can use the Split Screen for the Browse, Table, Review, and Edit views.

To use the Split Screen view:

1. On the View menu click the Split screen command, and then click the Enable command to activate the Split Screen view.

   A check mark next to the Enable command indicates the Split Screen view is activated.

2. On the View menu, click the Split screen command, and then click the Left - Right or Top - Bottom command.

   A check mark is displayed next to the selected view orientation.
The currently opened view when you activate the Split Screen view, is displayed on the top when using the Top - Bottom command, or on the left when using the Left - Right command.

3. On the Standard toolbar, click the view button for the second view you want to display.

For example, if you have the Browse view open when you enable the Split Screen view with the Top - Bottom orientation, and then click the Table view button, the Browse view is displayed on top and the Table view is displayed on the bottom.

4. To modify the views, click the view you want to change and click another view button on the Standard toolbar. The view containing your cursor, is the view that will change when you click another view button.

Customizing view fonts

In the Browse view, you can customize the font and color of the field and record text displayed in the view, unless the record contains rich-text format. You can also modify the font and color of the record text displayed in the Table view. Changing the text font and color does not affect the record’s original text, which is stored as a rich text file (.rtf) that keeps the original format secure.

When you change the text font and color in the Browse and Table views, the changes are applied to each database record displayed in the Browse and Table views for the current database. For concatenated databases, you can customize the text font and color displayed in the Table view for each database in the concatenated set. This can help differentiate between the databases at a glance.

To change the field font in the Browse view

1. On the Standard toolbar, click the Browse view button.

2. Right-click anywhere in the record text section of the Browse view.
3. Point to **Font** and click **Field** font to open the **Font** dialog box.

4. Modify the font settings as desired.

5. When finished, click **OK** to save your changes.

The font changes apply to all field text displayed in the Browse view.

- **To change the record font in the Browse view**

  1. On the **Standard** toolbar, click the **Browse** view button.

  2. Right-click anywhere in the record text section of the **Browse** view.
3. Point to **Font** and click **Data font** to open the **Font** dialog box.

4. Modify the font settings as desired.

5. When finished, click **OK** to save your changes.

   The font changes apply to all record text displayed in the Browse view.

---

**To change the record font in the Table view**

1. Click the **Table** view button on the **Standard** toolbar to open the **Table** view.

2. Right-click and click **Font** to open the **Font** dialog box.

   If you are changing the record font and color for databases in a concatenated set, right-click any record in the database for which you want to change the font. This only changes the font for the records in that database.
3. Modify the font settings as desired.

4. When finished, click **OK** to save your changes.

The font changes apply to all record text displayed in the Table view for the database.

If you are changing the font and color for a record in databases within a concatenated set, right-click any record in the database for which you want to change the font. This only changes the font for the records in that database.

---

**Defining preferences**

The Preferences dialog box contains settings used by both the administrator and reviewers. You can choose to prevent certain users from accessing the Preferences dialog box by applying security to this menu item. Most of the preferences are Microsoft Windows registry settings, but there are several options that allow you to apply selections to all databases.

Setting some of your viewing parameters helps ease browsing by offering more record detail onscreen, changing the red highlight color for keywords, and choosing default settings for the Concordance Image viewer application.

**The Preferences dialog box contains seven tabs:**

- **General** - settings used when starting and closing Concordance, enable/disable Workspace options, and assigning fields for attachments.
- **Searching** - settings for the default search behavior and search engine.
- **Browsing** - settings for the title bar field, default query field, and tag and issue options.
- **Wizards** - settings for enabling or disabling the import and export wizards.
- **Viewer** - settings for the default viewer application and View image (camera) button
preferences.

- **Indexing** - settings for configuring the amount of memory allocated to indexing and reindexing.
- **CPL** - settings for CPLs, such as the CPL font selection.

Any setting changes made in the Preferences dialog box require you to close Concordance and restart the application before the changes take effect.

**To set General preferences:**

1. Do one of the following:
   - On the **Tools** menu, click **Preferences**.
   - On the **Standard** toolbar, click the **Tools** button, and then click **Preferences**.

Clicking Preferences opens the General tab in the Preferences dialog box.

The Startup section defines the startup view when opening Concordance and databases.
For more information about customizing the start-up view in Concordance, see Customizing the start-up view.

The Initial Browse Path field is used to determine the initial folder that opens when you browse for a file or open a new database. For example, entering C:\LexisNexis\MyDatabases opens the MyDatabases folder when selecting Open database from the Databases task pane. During each Concordance session, the browse path is a dynamic setting and remembers the last folder opened. The next time you browse for a file or select Open database, the previous folder location opens. Each time you close and restart Concordance, Concordance resets the browse path to the original Initial Browse Path field setting.

You need to restart Concordance for this change to take affect.

2. To define the initial browse path, click the ellipses (…) button next to the Initial Browse Path field, to open the Browse For Folder dialog box.

![Browse For Folder dialog box]

3. Navigate to and click the folder you want to open when you browse for a file or open a new database, and click OK.

Clicking OK adds the folder path to the Initial Browse Path field.

4. To ensure all workstations installs open the path in the Initial Browse Path field, select the Always Map Initial Browse Path option.

The Default view field determines whether the Browse or Table view automatically opens when you open a database in Concordance.

5. To define the default view, in the Default view field, click Browse or Table from the view list.

The Number of MRU items field determines the number of database files listed in the most recently used (MRU) file list. The MRU file list is displayed on the File menu and the
Recent panel in the Databases task pane. The Number of MRU items field defaults to 6. You can display up to nine files in the list.

- If a user's Recent panel or Recent Files list is blank, your company may have a policy preventing the user's computer from writing to the MRU registry key.

- You need to restart Concordance for this change to take affect.

6. To modify the number of database files listed, in the **Number of MRU items** field, type or scroll to the number of files to list in the most recently used (MRU) file list.

The Exit section defines what happens when you close Concordance.

The Exit application field allows you to set up an application to automatically launch after Concordance is closed, like a reviewer time card application. Concordance launches the application when it terminates normally. Any additional parameters for the application file are entered in the Parameters field.

7. To launch an application after Concordance closes, click the ellipses (...) button next to the **Exit application** field, to open the **Open** dialog box.

8. Browse to and click the application executable file, and click **Open**.

Clicking Open adds the application's file path to the Exit application field.

9. In the **Parameters** field, type any additional parameters for the application.

The Workspace section controls the Workspace tab settings in Concordance.

By default, the Workspace tab is displayed and contains links to the LexisNexis Web site. You can customize your Workspace tab to display internal or external Web pages simply by adding a link to an external HTML web page or to a locally stored .HTM or .HTML file with information you'd like to publish for user reference.

10. In the **Workspace** section of the **General** tab, the **Enable workspace** check box is selected by default. To continue displaying the Workspace tab in Concordance, leave the **Enable workspace** check box selected. If you do not want to display the Workspace tab, clear the check box.

11. If you want the Workspace tab settings to apply to all users in all databases, in the **Apply to** field, choose **<All databases, all users>**. If you only want the Workspace tab settings to only apply to the local user, choose **<local user only>**.

12. To add a link to an external HTML Web page, in the **URL** field, enter the Web site URL. Be sure to include http:// or https:// in the URL. For example: http://lexisnexis.com/concordance.

To add a link to an internal internal .HTM file located on your server, in the URL field, enter the full UNC path. For example: J:\LexisNexis\Internal_Links.htm or \MyServer \MyFolder\myhtm.htm.

13. In the **Attachments** section, if the attachment fields were not set up during the database creation process, to specify the fields to use with the Find Attachments feature, do one of the following:
   - To set a field to a range of attachments, select the **Attach Range** option, and then select the field that contains the attachment range data.
To set up the beginning and ending attachment fields, select the **Fields** option, and then from the **Beg Attach** and **End Attach** list select the fields that contain the attachment data for the beginning attachment number and ending attachment number.

When using the Find Attachments feature, it is best practice to setup the fields as paragraph type fields to increase the performance and make sure to index/reindex the database. For more information about the Find Attachments feature, see Finding attachments.

14. Click **OK** to save your changes.

**To set Searching preferences:**

1. Do one of the following:
   - On the **Tools** menu, click **Preferences**.
   - On the **Standard** toolbar, click the **Tools** button, and then click **Preferences**.

2. Click the **Searching** tab.

   The settings on the Searching tab define settings for your search query results.
The Default search term section determines which search operator is used when two search terms are entered without an intervening search operator, and the number of words within the search. The search operator selected in the Default search term field is automatically inserted when Concordance encounters this scenario. The Default search term field defaults to the adjacent (ADJ) search operator.

For example, searching for Anza Borrego is interpreted as Anza ADJ Borrego.

3. To change the default search operator, in the Default search term field, select the default search operator you want to use.

4. To expand the number of words included in the search results, in the Within words field, type the number of words to include within the search.

For example, if ADJ is selected in the Default search term field and you enter 3 in the Within words field, Concordance searches for Borrego within 3 words of Anza.

The Wildcard character field determines the wildcard character for searches. The wildcard character is used as a prefix or suffix mask when running a search. The Wildcard character field defaults to an asterisk (*). You can change this character to any non-alphanumeric character.
5. To modify the wildcard search character, in the **Wildcard character** field, type the non-alphanumeric character you want to use.

Quote characters are used when your search query includes numbers or special characters, such as periods (.), asterisks (*), and spaces. The quotation character can be redefined as any non-alphanumeric character, such as the apostrophe. The quotation character is not included in the dictionary unless it occurs as embedded punctuation. To search for the quote, use this option to change the character recognized as the quote, then do the search.

The Quotation character field defaults to the quotation mark ("" character. It is best practice to leave the quotation mark character in the Quotation character field, which is necessary for locating punctuation in relational searches.

For more information about quotes in searches, see Running relational searches.

6. To change the quotation character, in the **Quotation character** field, type the non-alphanumeric character you want to use.

The Highlight color field determines the color used to display search hits from searches performed using the Quick, Simple, Form, and Advanced Search features. The Persistent color highlights the terms found in the record from the list of terms in the `<databasename>_Persistent.txt` file when the Persistent Search feature is enabled. It is best practice to choose a color that stands out against the Browse view background and is different than the data or field font color. The Highlight color field defaults to red. The Persistent color defaults to blue.

7. To change the hit color, do any of the following:

   - For search hits using Quick, Simple, Form or Advanced searching, click the **Highlight color** list, in the color selection box, click the color you want to use.
   - For Persistent Search hits, click the **Persistent color** list, in the color selection box, click the color you want to use.

   Clicking OK opens the *Changes may not be reflected until Concordance is restarted* message.

9. Click **OK**.

**To set Browsing preferences:**

1. Do one of the following:
   - On the **Tools** menu, click **Preferences**.
   - On the **Standard** toolbar, click the **Tools** button, and then click **Preferences**.

2. Click the **Browsing** tab.

   The settings on the Browsing tab define the browse settings by database and field data parameters.
The Local settings section determines where the browse settings are applied. The browse settings can be applied to any database in a group of concatenated databases.

3. In the **Apply settings to** field, select the database you want to apply the settings.

In the Select the field to display in the title bar while browsing field, you can select a field to display on the Title bar for the current document. The field is displayed on the Title bar in the Browse, Table, and Edit views.

Having a field's content displayed on the Title bar can help when viewing long documents, such as depositions, where you may be deep within the document and forget the deponent's name or the document's title. It can also help you see relevant document information when scrolling through records in the Table view.

For transcript databases, Concordance automatically displays the name, date and volume of the current document in the Title bar.

Use the Select the field to display in the title bar while browsing field to select a field for other non-transcript databases.
For concatenated databases, you can choose a different Title bar field for each database.

In the Select the field to sort default query by field, you can modify the default field sort order of a database when the database is opened and before running a search. This is called the default query. The database is sorted in ascending order by the field selected in the Select the field to sort default query by field. The field can be any field designated as a key field on the New or Modify dialog box. For more information about key fields, see Creating databases.

Selecting <none> sorts the database by the document number.

4. To adjust the default sort order of a database, in the Select the field to sort default query by field, click the field you want to use for the default sort order.

In the Select the default action of double-clicking a tag field, you can determine whether double-clicking a tag applies the tag to or removes the tag from a document or whether double-clicking a tag opens the tagging options menu. The Select the default action of double-clicking a tag field defaults to Apply tag (Default).

Regardless of the Select the default action of double-clicking a tag field’s setting, clicking directly on the tag’s check box will apply or remove the tag as usual, and you can always access the tagging options menu in Concordance by right-clicking a tag.

5. To modify tagging actions, in the Select the default action of double-clicking a tag field, click Apply tag (Default) to apply a tag when you double-click a tag or click Displays menu to open the tagging options menu when you double-click a tag.

Double-clicking a tag applies the tag to a document or removes it from the document if it's already selected. You can change this action to display the tagging options menu, which is usually displayed by right clicking a tag.

The Issue coding section determines how issues are applied in Concordance. By default, issues are are applied to highlighted text in a document using SHIFT+left-click. You can change the setting to apply issues using only left-click.

6. To modify the issue coding setting, in the Issue coding section, click the Use shift-left-click for issue coding or Use left-click for issue coding (original method) option.

If you change the issue coding setting, the change will not take effect until you close and reopen Concordance. For FYI Reviewer, the change will not take effect until you log out and log back into FYI Reviewer.

7. Click OK to save your changes.

Clicking OK opens the Changes may not be reflected until Concordance is restarted message.

8. Click OK.

To set Wizards preferences:

1. Do one of the following:
   - On the Tools menu, click Preferences.
   - On the Standard toolbar, click the Tools button, and then click Preferences.
2. Click the **Wizards** tab.

The settings on the Wizards tab allows you to enable or disable the Import Wizard and Export Wizard for delimited text files. The Import Wizard guides you through the process of loading delimited text files into Concordance. The Export Wizard guides you through the process of exporting a Concordance database to a delimited text file. By default, both wizards are enabled.

For advanced users, the wizards may be unnecessary. When the Import Wizard is disabled, pointing to Import on the Documents menu, and clicking Delimited text opens the Import Delimited Text dialog box. When the Export Wizard is disabled, pointing to Export on the Documents menu, and clicking To a delimited text file opens the Export Delimited ASCII dialog box.

The settings on the Wizards tab in the Preferences dialog box only apply to the Import Wizard and Export Wizard for delimited text files. They do not affect the import and export wizards for e-documents, e-mails and Concordance databases.

3. To enable the **Import Wizard** or **Export Wizard** for delimited text files, click the **On** option.
To disable the Import Wizard or Export Wizard for delimited text files, click the Off option.

4. Click **OK** to save your changes.

Clicking OK opens the *Changes may not be reflected until Concordance is restarted* message.

5. Click **OK**.

---

**To set Viewer preferences:**

1. Do one of the following:
   - On the **Tools** menu, click **Preferences**.
   - On the **Standard** toolbar, click the **Tools** button, and then click **Preferences**.

2. Click the **Viewer** tab.

The settings on the Viewer tab define the image viewer settings by user and database, and define the View Image (camera) button settings for Concordance.
You can apply the viewer settings to the current user or all users in the database, and can apply the viewer settings to only the current database or all Concordance databases.

Viewer settings that are applied to all databases are stored the local user’s registry settings.

Viewer settings that are applied to a specific database impacts all users that access the database. The viewer information is stored in the .ini file of the selected database.

3. In the **Apply user settings to** field, click **Current user (user name)** or **All users**.

4. In the **Apply database settings to** field, click **Current database (database name)** or **All databases**.

   If you click a specific database, the viewer setting applies to all users that access the database. If you click All databases, the viewer settings only apply to the current user for all databases.

5. In the **Viewer** field, click the application you want to use as the default image viewer for Concordance.

6. In the **Application path** field, enter the file path or click the browse button and locate the .exe file for the viewer application specified in the Viewer field.

   - You need to restart Concordance for this change to take affect.

You can use one of the following applications as the default image viewer for Concordance:

- Concordance Image
- Concordance Native Viewer
- CPL (Concordance Programming Language)
- IPRO
- IPRO Thin Client

Depending on which application you click in the Viewer field, other fields may be displayed in the Viewer settings section.

- **To use Concordance Image as the default viewer:**
  
  1. In the **Viewer** field, click **Concordance Image (Opticon)**.
  2. Click the ellipses (...) button next to the **Application path** field, to open the **Open** dialog box.
  3. Locate and click the **ConcordanceImage.exe** file, and click **Open**.

- **To use Concordance Native Viewer as the default viewer:**
  
  1. In the **Viewer** field, click **Concordance Native Viewer**.
  2. Click the ellipses (...) button next to the **Application path** field, locate and click the **ConcordanceNativeViewer.exe** file, and then click **Open**.
To execute a CPL when you click the View Image button in Concordance:

The CPL (Concordance Programming Language) viewer option is intended for programmers and systems integrators who have knowledge of programming languages and technical expertise. Concordance can execute a CPL program when clicking the View Image (camera) button on the Dynamic toolbar in the Browse, Edit, or Table view, or right-clicking highlighted text and clicking View image. The CPL program can then pass the image key to another program through DDE or as a startup parameter.

The CPL program you select needs to take the appropriate action to bring up the viewer and the proper image. The CPL program should check the clipboard by using the paste() function. If nothing is in the clipboard, your program should use the data in the image-key field. You need to check the clipboard because the end user can highlight text in the Edit or Browse view and send it to your program with the right mouse button. Your program must not perform any screen displays. For information about DDE functions which may be useful to your program, see About CPL Functions.

1. In the Viewer field, click CPL.

   When you click CPL, the Viewer CPL field is displayed on the Viewer tab.

2. Click the ellipses (...) button next to the Viewer CPL field, to open the Open dialog box.

3. Browse to and click the .cpl file to execute when you click the View Image button in Concordance, and click Open.

   Clicking Open adds the CPL file path to the Viewer CPL field.

To use IPRO as the default viewer:

1. In the Viewer field, click IPRO.

   When you click IPRO, the Application path and Viewer CPL fields are displayed on the Viewer tab.

2. Click the ellipses (...) button next to the Application path field, to open the Open dialog box.

3. Browse to and click the IPRO.exe file, and click Open.

   If IPRO is not running when the View Image button is clicked, Concordance requests Microsoft Windows to start the program using the program path and file name entered in the Application path field.

4. Click the ellipses (...) button next to the Viewer CPL field, to open the Open dialog box.

5. Browse to and click the applicable .cpl file, and click Open.

   You can download the CPL script from www.iprotech.com.
Clicking Open adds the CPL file path to the Viewer CPL field.

For more information about the IPRO viewer and setup options, see the IPRO documentation.

To use IPRO Thin Client as the default viewer:

1. In the Viewer field, click IPRO Thin Client.

   When you click IPRO Thin Client, the Alternate project name field is displayed on the Viewer tab.

2. In the Alternate project name field, enter the alternate project name.

   For more information about the IPRO Thin Client viewer and setup options, see the IPRO documentation.

In the Sticky camera section, you can determine whether the View Image (camera) button on the Dynamic toolbar automatically stays selected, also known as sticky, for continuous image viewing in the Browse, Table, and/or Edit views.

When a "Sticky" [view name] button check box is selected, the View Image button is automatically selected in the view. When the check box is cleared, users manually have to click the View Image button to view the images associated with the documents in the view.

By default, the Sticky browse button, Sticky table button, and Sticky edit button check boxes are selected.

6. To turn off "Sticky [view name] button function for a view, clear the check box for the view.

7. Click OK to save your changes.

   Clicking OK opens the Changes may not be reflected until Concordance is restarted message.

8. Click OK.

If nothing happens when you click on the View Image button, verify that viewer settings are pointing to the appropriate viewer and are not unintentionally different for individual databases.

To set Indexing preferences:

1. Do one of the following:
   - On the Tools menu, click Preferences.
   - On the Standard toolbar, click the Tools button, and then click Preferences.
2. Click the **Indexing** tab.

![Indexing Tab](image)

The settings on the Indexing tab define the Concordance cache settings, which is the amount of memory allocated to indexing and reindexing, and define dictionary access during reindexing.

Indexing and reindexing performance varies with the amount of system resources that you can dedicate to it. Giving Concordance more memory and fast Microsoft Windows NTFS formatted drives is one of the most important things you can do.

For more information about recommended database cache settings, see the Cache Preferences section in the System Requirements topic.

The Indexing cache field defaults to 128 MB and the Dictionary cache field defaults to 32 MB.

3. To modify the indexing cache setting, in the **Indexing cache** field, type or select the cache size that is appropriate for your user’s computer and organization’s guidelines.

The indexing cache memory is only used during the indexing process. It is released back to the operating system when indexing completes.
Large allocations index databases faster. Be careful not to allocate more memory than your workstation can afford. For instance, on a workstation with 256MB of RAM, you can safely allocate 176MB to indexing and 16MB to the dictionary cache. This leaves 64MB for the operating system. With more memory available, plan on leaving 128MB for the operating system and giving the rest to the indexing cache. A memory starved 64MB workstation should allocate no more than 16MB to the indexing cache and 4MB to the dictionary cache. Concordance logs the allocation and indexing time in the Concordance_[version #].log.

4. To modify the dictionary cache setting, in the **Dictionary cache** field, type or select the cache size that is appropriate for your user’s computer and organization’s guidelines.

   This dictionary cache setting is used for all list files, all of the time, not just during indexing. List files include the database dictionary, the database .key file, the stopword files, files for spell checking, miscellaneous .lst files, security and password files, and so on.

   Indexing makes extensive use of the dictionary cache. Increasing the size of the cache will especially improve indexing performance on large natural language text and OCR databases. A setting in the 16-32MB range is usually enough.

   The Multiuser reindexing section determines whether users are prevented from accessing the dictionary, which prevents users from searching, while a reindex is performed on a specific database or all databases.

   Checking the Allow exclusive indexing check box in a particular database secures these settings while the updates are made. However, this setting only marginally increases processing time and is considered optional based on need.

   By default, the Apply settings to field is set to <All databases> and the Allow exclusive indexing check box is not selected, which keeps the database available to other network users during reindexing.

5. To modify the multiuser reindexing settings, in the **Apply settings to** field, click <All databases> or the current database.

6. To prevent users from accessing the dictionary and prevent users from searching while a reindex is performed, select the **Allow exclusive indexing** check box.

   To allow users to access the dictionary and search while a reindex is performed, clear the Allow exclusive indexing check box.

7. Click **OK** to save your changes.

   Clicking **OK** opens the *Changes may not be reflected until Concordance is restarted* message.

8. Click **OK**.

**To set CPL preferences:**

1. Do one of the following:
   - On the **Tools** menu, click **Preferences**.
   - On the **Standard** toolbar, click the **Tools** button, and then click **Preferences**.
2. Click the CPL tab.

The CPL tab determines the font and tab size settings used when running Concordance Programming Language (CPL) programs.

The CPL font field defaults to Courier New 9pt and the Tab size field defaults to 3 spaces.

3. To change the CPL font, click the CPL font button.

Clicking the CPL font button opens the Font dialog box.
4. Modify the settings and click **OK**.

Clicking OK closes the Font dialog box, and adds the font settings to the CPL font field.

5. To change the tab size, in the **Tab size** field type the number of spaces you want a tab to contain.

6. Click **OK** to save your changes.

Clicking OK opens the **Changes may not be reflected until Concordance is restarted** message.

7. Click **OK**.

---

**Basic Searching**

**About searching**

Concordance search tools sort through vast amounts of information quickly using two search methodologies:

- **Full-text Searching**

  Full-text searching is fast and produces results quickly because it searches for words based on index entries created when building the database. The index provides directions to words in the database dictionary and records are gathered for you to review based on
search criteria. For more information, see Running full-text searches.

- **Relational Searches**
  
  Relational searches scan every word of every record in a database and take longer than full-text searches, because Concordance must read every record to locate your entries and does not use an index. Relational searches are great for locating dates and numbers, whereas full-text searches are optimal for word searches. For more information, see Running relational searches.

When your Concordance administrator builds your record databases, the information is indexed for full-text searching capabilities. Once a record collection is indexed, a dictionary is created with additional filters that weed out unnecessary words, common English words, and even some punctuation, to improve search processing time. When reviewers make edits, redactions, or add new records to the database, the administrator must perform a reindex in Concordance to update your record collection.

All of this processing affects how up-to-date your full-text searches are on a database. However, this does not affect relational searches, because relational searches run off the entire database, not just the database index.

Administrators must perform indexing when reviewers are not working in Concordance, but a reindex process can be performed while users are working in a database.

To better understand full-text searching, it is important to understand the following functionality used in full-text searching:

### Indexing and Reindexing

When Concordance databases are built, the index and dictionary are generated from your document contents. The index contains directions to every word or character string in the database. The dictionary contains a list of every word or string of characters in your record collection, except words, punctuation, and/or field content your administrator specifically excludes from the dictionary.

A word is simply defined as any string of letters and/or numbers. A word does not have to be in a published dictionary to qualify as a word in a Concordance dictionary.

**Example:** `airforce1` or `ABC000001`

"Airforce1" qualifies as an index entry, including both letters and numbers. Spaces between characters disqualify it as a whole word; space between `airforce` and `1` would be read as two words. The same is true for `ABC000001`, a numbering scheme that is searchable and considered a word by Concordance.

In Concordance, we refer to an index update as a reindex. Reindexing updates the database dictionary and its corresponding index. Actively used databases need frequent reindexing to keep the index and dictionary entries current for searches.

Administrators are usually responsible for indexing or reindexing databases due to the sensitivity involved in running these processes. Concordance administrators must ensure that all data is reviewed and proper backups are made before indexing or reindexing a database.

When updates have been made to a database and your database dictionary is no longer current with the latest updates, Concordance indicates that the database needs reindexing. On the file menu a check mark is displayed next to the Reindex command and **Needs Reindexing** is displayed in the Databases task pane under Current Database. If you do not
have reindexing privileges, the Reindex command is not visible on the File menu.

Stopwords

Concordance comes with a pre-defined list of stopwords for each database. Stopwords are words that are automatically excluded from a database's index. The stopwords list includes the most common words in the English language (for example: and, but, is, and the). Stopwords are words you would generally not search for. Eliminating these words from the index ensures that searches run faster and more efficiently. Stopwords lists can be modified by your database administrator. If you need a copy of a database's stopwords list, your administrator can print it out for you.
The stopwords list is maintained in the Stopwords dialog box. To access the Stopwords dialog box, on the File menu, point to Dictionaries and click Stopwords.

**Punctuation**

For full-text searching, punctuation is not indexed. Concordance treats punctuation symbols as spaces when full-text searches are conducted. All punctuation is ignored, such as periods or quotations, as well as any symbols like currency and percentage. All leading and trailing punctuation for words are also ignored.

**There are two exceptions to this rule, and both must be true:**

- Punctuation is entered in Concordance by your administrator to be indexed.
- Punctuation is embedded in a string of words.

You can find what punctuation is full-text searchable in a database (when it’s embedded in a string of characters) by checking the Searching option of the Properties dialog box.

### Examples of Embedded Punctuation:

**AOL.COM and NETSCAPE/AOL** – Allows you to search on these terms because the entries relate to a case regarding Internet browsers.

**D'Arcangelo** – The apostrophe is embedded because of the surname spelling. People often have possessive apostrophes embedded in their names and are added to the list because they are searched often.

**john.smith@organization.com** – The period and ampersand are both examples of embedded punctuation within an email address.

Contact your Concordance administrator if you have questions, need a listing of the
punctuation used in your databases, or would like to modify the punctuation list.

Dictionary

In Concordance, a word is any string of characters; a word can be a series of numbers or a combination of letters, numbers and even punctuation or symbols. Familiarize yourself with your database dictionary by reviewing or printing the entries added to help streamline your search queries.

The Properties dialog box provides a quick review of the number of words included in your dictionary, and also notes punctuation that is indexed. Punctuation is entered by your database administrator. You can only search on punctuation when listed in Properties dialog box and it’s embedded in the word.

The Dictionary dialog box provides a complete listing of all words included, the number of documents it appears in, and how many word hits there are.

<table>
<thead>
<tr>
<th>Word</th>
<th>Hits</th>
<th>Doc</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>113</td>
<td>46</td>
</tr>
<tr>
<td>O'D</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'NEIL</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'NEILL</td>
<td>38</td>
<td>11</td>
</tr>
<tr>
<td>O'NEW</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'S</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'K-O</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'APR</td>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>O'JUL</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'JULIA-T</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>O'OCT</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

You can also access the Dictionary dialog box from the Search task pane by selecting Display the database dictionary under Options in the Advanced Search panel. This allows you to select words from the dictionary and add them directly into your search logic in the Advanced Search panel. You can also verify whether the word you are searching is included in the dictionary. If it isn’t, then you may want to try another spelling or try a relational search.

Related Topics

Available search tools
Running quick searches
Running basic keyword searches
Available search tools

Searching is a fundamental core component of Concordance, and there are a variety of tools to assist you in this process. You can use all of them, deciding which you prefer or produces faster results depending on the task and issue currently at-hand.

There are four primary search tools for locating specific record content, each one specific to the type of search you are conducting:

- Quick Search (full-text and relational)
- Persistent Search (full-text)
- Find Attachments (full-text)
- Simple Search (full-text)
- Advanced Search (full-text and relational)
- Form Search (full-text and relational)

When only searching documents, make sure that the View image (camera) button on the Dynamic toolbar is not activated, otherwise it will open images in Concordance Image.

Running quick searches

Quick Search is similar to using the Internet browser to locate information. Use Quick Search to find information quickly in the Browse or Table views without having to open the Search panel. You can use it for fast, simple searches or to copy and paste in complex search strings. Toggle the All button to switch between viewing all case records or those in your current query.

To run a quick search

1. In the Search field, type the search value or string.

   You can enter up to 255 characters to build your query.

2. Click the Go button or press Enter to initiate the query.

   All records containing the search value you entered are displayed in Table view, and the first record is displayed in the Browse view.

   Notice that search value is highlighted in red in the Browse view. A search value
highlighted in red is called a hit in Concordance.

3. To navigate to each hit in a document, click the Next Hit button.

4. The Search field stores your recent quick searches. You can select, edit, and rerun any search stored in the Search field list. To access a recent quick search, click the Search field down arrow, and select the query. To rerun the search, click the Go button or press Enter.

Running simple searches

Simple Search is a great way for new Concordance users to jump right in and start searching records. Simple Search is designed similar to the Google Advanced Search query for familiarity. You can immediately locate information using the parameters provided in the task pane without having to use or learn about search operators.

Simple Search is available in the Search task pane in Concordance.
Simple Search is the most basic full-text search for a one-word query, reviewing the contents of all indexed fields, and finding an exact word match in seconds. You can also search for more than one word or phrases. Searching in Concordance is not case sensitive, so you can type keywords in the manner that is most comfortable for you. You can enter up to 128 characters in a single search option field to build your query.

Expand the width of the Search task pane, so that more text can be entered and viewing is easier. You can always resize the pane to a smaller setting once a document is open for review.

**To run a simple search**

1. Open the Search task pane.
2. Open the Simple Search panel.
3. To expand your task pane for better viewing, drag the navigation pane bar to the right.
4. Enter your search criteria.

**Simple Search Options**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>with all of the words</td>
<td>Conducts an <em>and</em> search to find document records containing all terms listed</td>
</tr>
<tr>
<td>with the exact phrase</td>
<td>Conducts an <em>adjacent</em> search to find document records containing terms found together</td>
</tr>
<tr>
<td>with at least one of the words</td>
<td>Conducts an <em>or</em> search to find document records containing any of the words listed</td>
</tr>
<tr>
<td>without the words</td>
<td>Conducts a <em>not</em> search to find document records that do not contain any of the words listed</td>
</tr>
</tbody>
</table>

When using punctuation characters in your search term, at least one letter needs to be inserted between the punctuation characters. For example, *joe@i@email.com*. Using two or more punctuation characters together will not work (*joe&@email.com*).

5. Click the Search button to initiate the query.

All records containing your search criteria are displayed in the Table view.

The first record of the search results is displayed in the Browse view, and your search value is also highlighted in red in the Browse view. Use the Next hit and Previous hit buttons on the Dynamic toolbar in the Browse view to jump from one highlighted word to the next.

When navigating search results in an ideographic language, like Chinese, one character can represent a word. Clicking the Next hit button jumps to the next character in the
search results. For more information, see Navigating Search Results for Ideographic Languages.

The Status bar indicates the number of records found.

To remove Search criteria:

In the Simple Search panel, click the Clear form button.

Using persistent search

Persistent Search is a search query, when enabled, remains active even after the results are returned. The Persistent Search feature searches for the terms included in the <databasename>_Persistent.txt file and highlights term(s) in each record where they are found. To add terms to the Persistent Search text file, contact your Concordance Administrator.

When new records are added to a database and the Persistent Search feature is enabled, simply reindex the database and then the new records are automatically included in the search results if the records meet the criteria.

The color used to highlight the terms found in the record from the list of terms in the <databasename>_Persistent.txt file is set on the Searching tab in the Preferences dialog box. For more information, see Defining preferences
The Persistent Search feature may be run in conjunction with the Quick, Simple, and Advanced Search queries to refine the search results even further. However, when combining search queries a maximum number of 255 characters is allowed. If a search is performed and then Persistent Search is activated make sure that the total number of characters does not exceed 255 to ensure the correct results are returned.

The Persistent Search text file, <databasename>_Persistent.txt, is stored in the corresponding database folder and accessed only by the associated database. In the case of concatenated databases, the Persistent Search text file associated with the primary database is used for all the databases in the concatenated set.

The Activate button can be used with the Persistent Search option to run previous search queries. If the Persistent Search option is enabled in the Search pane and then the Activate button is selected in the Review view, Concordance returns all the records that contain both the terms in the query and the Persistent Search text file. For more information, see Running previous search queries.

When combining Persistent Search and other search options, make sure that the Persistent Search option is enabled before running any additional queries. However, Persistent Search is automatically disabled after executing the Find Attachments command.
The Review view does not list the Persistent Search terms in the Search Terms(s) column; however, the Number of Hits column does count the terms in the total number of hits.

To use Persistent Search:

1. To enable Persistent Search, do one of the following:
   - From the Search menu, click **Persistent Search**.
   - In the Navigation pane, click the **Search** tab to open the Search task pane, and then in the Options section click the **Persistent Search** check box.

2. To disable Persistent Search, do one of the following:
   - From the Search menu, click **Persistent Search**.
   - In the Navigation pane, click the **Search** tab to open the Search task pane, and then in the Options section clear the **Persistent Search** check box.

   If you click the All button on the standard toolbar, all the records in the database are returned and Persistent Search is automatically disabled. Click the All button a second time to reactivate the Persistent Search.

To use Persistent Search with another query

1. Do one of the following to enable Persistent Search:
   - From the **Search** menu, click **Persistent Search**.
   - In the **Navigation** pane, click the **Search** tab to open the **Search** task pane, and then in the **Options** section click the **Persistent Search** check box.

2. Enter the new search query using Quick, Simple, or Advanced Search features. For more information, see Running quick searches, Running simple searches, Using the Advanced Search panel.

   The search results returns all records having one or both the search term and the term(s) listed in the `<databasename>_Persistent.txt` file.

3. To return to all the Persistent Search results, in the **Search** field type 0.

4. To return to all the documents in the database, on the Standard toolbar, click the **All** button.

Finding attachments

When paper documents are scanned to TIFF formatted files and loaded into Concordance, parent documents and their attachments may be broken into separate records. If a document and its attachments are scanned as one document, there may be only a Begin and End Bates number field for each record in the database that reflects whole documents. If parent documents and attachments are separate records there may be a Begin and End Bates number as well as a Begin and End Attachment field or Attachment Range field in the database for each record.
When native e-mail files are processed, they may be converted to TIFF formatted files, in which case, they could be treated the same as paper document TIFF formatted files, in terms of the Begin and End Bates number and Attachment number fields in the database. If they are not converted to .tiff files and were reviewed in native format, document ID fields are used to assign a unique identifier to each document and attachment. A document ID is a document level identifier, rather than a page level identifier.

When searching a database that has documents and attachments, the search results may return some of the attachments for a document but not the parent document, or just the parent and not the attachments, etc. If it is important to produce the entire document set (parent and all attachments related to those document that returned as the result of a search), it may be necessary to run the Find Attachments command to gather the related parents and attachments.

The Find Attachment command gathers related parent and attachment documents in a database based on the fields containing the attachment information for an active query. The Find Attachments command looks for attachments where the attachment ranges are stored in a single field or two separate fields. The Find Attachments can be set up when creating a database using the New Database Creation wizard, or using the preferences. For concatenated databases, only the primary database settings will work for all other databases in concatenated set, even if non-primary databases have different settings. For more information about setting up the fields for the Find Attachment command for the database, see Defining preferences.

When using the Find Attachments feature, it is best practice to setup the fields as paragraph type fields to increase the performance and make sure to index/reindex the database. For more information about the Find Attachments command, see Finding attachments.

To locate documents and related attachments:

1. Run the appropriate search to locate the documents for review.
   The search results are returned.
2. To find related attachments, on the Search menu, click Find Attachments.
3. When finished, press Enter.

To run a query and include all documents and attachments:

1. In the Search field, type the query to locate the documents and attachments.
2. In the Navigation pane, click the Search tab.
3. In the Options section, click the Include Attachments check box.
4. On the Search toolbar, click the Go button.

Related Topics
Defining preferences
Tagging records

**Advanced Searching**

About advanced searching

There are two ways to query a Concordance database: full-text and relational. Each method has a distinct purpose in locating information efficiently. But both methods can be combined and used in the Quick Search bar and the Advanced Search panel.

Full-text searching is the faster search method in Concordance, enabling you to examine the contents of free-text paragraph fields using words and phrases with various search operators and parameters narrowing the query results. Relational searching is used to query fixed fields, most commonly defined as numeric, date, or fixed-length text. One of Concordance’s most powerful features is its ability to combine these search methods, allowing you to search both field types at once — saving critical review process time by maximizing your query potential.

<table>
<thead>
<tr>
<th><strong>Searching Benefits: Full-text versus Relational</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full-text</strong></td>
</tr>
<tr>
<td>Searches the dictionary, uses index to display words from dictionary search</td>
</tr>
<tr>
<td>Very fast</td>
</tr>
<tr>
<td>Highlights hits in red</td>
</tr>
<tr>
<td>Can only be used to search indexed fields</td>
</tr>
<tr>
<td>Easy to search multiple fields at once</td>
</tr>
<tr>
<td>Used more often to find words</td>
</tr>
<tr>
<td>Cannot be used on date fields</td>
</tr>
<tr>
<td>Often used on paragraph fields</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

© 2018 LexisNexis. All rights reserved.
### Searching Benefits: Full-text Versus Relational

<table>
<thead>
<tr>
<th>Full-text</th>
<th>Relational</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR1 NE &quot;&quot; finds populated fields</td>
<td>Can be used whether or not the database has been indexed</td>
</tr>
<tr>
<td>Cannot be used until the database has been indexed. Will not find new data until database has been reindexed.</td>
<td>Cannot be used to find stopwords, since they are not in the dictionary</td>
</tr>
<tr>
<td>Uses the * wildcard character. Can be used before or after the word.</td>
<td>Uses the * wildcard character only at the end of a word. Use the ? wildcard character, to replace a single character in the middle of a word and in data searches.</td>
</tr>
<tr>
<td>Always searches the complete contents of paragraph fields</td>
<td>Only searches the complete contents of paragraph fields when using CO and NC operators</td>
</tr>
</tbody>
</table>

- In the Browse view, you can distinguish between the different fields:
  - Non-paragraph fields are preceded with an equal sign =
  - Paragraph fields are preceded with a colon :

### Running full-text searches

A full-text search is designed for text and words, and is the most flexible search feature provided by Concordance. A full-text search uses the database’s index to quickly sift through every word entry (of every record) entered in the database index dictionary – similar in design to the Google search engine, which is also based on indexing. Your Concordance index is generated after your record collection is entered into the database. The dictionary is created during the indexing process and includes every word in indexed fields, except for stopwords, to improve searching speeds.

Terms entered in the search are highlighted in the record (red is the default color setting) and are referred to as a hits. You can quickly navigate to every hit in a given record by using the Previous Hit and Next Hit buttons on the Dynamic toolbar.

There are three sets of operators and one wildcard you can use for full-text searches:

**Boolean (document level)**

Boolean operators are based on the binary logic used in computers today, producing strict true or false results. In Concordance, Boolean operators search at the document level. The
most common Boolean operators are: AND, OR, and NOT. The search is not case sensitive, so you do not have to enter all caps for the Boolean operators.

Table of Boolean Operators

<table>
<thead>
<tr>
<th>Boolean Operators</th>
<th>Query</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND contains both words</td>
<td>milk AND coffee</td>
<td>All documents with both the words: milk and coffee</td>
</tr>
<tr>
<td>OR contains either word</td>
<td>milk OR coffee</td>
<td>All documents with either milk or coffee, or both</td>
</tr>
<tr>
<td>NOT contains first word, but not second</td>
<td>milk NOT coffee</td>
<td>All documents with milk, but not coffee</td>
</tr>
<tr>
<td>XOR</td>
<td>milk NOT/OR coffee</td>
<td>All documents with milk or coffee, but not both words</td>
</tr>
</tbody>
</table>

Boolean search operators are used in the Simple Search panel, but the operators are hard-coded for you.

- Typing spaces between words is important to separate the word you are searching from the operator word (AND, OR, NOT). For example, type spaces where you see the underscore: milk_AND_coffee.

- Using XOR saves time in locating documents by combining two separate word searches into one, pulling all documents that either have milk or coffee in them, but not milk and coffee in the same record.

_Context (field level)_

Context operators are great for locating authors and recipients of records, if these fields are entered in your database. Context operators search at the field level. If you are searching
the AUTHOR and RECIPIENT fields for a particular name, the query results will be a list of documents to and from that person. The search is not case sensitive, so you do not have to enter all caps for the context operators.

Context operators include SAME and NOTSAME qualifiers including or excluding fields. The SAME and NOTSAME operators are not commonly used, but field limiters are used frequently to narrow a search for a particular field or to omit fields, saving valuable search processing time.

Table of Context Operators

<table>
<thead>
<tr>
<th>Context Operators</th>
<th>Query</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAME</td>
<td>DOCTITLE SAME bank</td>
<td>Both terms exist in the same field</td>
</tr>
<tr>
<td>NOTSAME</td>
<td>DOCTITLE NOTSAME bank</td>
<td>Both terms never exist in the same field</td>
</tr>
<tr>
<td>Field Limiters</td>
<td>cowco.DOCTITLE.</td>
<td>Looks in the named fields</td>
</tr>
<tr>
<td></td>
<td>correspondence.doctype.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>cowco..ocr1.</td>
<td>Looks in all other fields except for the named field</td>
</tr>
<tr>
<td></td>
<td>memorandum..doctype.</td>
<td></td>
</tr>
</tbody>
</table>

**Example:** cowco.ocr1.

This query searches for cowco in the ocr1 field.

**Example:** milk SAME coffee

This query searches for documents where milk and coffee are both found in the same field. If they occur in the same document, but not in the same field, the document is ignored.

Typing spaces between words is important to separate the word you are searching for from the operator word (SAME, NOTSAME). However, when you are using the periods/field limiters, you want to skip spaces and type the words and periods together in a tight search string, because the periods are a coding language for specifying the inclusion or omission of a field (milk..ocr1.). If you add a space between milk and ..ocr1, the application will not read your search query.

A context operator search with word..fieldname locates the word with an exclusion. The word can still exist in database records, it is just not part of your specific search. For example, a search for milk..ocr1. locates milk in all fields, except for ocr1. This search is helpful for locating keywords in metadata fields, excluding a search on the record’s body content.
Proximity (word level)

Proximity operators search at the word level and are useful when looking for content that appears in records either in direct succession or adjacent order, or in close succession to each other within a specified range. You can add a qualifying number from 0 to 255. This number refers to the maximum number of intervening indexed words, excluding stopwords.

Table of Proximity Operators

<table>
<thead>
<tr>
<th>Proximity Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
</tr>
<tr>
<td>milk ADJ programs</td>
</tr>
<tr>
<td>Both terms are immediately next to each other and in the order specified</td>
</tr>
<tr>
<td>Produces the same results as typing milk programs</td>
</tr>
<tr>
<td>milk ADJ25 programs</td>
</tr>
<tr>
<td>Both terms appear within 25 words of each other</td>
</tr>
<tr>
<td>ADJ# operator has a 255 word limit</td>
</tr>
<tr>
<td>milk NEAR programs</td>
</tr>
<tr>
<td>Both terms are within close range of each other regardless of order, i.e. programs for milk</td>
</tr>
<tr>
<td>milk NEAR255 programs</td>
</tr>
<tr>
<td>Both terms appear within 255 words of each other</td>
</tr>
<tr>
<td>NEAR# operator has a 255 word limit</td>
</tr>
</tbody>
</table>

The default Proximity operator is ADJ. So a search for file note is actually searching file ADJ note. This selection can be customized by your Concordance administrator for your personal searches, as needed.

Typing spaces between words is important to separate the word you are searching from the operator word (ADJ, NEAR). For example, type spaces where you see the underscore: file_ADJ_note.

Proximity operators are hard-coded into the Form Search tool.

Wildcard (field and character masking)

Searching for people’s names can be complicated. Names can be misspelled or include
variations of punctuation. You’ll want to investigate the method used at your organization for entering names into your Concordance databases. This helps you determine how to search to ensure that you do not exclude any possible variations of someone’s name.

If you are searching for a name in an email database, you will notice that there are many email address formats depending on the Internet service provider’s account type. You may miss a critical record in an email address search if you are not careful about how you query it. Using wildcard characters helps ensure that the recipient name is located, regardless of the email format.

Examples:

- jsmith@organization.com
- J_Smith@organization.com
- john.smith@organization.com
- jsmith@gmail.com

Names in documents are also easily misspelled and could be overlooked if apostrophes and initials are combined in records. Using a wildcard symbol as a substitute for a character or series of characters, masks the individual character fields in words creating a broader search with stronger results.

Table of Wildcard Characters - Full Text

<table>
<thead>
<tr>
<th>Character</th>
<th>Query</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asterisk (*)</td>
<td><em>count</em></td>
<td>Finds account, accountant, country, countries, and discount</td>
</tr>
<tr>
<td></td>
<td></td>
<td>searches ocr1, ocr2, ocr3, etc.</td>
</tr>
</tbody>
</table>

When searching for a person, think about all the fields in which this name might be printed or referenced, and also become familiar with the field titles used in your databases, as these can vary. For instance, when searching for Weller in one database, it may be necessary to specify the To and From fields. In another database, you may need to search in the Author and Recipient fields.

Search strings that do not include white space are limited to 64 consecutive characters.

Using the Advanced Search panel

The Advanced Search panel allows you to type longer, complex search strings. You can still conduct simple, one-word searches as well. The added benefit of using Advanced Search is your query results also display the number of word hits found and how many documents it
appears in. The hits and document counts are listed in the Hits and Docs columns in the Results field on the Advanced Search panel.

**Reviewing your search results:**

- A summary of your search results are displayed in the Results field.
- The Results pane displays the search results for each individual term, and the search results for the entire search string. After running your query, the search results for the entire search string is displayed in the last row of the Results field and is highlighted in gray.
- Double-clicking a term in the Results field narrows your search to only those documents containing the term. The search results are displayed in Table view. The first document in the search results is displayed in the Browse view.

You can enter up to 255 characters to build your search logic in the Advanced Search panel. If a complex search string exceeds this limit, you may want to run two separate searches and later combine them in the Review screen using the search numbers.

The Advanced Search panel also contains more tools to assist you with your case review:
Using the Dictionary

Use your database dictionary to search for keywords and also to add dictionary entries directly into a search string in the Advanced Search panel. You can also use your dictionary to see if a word already exists in the dictionary. If a word is not in the dictionary, use relational searching.

The dictionary contains every word, other than stopwords, in the database since the last time it was indexed or reindexed. If the database is concatenated, the dictionary feature displays only words in the primary database.

To open the Dictionary list:

1. In the Search task pane, do one of the following:
   - In the Advanced Search panel, click the Display the database dictionary link.
   - Click the Form Search panel to open the Query by Example dialog box, and click the Dictionary button.
2. In the Dictionary dialog box, scroll through the dictionary list or type the first letters of a word to scroll directly to that entry.
3. To add words to the search string, do one of the following:
   - Select the word, and then click Add.
   - Double-clicking the word.
4. When finished, click the Close button.

The maximum length of a dictionary word is 64 characters. Due to this limit, only the first 64 characters of a long word are included in the dictionary. Since the full word is
not listed, it may not be found in the database. For example, including the file name and path in a word can create a word longer than 64 characters, and the full word will not be found in the database.

Adding Dictionary Words to Search Queries

If you have a list of common words for your review, you can quickly locate the words in the dictionary and run a search query for each of the words in the Advanced Search panel to identify how many times these words appear in records, and to locate the applicable documents.

There are two ways to add a dictionary word in the Dictionary dialog box to a search query in the Advanced Search panel. You can select the word and click the Add button, or double-click the word. If you are adding multiple words at once to a search query, double-clicking the words also automatically adds the OR search operator, so pay attention to how you add dictionary words to a query, as it affects your search results.

**Example:** Dictionary words are added as adjacent (ADJ) words in the Advanced Search field if you add the words separately or by clicking the Add button in the Dictionary dialog box.

```
Advanced Search

(MILKING)(PROGRAM)
```

**Example:** Dictionary words are added with the OR operator to the Advanced Search field if you add multiple words at one time by double-clicking the words in the Dictionary dialog box.

```
Advanced Search

(MILKING or PROGRAM)
```

To add dictionary words to a search query

1. In the Advanced Search panel, click the Display the database dictionary link to open the Dictionary dialog box.

2. Scroll to and select the words you want to add to your search query.

   To quickly search for a word in the dictionary, you can type all or part of the word in the field below the dictionary list to locate a word. For example, if you type c, the dictionary automatically scrolls to the first word in the dictionary that starts with c.
3. Double-click the dictionary word or click the **Add** button to add the word to the **Advanced Search** field.

When you double-click multiple dictionary entries at one time, rather than clicking the Add button, Concordance automatically inserts the OR search operator into the search query. When you add multiple dictionary words separately or by clicking the Add button, Concordance treats the words as adjacent (ADJ) words in the query. Pay attention to how you add dictionary words to a query, as it affects your search results.

4. Click the **Close** button to close the **Dictionary** dialog box.

5. In the **Advanced Search** panel, click the **Search** button to run a query for records containing the selected words.

### Searching by fields

Field search narrows a query to a specified field in the active database. You can view the fields in a database and add field entries directly into a search string in the Advanced Search panel of the Fields dialog box. Referencing your Fields dialog box is a great way to verify exactly what your database field names are. For example, searching for `goniff*.TO.` when the field is actually named `RECIPIENT` will not return any search results.

To add fields to a search query:

1. In the **Advanced Search** panel, click the **Display a list of available fields** link to open the **Fields** dialog box.

2. Locate and select the fields you want to add to your search query.

3. Double-click the field or click the **Insert** button to add the field to the **Advanced Search** field.

   Concordance automatically inserts the field limiters into your search string and
separates the additional fields with commas.

4. Click the **Cancel** button to close the **Fields** dialog box.

5. In the **Advanced Search** panel, click the **Search** button to run a query for records containing the selected fields.

### Searching Fuzzy Words

Fuzzy searches are great for finding misspelled words. A fuzzy search looks for homonyms in the database dictionary; finding words that *look like* and *sound like* your term. For example, *milk*, *mild*, and *mike* are homonyms. You can view the words similar to your search term and add these fuzzy word entries directly into a search string in the Advanced Search panel in the Fuzzy Search dialog box.

Fuzzy searches provide a 65 percent character match for each word, offering a list of best guesses. If you combine this search with asterisks around the *word*, you will get more fuzzy results.

To add fuzzy words to a search query:

1. In the **Advanced Search** panel, type the word you want find homonyms for in database dictionary.

2. Click the **Display a list of words that sound like the selected word** link to open the
**Fuzzy Search** dialog box.

3. Locate and select the words you want to add to your search query.

You can select multiple words in the Fuzzy Search dialog box. To select multiple individual words in the list, use CTRL+click. To select a block of words in the list, use SHIFT+click.

4. Click **OK**.

Clicking **OK** adds the selected words to the **Advanced Search** field and closes the **Fuzzy Search** dialog box.

When you add multiple fuzzy word entries at one time, Concordance automatically inserts the **OR** search operator into the search query.

5. In the **Advanced Search** panel, click the **Search** button to run a query for records containing the selected fields.

---

**Running relational searches**

Relational searches query the entire database in real time. This search is based on a specified field for a specified value, scanning every record in the database (usually only one field). Relational searches are primarily used to search unique value fields, Bates numbers, dates, fixed-length text fields, and other short fields.

Relational searching does not require an indexed database to search current data. Unlike full-text searching, you can search on all punctuation and stopwords in the database. Because Concordance is searching the actual database data in real time, and not a dictionary or index, relational searching can take longer than full-text searching.

Relational searches can be done on full-text fields, but it is best practice to use full-text searching for full-text fields when you can to save time.

Relational search results are not highlighted in red. Instead, you receive a list of records containing your query results in the Table view. It is best to try initial queries in a full-text search before conducting a relational search to ensure you are using the dictionary when you can.

- Field Groups are not supported in relational searching. Use full text searching for Field Groups.
Syntax

Relational search requests are entered in a structured query format. Every fixed field query contains at least three elements:

- field name
- OPERATOR
- data value

The fixed field name to search

A relational operator

The selection criteria

Example:

ISBM = 0-477-01-482-8

The sample query searches the ISBN field in every record in the entire database for a value equal to 0-477-01482-8. Relational searches can run faster if you combine them with a full-text search:

wonder wheels and date <= 4/25/1994

In this case, the fixed fields are examined only in the documents located by the full-text portion of the query. The result line for the date query would apply only to the documents that contain wonder wheels. It is not an indication of all possible matching dates in the database.

Concordance provides ten relational operators for relational searches. Like full-text queries, relational searches are not case sensitive. You may enter your search in upper, lower, or mixed-case letters. You can search for a subset of characters in a field, for a partial match of characters, or for an exact match.

Concordance allows you to use wildcard characters in fixed fields. You can use a wildcard to mask single characters (?), or to mask the remainder of a word (*). The masking capability is not available when selecting on numeric fixed-length fields.

Searching for Multiple Values

Search for several values at once by separating them with commas. Spaces between the values are optional. If you are searching for a value, which itself has a comma in it, then the value must be placed in quotes.

Example: AREACODE = 213, 818, 310, 714

Relational Operators

There are ten relational operators available in Concordance. These operators compare your search criteria with the contents of the fixed field specified in your query. Some of the relational operators have a symbolic equivalent, such as eq and =, both of which mean equal to. These may be used interchangeably and are listed below. When performing a relational search you want to type the field first, then the data value you are searching.
Relational Search Format

field name OPERATOR data value

Relational Operators reference table

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>EQ</td>
<td>Equals</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>NE</td>
<td>Not equal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>GT</td>
<td>Greater than</td>
</tr>
<tr>
<td>&lt;</td>
<td>LT</td>
<td>Less than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>GE</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>LE</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>$</td>
<td>CO</td>
<td>Contains</td>
</tr>
<tr>
<td>!</td>
<td>NC</td>
<td>Does not contain</td>
</tr>
<tr>
<td>(no symbol)</td>
<td>WL</td>
<td>Within limits, includes stated values</td>
</tr>
<tr>
<td>(no symbol)</td>
<td>OL</td>
<td>Outside limits, excludes stated values</td>
</tr>
</tbody>
</table>

Typing spaces between words or symbols is important to separate the word you are searching for from the operator symbols or letters (CO, WL, GT, etc.), otherwise the search won’t work. For example, type spaces where you see the underscore: milk_NC_coffee.

The CO and NC operators are only valid when searching text or paragraph fields. If used on numeric or date fields, Concordance processes the request as if you had entered EQ or NE respectively. A search for OCR CO milk locates words like un milked and milking because it includes the four characters in milk and anything before or after it.

The WL and OL operators search for ranges, within limits and outside of limits. These operators require two criteria to specify the range. The following search would locate any record with a DUEDATE field greater than or equal to January 1, 1993 and less than or equal to March 15, 1995.

Example:
If you are searching for a value that has operators, then the value must be placed in quotes. For example: OCR1 CO "$5,000"

**Example:**

doctitle = untitled
doctitle EQ untitled

Both of the relational operators produce the same search results

If you need to find a specific record and know the Bates number, run a relational search.

But first check your dictionary to see if they are included by your administrator. If numbers are included, you can skip relational searches for them and run a full-text search instead.

**Example:**

docdate WL 10/01/1983, 12/31/1984

This query finds all documents from October 1, 1983 through December 31, 1984.

Use the date format that is standard for each database.

**Example:**

pages WL 5,10

This query finds all documents that are five to 10 pages in length. Four-page documents or 11-page documents are not included in the search results.

Concordance searches numbers and dates in sequential order, so it’s best to train yourself to enter them in that order: smaller number first, then bigger number (5,10), and earlier date, then later date (10/01/1980, 12/31/1983).

**Wildcard Characters - Relational**

When Concordance reads a relational search, it views each individual character. The root of the search criteria can be masked (*) or individual characters can be masked (?) using the wildcard characters. For relational date searches, you must replace each digit in a date query with a wildcard character while using slashes based on the existing date format for your database.

**Example:**

8 and date eq 01/??/1986
All documents identified in query eight with any date in January 1986 are retrieved.

**Example:**

organization co wom?n*

The query selects documents that contain the words WOMAN, WOMEN, WOMANHOOD, etc., in the organization field.

## Relational Wildcard Characters reference table

<table>
<thead>
<tr>
<th>Wildcard Characters - Relational</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Asterisks (*) replace a single text character at the end only</td>
</tr>
<tr>
<td>Question mark (?) replaces a single character</td>
</tr>
<tr>
<td>Quotation marks (&quot;) are required for searching operators</td>
</tr>
</tbody>
</table>

## Quotes in Relational Searching

All spaces in a relational search string are automatically trimmed from the search. If you need to perform a relational search for an entry with spaces or any special characters, enclose the criteria in quotes. The text must be quoted if the criteria itself has spaces or commas in it. Below is a fixed field search with spaces and special characters.

**Example:**

`STATUS = "PAID STATUS?"`

Remember that Concordance inserts the default operator wherever it finds a space. So, without the quotes, Concordance would interpret the above query as `STATUS = PAID ADJ STATUS?`, and it would locate zero records.

## Running complex clause searches

A complex clause search is a search string containing a combination of both full-text and relational search clauses. Stringing both full-text and relational searches together and
combining complex clauses together saves query processing time, thus providing faster search results.

Use Notepad or another text pad editor program to brainstorm your searches as the larger text box makes it easier to read onscreen. Type one clause per line and cut and paste them together, rearranging them until you find the right order. Then simply copy and paste the string into a Concordance search tool to run the query.

Type full-text clauses first, then relational, to conduct efficient queries resulting in a distinct outcome. Full-text searches are faster than relational, so by executing this search first, the secondary relational search is only running the full-text results as opposed to the entire database – saving you valuable processing time.

**Example:** goniff*.ocr1. AND docdate = ??/??/1983

The full-text search for *Goniff* in the OCR1 field is performed before the relational search is conducted for all records from 1983 containing *Goniff*.

In the Results box, you will find records with *Goniff* hits that appear in the DOCDATE field.

To remember whether fields come first or last in a search clause depends on the search method used:

- **Full-text searches:** the field is typed last
  
  *goniff*.recipient. or (financial report).doctype.

- **Relational searches:** the field is typed first
  
  *docdate WL 05/04/1982,05/20/1982

Use care when querying names. Some names may be coded with the person’s initials, especially in email: *goniff*.recipient. vs. *goniff;ja.recipient*. Use a wildcard character, like an asterisk, to mask the name in full-text searches. This will provide wider results.

Use relational searching to search for empty or populated fields.

  - Use fieldname EQ “” to located records where the field is empty.
  - Use fieldname NE “” to locate records when the field is populated with any value.

**Form Searching**

The form search performs the same full-text and relational searches as manually typed searches, but a form search has the operators hard-coded for you. Clicking the Form Search panel in the Search pane or selecting Form Search from the Search menu opens the Query by Example dialog box. Form searches are built and run from the Query by Example dialog box.

The form search can be used as a query builder if you are unfamiliar with the various searching operators. Notice each of the column headers at the top. Your first search connector will always start with **New**; then you need to tell Concordance *Where to Look, How to Look* and what word you want Concordance to *Look For*. To build complex queries, use the search connector fields to join various query strings that you determine for each line.
You can enter up to 85 characters per field with a maximum of 255 characters total for all fields to build your search logic.

Concordance determines whether to run a relational or full-text search for you. If you understand searching concepts and want to use the form search to run all your complex queries, remember to place your all your full-text searches before the relational searches in the Query by Example dialog box.

The Query by Example dialog box is limited to ensure it remains simple to use. For more complex searches, you can use the Advanced Search panel to enter longer queries, add parentheses more precisely, review the results of each word when using wildcards, and use a larger range of query operators.

To build and run a form search:

1. To open the Query by Example dialog box, do one of the following:
   - In the Search task pane, click the Form Search panel.
   - From the Search menu, click Form Search.
   The Connector field in the first row always defaults to New.

2. If you are creating a new search query, leave the default value, New, in the first row.
   If you are filling out more than one row for your search query, select the appropriate
connector from the Connector field in the additional rows.

You can also change the first search connector, *New*, to another operator. The new query will be added to the previous query. For example, if you search for milk in the Quick Search bar it will now be search #1 (or the next sequential number). You can then open the Query by Example dialog box, change the first connector to adj and search for Corp. The new search query will be 1 adj Corp and will find where milk is adjacent to Corp.

3. From the **Where to look** field, select the field you want to search.

4. From the **How to look** field, select the operator you want to use.

   In the How to look field CO Contains is equivalent to *EQ Equals*, and NC Does not contain is equivalent to *NE Does not equal*.

5. In the **Look for** field, type the specific value you want to search for.

6. When finished, click the **Search** button.

   After clicking the Search button, your search query is displayed in the text field and the number of hits and documents found for your search are displayed at the bottom of the Query by Example dialog box.

**To view your query results:**

Do one of the following:

- Click the **Search then Browse** button to display the search results in the **Browse** view.
- Click the **Search then Table** button to display the search results in the **Table** view.
- Click the **Done** button to display the search results in the current view.

You can edit your search in the text box and run it again to receive different results. You can insert words from the dictionary into your search string using the Dictionary button. When you add a word from the dictionary, the word is inserted wherever your cursor is in the text field.

**Combining Search Strings**

Using Boolean search operators, join search clauses together.

*Example:*

milk OR calcium NEAR25 coffee

This query locates all documents with either milk or calcium within 25 words of coffee. The search results omit instances where milk or calcium are in a document, but not within 25 words of each of coffee because the NEAR operator carries a higher precedence than the OR operator.

- Use of spaces when typing search strings becomes very important and is dependent on the type of search operators you are using.
- Use spaces when using word operators (AND, OR, NOT, SAME, NOTSAME, ADJ, and NEAR). For example, type spaces where you see the underscore: milk_AND_coffee
- Omit spaces when using field limiters ( . or .. ). For example, do not type spaces before or after the field limiter: cowco.doctitle.
- If you combine operators and limiters, you still need spaces before and after the operator: Goniff*.AUTHOR..AND__Weller*.RECIPIENT.

**Using Parentheses for Search Precedence**

Like mathematics, Concordance uses a hierarchy to evaluate search expressions. Use parentheses liberally in complex search strings to clarify query logic and enforce operator precedence. Searches within parentheses are evaluated before they are combined with other search operators. Parentheses have the highest precedence and can be nested up to 50 levels deep.

The following table includes Boolean, context, and proximity operators and the order of precedence they carry in a Concordance search. Refer to this table when you are combining one or more clauses together to know which operator clause to place first, and which is secondary. Use the parentheses to combine two or more clauses when additional clauses are included in the search logic, but are secondary in emphasis.

**Operator Order of Precedence reference table**
### Operator Order of Precedence

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADJ</td>
<td>Locates words that are immediately adjacent, and you can specify a range of intervening indexed words from 0 to 255</td>
</tr>
<tr>
<td>NEAR</td>
<td>Locates words that are near each other, and you can specify a range of intervening indexed words from 0 to 255</td>
</tr>
<tr>
<td>SAME</td>
<td>Finds words within the same field</td>
</tr>
<tr>
<td>NOTSAME</td>
<td>Finds words that do not occur in the same field</td>
</tr>
<tr>
<td>AND</td>
<td>Combines words and search results that occur in the same document</td>
</tr>
<tr>
<td>NOT</td>
<td>Combines words and search results if they do not occur in the same document</td>
</tr>
<tr>
<td>OR</td>
<td>Combines words and search results, whether they occur in the same documents or not; Concordance doesn’t care</td>
</tr>
<tr>
<td>XOR</td>
<td>Finds documents that contain one of two search terms, but not both</td>
</tr>
</tbody>
</table>

**Example:** milk OR (calcium NEAR25 coffee)

In this example, the NEAR operator carries a higher precedence than OR, and Concordance searches clauses within parentheses first. The results of the calcium NEAR25 coffee search would then be processed as milk OR results.

**Examples:**

- financial ADJ statement OR report
  
  This query locates financial statement or report.

- financial ADJ (statement OR report)
  
  This query is focused on finding statements or reports containing the words financial statement or financial report.

**Example:** (Correspondence.doctype. AND Goniff*.Recipient.) NOT date = ???/??/1982

This query forces Concordance to run a full-text search first for all correspondence records to Mr. Goniff, with a secondary emphasis that eliminates anything from the year 1982.
Searching by tally

Tally is a great tool for gaining an item count for a specific field to help you organize your document collection and for quality assurance checks. Perhaps you need to quickly determine how many contracts are currently in your caseload or verify if any new ones have been added to the database since you started your review. Organize your documents by type so you can search a subset for critical information. Or, find out how many times a key witness is mentioned by tallying the Author field. A Tally count itemizes this information for you so you can perform internal quality assurance checks in your case review, organize documents by field type, or narrow your searches off a reduced set of records. The Tally feature is only accessible from the Table view and runs a query only on the selected field column.

In the Tally task pane, you can:

- Reset the tally list for a new search
- Print a tally list for quality assurance reference
- Save the tally list to a text file for tracking purposes

For more information about using Tally for printing needs, see Tallying records for reports.

To run a field tally in the Table view:

1. In the Table view, right-click in a field column.
2. Select **Tally [field name]** to tally the field.

3. The tally results are displayed in the **Tally** task pane.

4. Double-click an item in the tally list to display the records in the **Table** view and the first corresponding record in the **Browse** view.

Each time you double-click a tally list item, you are narrowing your search results based on your initial query.

- To sort the tally results, click the tally column headers to sort by item or count.
- To return to the original document listing, click the Reset link.
- To print your tally results, click the Print link.
- To save your tally results to a text (.txt) file, click the Save link.
- To close the Tally task pane, click the Close link. To hide the Tally task pane, click another task pane icon.

**Searching by tags and issues**

You can also search by tags and issues in the Tags task pane. Searching by tags or issues allows you to locate documents tagged in a specific category and marked with internal issues. You can also search your record collection by tags, using the Review screen or conducting a query on applied tags.

For more information about searching by tags or issues, see Creating queries from tags and Querying tags and folders.
Creating a synonyms list

When you perform a search for a word, Concordance automatically searches for any synonyms associated with that word in the database dictionary. Synonyms are created and managed in the Synonyms dialog box.

Synonyms can be based on words already entered in your database dictionary, creating a permanent link between them, or other search terms in Concordance. You can also create synonyms from the fuzzy words list, to include homonyms or words that “look like” and “sound like” those already in your dictionary and synonyms listings. Fuzzy words provide a 65% character match on search terms, but fuzzy searches can miss words longer than the search term.

Synonyms are stored in the .syn file and fuzzy words are stored in the .fzy file. Both files are located in the same directory folder as the primary database.

Here are some examples of synonyms you can create:

- Common American English and UK English spellings, such as color and colour
- OCR errors and misspellings
For acronyms
For complex query expansions (Automatic synonym expansion is suppressed when you place a search term in quotes.)
Associating generic drug names with brand name medications
Associating e-mail messages to a person’s name
Capturing misspellings of a person’s name

For more information about fuzzy searches, see Using the Advanced Search panel.

To create a synonyms list:

1. On the File menu, point to Dictionaries, and click Synonyms.

   Clicking Synonyms opens the Synonyms dialog box.

2. In the Dictionary list, click the word you want to link to synonyms.

   To search for a word in the Dictionary list, type or select part or all the word you are looking for in the Dictionary field below the Dictionary list.

   If you only want the Dictionary list to display words already associated with synonyms, select the Limit the words to Synonyms check box. If you want the Dictionary list to display each word in the dictionary, clear the Limit the words to Synonyms check box.

   You can manually add words to the synonym list or add words to the synonym list from the Fuzzy matches list. You can associate multiple synonyms with a dictionary word.
3. To manually add a word, in the **Synonyms** field at the bottom of the **Synonym** list, type in the corresponding synonym and click the **Add** button.

Clicking the Add button adds the word to the Synonyms list. Repeat this step for each of the synonyms you want to associate with the selected dictionary word.

4. To add a word from the **Fuzzy matches** list, in the Fuzzy matches list, click the word and click the double arrows, <<, button.

5. When finished, click **OK**.

To check the synonyms associated with a dictionary, you can run a search for the word in the Advanced Search panel in the Search task pane. You should see the synonyms listed as hits in the Results list in the Advanced Search panel since they are linked to the word in the dictionary.
**Saving Searches**

**Saving search history**

Reviewing and saving your work history is essential for tracking purposes, especially during complex and lengthy reviews. After conducting a series of searches, you'll want to review your search history to combine previous searches into a new search to narrow your results and rerun prior queries to capture updates in the record recollection. You will also want to save previous queries to a file for tracking purposes or to rerun them at a later time.

**Saving search queries**

There are several reasons to save your search queries. A benefit to saving queries is that once stored, they will collect new data on future executions. The next time you open the query file, Concordance automatically reruns all previous query criteria and includes them in the current session's search listing. This provides you with a foundation of queries to build upon in your advanced search efforts and saves you data entry time.

**You may want to save your searches if:**

- You are interrupted during a complicated set of searches that you want to resume later.
- You need to perform some searches on a regular basis for production reports or privilege-status logs.
- Other reviewers need to retrieve your search results from another computer at a later time.
- You want to run the searches on another database.
Queries are saved as .qry files. These are editable text files containing only the search string. Rerunning a saved query file reprocesses all searches for the file. This process can take extra time since Concordance is re-executing all of the searches. You can execute a .qry file on other databases. If you re-execute it in another database, remember that you will need to resolve any field discrepancies between them by editing the search strings or by making a copy of the search and editing it. For example, the To and From fields in one database may be titled Author and Recipient in another one.

Each reviewer needs to save their query file with a unique file name on a shared network. Your network will not allow multiple files of the same name to be created in the same folder. We recommend each user adds their initials to the end of the file name to differentiate it from others and make it easily identifiable to each person. This rule does not apply to personal or local folders. This example has initials at the end of the file name:

F:\DATA\CONCORDANCE\TUTORIAL\SEARCHES\LAM.QRY

If you don't need to re-execute a .qry file, then you can save queries as .txt files by right-clicking on a query in the Review view and selecting Save. Unlike a saved .qry file, which only stores your search clause, a saved text file also stores the number of hits and documents for that query. Saved .txt files are useful in referencing search history.

To save search queries:

1. To open the Review view, on the Standard toolbar, click the Review button.
2. To open the Keep Queries dialog box, do one of the following:
   - In the Search task pane, click the Save all queries to a saved query file.
   - On the Search menu, click Save All Queries.
3. Browse to where you want to save the file, type the name of the .QRY file in the File name field and click Save.

To clear the queries from the Review view:

Once you have saved your queries, to clear the queries from the Review view, do one of the following:

- In the Search task pane, click Clear search history.
- On the Search menu, click Clear Search History.

To rerun saved queries:

1. Do one of the following:
   - In the Search task pane, click Execute a saved query.
   - On the Search menu, click Execute Saved Queries.
2. Locate and open the .qry query file.

Concordance reads the file and reruns all the searches in the query file. If any records were updated before you restored the query, your search results are automatically
updated. The search results display in the Review view as soon as they are executed.

Reviewing search queries

The Review view provides a complete, numerical listing of all searches conducted since you opened Concordance or it was last reindexed. Use the Review view for tracking purposes or simply to save your queries at the end of your Concordance session. The Review screen references all search scenarios already conducted on a record collection. The listing is also a foundation for building advanced searches to narrow results for key criteria.

Because each search query is numbered sequentially, you can select one or more to combine two previous queries into a new one. The Review screen conducts searches based on Boolean operators, so you can also exclude previous queries from a new search using the OR or XOR operators when combining multiple search numbers in a complex query. Concordance references a query by number faster than if you re-type the query words.

Example: 2 AND 3

Using the queries listed in the Review view image above, the 2 AND 3 query searches for all documents from 1980 with Goniff in the RECIPIENT, AUTHOR, OR CC fields.

Reviewing recent queries is easy. You can click the drop-down arrow in the Search field to view your recent queries, and rerun and edit previous searches from the Search field. You can also copy an advanced search string into the Search field to save it and rerun at a later time. Queries in the Search field list are stored for one Concordance session.

- The Review view does not list the Persistent Search terms in the Search Terms(s) column; however, the Number of Hits column does count the terms in the total number of hits.

Zero Query

To search the entire database or resort it after running several queries, run a Zero Query by typing a zero, 0, in the Search field. The zero is predefined in Concordance to locate all records in a database and resort them in their original load order and is always the first search run when opening a database. You can combine the zero with operators to narrow query results.
**Example:** 0 NOT milk

This search first locates all records in the database, then narrows the results to exclude all documents that contain the word milk.

**Example:** 0 NOT 9

This search locates all database records, then narrows the results to exclude the query results found for search number 9 in the Review view.

Using the Search field is the fastest way to search the entire database or conduct a Zero Query, and is a useful tool when rerunning or excluding results in previous searches tracked in the Review view.

### Running previous search queries

When you click the Review button in the Standard toolbar, two additional Dynamic toolbar buttons become active: Edit and Activate. The Edit button adds queries from the Review view to the Advanced Search panel. The Activate button initiates a previous search query and the search results are displayed in the Table view.

The Activate button can be used with the Persistent Search option. If the Persistent Search option is enabled in the Search pane and then the Activate button is selected, Concordance returns all the records that contain both the terms in the query and the Persistent Search text file.

- The Review view does not list the Persistent Search terms in the Search Terms(s) column; however, the Number of Hits column does count the terms in the total number of hits.

**To review a previous search query:**

On the **Standard** toolbar, click the **Review** button.

All searches conducted since you opened the Concordance session are saved and displayed in the Review view.

**To rerun a previous search query:**

In the Review view, do one of the following:

- Double-click the search query.
- Select the search query, and then on the **Dynamic** toolbar, click **Activate**.
- Right-click the search query, and then click **Activate**.
The first record of the search results displays in the Browse view. You can also view the query results in the Table view.

**To copy a previous search query:**

In the Review view, do one of the following:

- Right-click the search query, click Copy Query, and then right-click in a search field and click Paste.
- Select the search query, and then on the Dynamic toolbar, click Edit.
- Right-click the search query, and then click Edit.

The query displays in the Advanced Search panel, where you can add or edit the search logic for a new query.

**To combine and run search queries using query numbers:**

1. In the Search Number column in the Review view, locate the query numbers for two previous searches.
2. In the Advanced Search box, type in the numbers for those two search queries.
   
   *For example:* 3 AND 9.
   
   It isn’t necessary to type in the preceding zeros displayed in the Search Number column.
3. Click the Search button.

Combining both search queries narrows your search results. Remember that the number of keyword hits and documents found display in the Results field of the Advanced Search panel.

**Basic Tagging**

**About tagging**

A new case has started and boxes of printed documents, CDs, DVDs, and other discovery documents have arrived and need to be reviewed and categorized. In a traditional setting, someone would have to manually sort and flag each document, hoping that the privileged flags don’t fall off in the process.

With Concordance, you no longer need to worry about lost flags and managing boxes of papers and electronic media files. If your case documents have already been entered into Concordance, you can step into the review process with the bulk of the headache-inducing tasks already completed, and start reviewing and categorizing documents.
Tagging records is a critical step in the discovery process. It is your organization’s way of essentially putting color-coded flags on your documents to categorize them by privilege, review status, or other criteria during document review.

When reviewing a concatenated dataset, all tags in all databases display in the Tags panel. If you apply a tag from one database to a record in another database, Concordance automatically writes that tag into the record’s corresponding database. See Concatenating Databases for more information about joined datasets.

---

**Preliminary Planning for Tagging**

To help you manage the case review process, your Concordance administrator typically builds a set of tags for case review that include standard naming conventions, such as privileged, responsive, non-responsive, etc. Tags can also be added in the Tags task pane and can be removed at any time. There are no limits on tagging. You can tag as many documents as you want, with as many tags as you want.

Once tags are applied to document records, the tags become searchable, allowing a user or administrator to easily retrieve all documents with a particular tag.

**Typical Tag Uses**

The following tag list provides examples of the types of tags organizations use to categorize documents during the document review process. You should consider in advance what tags
will be required for both high-level review and specific research angles for your case. Collaborate with your Concordance administrator so these tags can be set up in advance.

- **Responsive vs Non-responsive** - identify responsive documents that must be produced as part of the discovery process
- **Privileged** - identify documents containing information that should not be produced
- **Witnesses** - identify documents for witness kits or binders used in depositions or trials
- **Reviewer Assignments** - delegate documents to be reviewed by individual reviewers
- **Exhibits** - identify documents that will used as exhibits
- **Issues** - identify documents related to key legal issues in the case
- **Keywords** - identify documents containing important terms in the case
- **Other**

### Tagging Strategies

In order to gain the most benefit from tag use, please consider the following:

- Determine how your database will be used by reviewers, so tags can be created in advance.
- Use consistent tag and folder names for better organization.
- As a general rule, search first, tag second. This method allows you to focus on documents containing key terms or other search criteria, which limits the number of documents that need to be reviewed.
- For field-level tags, once all documents are tagged with a particular tag, consider adding a field value to the database to permanently categorize these documents.

### Tagging records

New tags are easily added to a list of persistent ones that are custom designed for a particular case. Any new tag created is immediately accessible to all users in Concordance. This provides a standard format, easy access, and a faster, more efficient review for all users.

Often tags are placed in folders or grouped by type or purpose so all reviewers have an immediate understanding of the case tag organization.

Tag names always display and sort alphabetically. If you intentionally want a tag to appear in a specific location, use the tag name to accomplish that.
Tagging Individual Records

Before you begin tagging records, it is best practice to run a search to limit the number of documents you have to review.

Tags can be applied and removed by any user, at any time. Contact your Concordance administrator or supervisor if you have concerns regarding the permanence of applied tags.

To apply a tag to a document:

1. Open the Tags task pane.
2. Run the appropriate search to limit the documents you have to review.
3. Review your search results and identify the documents you want to tag.
4. In the Table view, select the document.
   You can also tag documents from the Browse view. Tags can be applied to the document currently displayed in the Browse view.
5. In the Tags task pane, do any of the following:
   - Click the tag's check box.
Right-click the tag and click *Tag document*.

Double-click the tag's name.

When you double-click a tag Concordance can either apply the tag or open the tagging options menu. The double-clicking option is set on the Browsing panel in the Preferences dialog box. Double-clicking a tag to apply the tag is the default setting.

A red check mark appears in the tag's check box and the tag is now applied to the document.

To remove a tag from a document:

1. Select the document in the *Table* view.

   You can also remove tags from documents in the Browse view. Tags can be removed from the document currently displayed in the Browse view.

2. To remove the tag from the document, in the *Tags* task pane do one of the following:
   
   - Clear the tag's check box.
   
   - Double-click the tag's name.

   When you double-click a tag Concordance can either apply the tag or open the tagging options menu. The double-clicking option is set on the Browsing panel in the Preferences dialog box. Double-clicking a tag to apply the tag is the default setting.

   The tag's check box is now cleared and the tag is removed from the document.

---

**Tagging Multiple Records**

In some review projects, you may want to conduct searches first and tag all documents for review later. This method is often referred to as *bulk tagging*.

For example, if you want to review all documents containing references to Mr. Goniff, you can search for these documents and tag all the documents in the search results for a later review.

> **Warning:** Tags can be applied and removed by any user, at any time. Contact your Concordance administrator or supervisor if you have concerns regarding the permanence of applied tags.

---

**To apply a tag to multiple documents simultaneously:**

1. Open the *Tags* task pane.

2. Run the appropriate search to limit the documents you have to review.

3. Open the *Table* view to view the search results.
4. In the **Table** view, select all the documents you want to apply tags.

5. In the **Tags** task pane, do one of the following:
   - Click the tag's check box, right-click the tag, and then select **Tag all documents in query**.
   - In the **Table** view, drag the documents selected to the tag in the **Tags** panel.
   - Double-click the tag's name.

When you double-click a tag Concordance can either apply the tag or open the tagging options menu. The double-clicking option is set on the Browsing panel in the Preferences dialog box. Double-clicking a tag to apply the tag is the default setting.

A red check mark appears in the tag's check box, and the tag is now added to each of the selected documents.

**To apply a tag to all documents and attachments in a query simultaneously:**

1. Open the **Tags** task pane.

2. Run the appropriate search to limit the documents you have to review.

3. Open the **Table** view to view the search results.

4. In the **Tags** panel, right-click the tag, and then select **Tag Query & Attachments**.

   - If no attachments are found for a document, the selected tag is applied to all the documents in the current query.

5. When prompted, confirm the number of documents to tag.

   A red check mark appears in the tag's check box, and the tag is now added to each of the selected documents and associated attachments.
To remove a tag from multiple documents simultaneously:

1. Open the **Tags** task pane.
2. Run the appropriate search to limit the documents you want to remove a tag.
3. Open the **Table** view to view the search results.
4. In the **Table** view, select all the documents you want to remove tags.
5. In the **Tags** task pane, click the tag's check box, right-click the tag, and then select **Untag all documents in query**.
   The tag's check box is now empty and the tag is removed from each of the selected documents.

Creating a Query from Tags

If you need to identify which documents have a particular tag applied to them, you can easily do so by creating a query from a tag.
To create a query from tags:

1. Open the Tags task pane.

2. In the Tags task pane, select the tags you want to query.

   You can select multiple tags by pressing the SHIFT or CTRL key while selecting multiple tags.

3. Right-click the selected tags and select Create query from tag(s).

   All documents that are tagged with the selected tags display in Table view.

Advanced Tagging

Organizing tags

Folders are used to organize similar types of tags, allowing you to easily focus on the tags that matter to you at that moment. Once a review has begun, you can review tag history and statistics to see what tags are applied to a document, who applied the tags and when. You can also perform queries on multiple tags or folders, allowing you to use a document’s tag status as part of a complex search.
Creating Folders

When you create a folder you must add at least one tag to the folder, or the folder will not be saved. You cannot create empty folders.

To create a folder:

1. Open the Tags task pane.
2. In the Tags task pane right-click, point to New, and then click Folder.
3. Type the name of the new folder and then press Enter.
4. Right-click the new folder, point to New, and then click Tag to create a tag within the folder.
5. Type the name of the new tag and then press Enter.

When you are creating a folder, you must add at least one tag to the folder.

To create a folder and set of tags for your individual review of documents, you can easily
do so. For more information, see Creating Personal Folders and Tags.

If you need to remove a folder or tag, contact your Concordance administrator.

Creating Personal Folders and Tags

To keep the tag panel uncluttered for all users, you can create a personal folder and custom tags specific to your own review needs. When you create personal folders, they are not visible in the Tags panel for other users. However, personal folders and tags are viewable by your Concordance administrator.

1. Open the Tags task pane.
2. In the Tags task pane right-click, point to New, and then click Folder.
3. Type the name of the new folder, and then press Enter.

Personal folders are pink and can only be viewed by the user who created the folder and the administrator. All public folders are yellow.

4. Right-click your personal folder, point to New, and then click Tag to create a tag within the folder.
5. Type the name of the new tag, and then press Enter.
When you are creating a folder, you must add at least one tag to the folder, or the folder will not be saved when you end your Concordance session. You cannot create empty folders.

If you need to remove a folder or tag, contact your Concordance administrator.

Reorganizing tags and tag folders

1. Open the Tags task pane.
2. In the Tags task pane, do any of the following:
   - To move a single tag from one folder to another folder, select the tag and drag to the new folder.
   - To move multiple tags, press CTRL and click the tags to move, and then drag the tags to the new folder.
   - To move a folder and all the tags in the folder, click the folder and drag to the new location.
   - To move multiple folders, press CTRL and click the folder to move, and then drag the folders to the new location.

   For a tag folder to exist in Concordance, it must have at least one tag in it. If you move all the tags out of a folder, the folder will be deleted.

Creating queries from tags

As your team reviews documents and categorizes them using various tags, you may want to search on multiple tags to find documents that have more than one tag applied. For example, you may want to run a search to find all documents that your team has tagged as both Responsive and Privileged so you can redact content prior to production. You can search on multiple tags individually or by folder.

Query results are displayed within the Tags task pane and the Review screen, where they are stored and can be rerun later. A query created from a tag becomes the current query and it can be used just like any group of retrieved records. Concordance stores the tagging information in the .TRK file, so it remembers the tagged documents and tag descriptions between query sessions.

Querying Tags by a Tag

There are two ways you can query multiple tags. You can query multiple tags together in one query or you can query the tags individually and then combine the individual queries into one complex search query.

For more information about complex search queries, see Running complex clause searches.

To query multiple tags combining individual queries:
1. Open the **Tags** task pane.

2. In the **Tags** task pane, select the tag you want to query.

3. Right-click the selected tag and select **Create query from tag(s)**.

   All documents that are tagged with the selected tags display in Table view.

4. In the **Tags** task pane, select another tag to query.

5. Right-click the selected tag and select **Create query from tag(s)**.

   All documents that are tagged with the selected tags display in Table view.

6. Click the **Review** button on the **Standard** toolbar to review your queries in the **Review** view.

7. In the **Review** view, identify the search numbers for both of the tag queries you created.

8. In the Search field, type the numbers with the **AND** operator between them and press Enter.

   For example, if the searches were numbered 12 and 13, then type **12 AND 13** to combine the two searches.

   The Table view displays only those documents that have both tags applied.

   This new search combines the initial queries into a new complex query, locating documents that contain both tags.

---

**Querying Tags by a Folder**

If you need to identify which documents have particular tags from a specific tag folder, you can easily do so by creating a query from a folder.

**To create a query from folders:**

1. Open the **Tags** task pane.

2. In the **Tags** task pane, select the folders you want to query.

   You can select multiple folders by pressing the SHIFT or CTRL key while selecting multiple folders.

3. Right-click the selected folders and select **Create query from tag(s)**.

   This selection says **tag(s)** instead of folders, but the query process applies to both tags and folders.

   The Table view displays all the documents tagged with any of the tags in the selected folders.
Searching by tags and issues

You can also search by tags and issues in the Tags task pane. Searching by tags or issues allows you to locate documents tagged in a specific category and marked with internal issues. You can also search your record collection by tags, using the Review screen or conducting a query on applied tags.

For more information about searching by tags or issues, see Creating queries from tags and Querying tags and folders.

Viewing tag history

The Tag history panel displays two types of information:

- **Added Tags** - tags that exist on the current document record, including who applied the tag and when it was applied.
- **Deleted Tags** - tags that previously existed on the current document record, but are now removed, including who deleted the tag and when.

As you navigate records, your tag history changes to reflect the history of each selected document.
To review tag history:

1. Select a document record that has been tagged.
2. Open the Tags task pane and select the Tag history panel.
3. Scroll to view all tags that are applied and removed from the current document.
4. Click the plus or minus sign next to the tag status to view or hide a category listing.

Viewing tag statistics

The Tag statistics panel allows you to monitor the tags applied, in categories by tag or reviewer, for a certain time frame. This feature is useful when monitoring an individual’s review progress.
To review tag statistics:

1. Open the Tags task pane and select the Tag statistics panel.

2. In the From and To fields, select the date range you want to review.

3. Click the Refresh button to display the tag statistics.

4. Scroll to view all tags and users listed.

   The Tags list displays the name of the reviewers who applied the tag, and how many records the tag was applied to by the user.

   The Users list displays the tags applied by each reviewer, and how many times the user applied each tag.

5. Click the plus or minus sign next to the users and tags to view or hide the statistics.
**Sorting Records**

**Sorting documents**

The results of any search are sorted in the order in which the documents are added to the database. You may want to sort your documents chronologically, by author, by document type, or by any other field you have in your database to help speed up your review.

The Sorting layout feature provides additional tools to customize and save how records are sorted in the Browse view to display the desired result. For more information, see Using sorting layouts. The Table layout feature provides the tools to create customized public and a private layouts for viewing data in the Table view. For more information, see Using table layouts.

When you are sorting, you need to remember that it only affects your current search results.

*Additional methods for sorting records:*

- **Returning All Records**

  After sorting and reviewing your records, you can refresh the sort order to its original state using the All button. Click the on the Standard toolbar All button to quickly return all records to the sort order in which they were added to the database. You can also toggle the All button to switch between your current query and viewing all records in the database.

- **Quick Sort**

  After running any search, you may want to sort your documents to view them chronologically, by author, by document type, or by any other field you have in your database.

  In order to sort your documents by a field, click a column heading in the Table view. Documents are sorted in ascending order by the selected field. To sort in descending order, click the column heading a second time. For more information, see Using table layouts.

<table>
<thead>
<tr>
<th>Ascending Order</th>
<th>Descending Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOCDATE</td>
<td>DOCDATE</td>
</tr>
<tr>
<td>09/09/1980</td>
<td>02/28/1984</td>
</tr>
<tr>
<td>04/24/1981</td>
<td>05/31/1983</td>
</tr>
<tr>
<td>00/00/1983</td>
<td>03/25/1983</td>
</tr>
<tr>
<td>03/03/1983</td>
<td>03/03/1983</td>
</tr>
<tr>
<td>03/25/1983</td>
<td>00/00/1983</td>
</tr>
<tr>
<td>05/31/1983</td>
<td>04/24/1981</td>
</tr>
<tr>
<td>02/28/1984</td>
<td>09/09/1980</td>
</tr>
</tbody>
</table>
Sorting by selected fields

In the Table view you can sort documents by a single field. With Sorting layouts, you can go a step further and perform multi-level sorting of records using up to four fields at once. For more information, see Using sorting layouts.

Using sorting layouts

The Sorting feature in Concordance determines the order records are displayed in the Browse view. The fields selected in the Sorting Layout dialog box define the order the records are returned for viewing. For example, if you select to sort the records by the fields: BEGNO, DOCDATE, and AUTHOR, then the records are first sorted by the records BEGNO number, then the document date and then by the document's author. You can also choose whether the field is to sort in Ascending or Descending order.

Sorting layouts are created and maintained in the Sorting Layout dialog box and saved as a .Sortlayout file on your local machine in the same directory as the database. There are no limits to the number of sort layouts that can be created and saved; however, sort layouts are specific to the database for which they were created.

Sorting layouts are specific to a database and user. Therefore, if you are working in a database and using a sorting layout that you created, and another user accesses the same database, the sorting layout you are using is not affected by the other user or their sorting layout.

Sorting layouts are compatible with concatenated databases. The fields available in the Sorting Layout dialog box are those fields associated with the primary database.

When creating sorting layouts for concatenated databases, keep the following in mind:

- All databases in a concatenated set are sorted according to the sorting layouts for the primary database when accessed from the concatenated set.
- Database fields in a concatenated set other than the primary will not appear in the Sorting Layout dialog box unless they are opened separately.
- If the field structures for the primary database do not completely match the field structure of concatenated databases, the sorting layout may not sort the concatenated databases as expected.
- In order for field structures of concatenated databases to match, they must have identical field names and field types and be listed in the same order.
- Each sorting layout is limited to four fields.

It is recommended that the .Sortlayout file not be marked as Read-Only as this will prevent the ability to create or switch layout views.
Sorting layout dialog box

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Single Database and Compatible Concatenated Databases" /></td>
<td>Primary database</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Available sort layout</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Field sort order - Descending</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Field sort order - Ascending</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Incompatible Concatenated Databases</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Available sort layout containing fields that are not compatible with the concatenated set of databases</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Field sort order - Descending (inconsistent layouts may appear for each concatenated database)</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Field sort order - Ascending (inconsistent layouts may appear for each concatenated database)</td>
</tr>
</tbody>
</table>

To create a sorting layout:

1. On the **Standard** toolbar, click the **Sorting** button.
2. In the **Layouts** tree, click the **New** button.

3. Type the name of the new layout.

4. To add fields to the layout, in the **Available fields** list, do one of the following:
   - Drag a field to the new layout.
   - Double-click a field.
   - Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields to the new layout.

5. To change the order of the fields sort the database in the layout, in the **Layouts** tree, drag a field to the desired position.

6. To set sort order for the field data, right-click the field, and then click either **Ascending** or **Descending**.

7. When finished, click **OK**.

### To modify a sorting layout

1. On the **Standard** toolbar, click the arrow next to the **Sorting** menu, and then click **Sort layout** to open the **Sorting Layout** dialog box.

2. To change the field order, drag a field in the Layout tree to the desired location.

3. To remove a field, in the Layout tree, do any of the following:
   - Right-click a field, and then click **Delete**.
   - Double-click a field.

4. When finished, click **OK** to apply your changes.

### To view a sorting layout

Do one of the following:

- From the **View** menu, click **Sorting**, and then click the layout name.
- On the **Standard** toolbar, click the arrow next to the **Sorting** menu, and then click the layout name.
To delete a sort layout

1. On the Standard toolbar, click the Sorting button arrow, and click Sort layout to open the Sorting Layout dialog box.
2. Right-click the layout you want to delete in the Layouts tree and then click Delete.

To rename a sort layout

1. On the Standard toolbar, click the Sorting button arrow, and click Sort layout to open the Sorting Layout dialog box.
2. Click the layout name to change, and then type a new sort layout name.

The default user sort layout is automatically created when the database is opened. This sort layout cannot be renamed.

Using table layouts

The Table view uses table layouts to determine the fields and order of the fields displayed within the view. Table layouts can be used to customize viewing preferences or to support sort methods specific to a review.

Table view layouts are created and maintained on the Table Layout dialog box. For each database, each user has one private layout, that is accessible only to the user. Any additional layouts created for a database are public and accessible to everyone using the same database. A database's public layouts can be created, edited, or deleted by anyone in the database.
Be selective when creating table layouts for a database. Too many table layouts in a database can slow down the database's processing speed.

If you have a table layout design that works well in other databases, you can copy and paste the .layout file into other database directories, and then rename the file with the new database name.

If you are using Table View to display long documents, such as depositions or resumes, you can get much faster performance if you do not display full text Paragraph fields. If necessary, add fixed length fields to your database, which have identifying information, such as a name, date and serial or volume number. Then use those fields for Table View. By selecting only fixed length text, date or numeric fields, large full text portions are not loaded. This improves performance for long document types.

It is recommended that the .layout file not be marked as Read-Only as this will prevent users from creating or switching layout views.

**To create a table layout**

You can only make new layouts for the database currently selected. Any layouts created in addition to your private table layout are accessible to all reviewers, and can be altered or deleted by them as well.

1. On the **Standard** toolbar, click the **Table** button arrow, and then click **Table layout** to open the **Table Layout** dialog box.

   In the Table Layout dialog box, the green box with your Windows User ID is your private table layout that is customizable and viewable only by you.
Users are permitted one private table layout per database.

2. In the **Layouts** tree, click the **New** button to create a new layout.

3. Type the name of the new layout.

4. To add fields to the layout, in the **Available fields** list do any of the following:
   - Drag a field to the new layout.
   - Double-click a field to add the field to the new layout.
   - Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields to the new layout.

   The order the fields are listed in the Layouts tree is the order in which the fields appear in the Browse and Edit views.

5. To change the order of the fields in the layout, click a field in the layout and drag it to the desired position in the **Layouts** tree.

6. When finished, click **OK**.

7. To view a saved layout, on the **Standard** toolbar, click the arrow next to the **Table** button, and then click the layout name.

   The Table view layout is not persisted if a sorting layout is applied to the view. Creating a sorting layout will automatically apply a Zero query, returning all documents and sorting the records based on the specified sorting layout.

**To modify a table layout**

1. On the **Standard** toolbar, click the **Table** button arrow and click **Table layout** to open the **Table Layout** dialog box.

2. To change the order of a field in a table layout, click a field in the layout and drag it to the desired place in the **Layouts** tree.

3. To remove a field in a table layout, right-click a field in the layout and click **Delete**.

   You can also double-click a field in the layout to remove the field.

4. Click **OK** to close the **Table Layout** dialog box and apply your changes to the **Table** view.

**To view other table layouts**

In the Table view you can switch between the different table layouts created for the selected database.

On the **Standard** toolbar, click the **Table** button arrow and then click the layout name for the layout you want to view in the **Table** view.

The check mark next to a layout indicates the layout currently displayed in the Table view.
To delete a table layout

Only public table layouts can be deleted in Concordance. When you delete a table layout, it is deleted for all users using the same database.

You cannot delete your private table layout or the table layout currently displayed in the Table view. The Delete command in the Table Layout dialog box is unavailable for private table layouts and the table layout currently displayed in the Table view.

To delete the public table layout currently displayed in the Table view, you first need to display a different layout in the Table view.

1. On the Standard toolbar, click the Table button arrow, and click Table layout to open the Table Layout dialog box.

2. Right-click the layout you want to delete in the Layouts tree and then click Delete.

Editing Records

About editing records

Concordance is fully equipped to handle a rolling production environment with features that allow editing and adding records as needed. Attorneys find the editing tool useful for adding comments directly to a document record during the case review. Administrators can add an Attorney Notes field to the database for this purpose.

The editing tool is also useful when there is limited information in the database to search. Sometimes a paralegal or staff member may be assigned to add missing information, such as the dates, authors, and recipients, to every document in a database to help locate documents authored by a particular individual to another individual within a specific time frame during searches.

Reviewers rarely need to create new records in Concordance. However, as new documents roll in after the initial collection phase, these new records need to be added to the database too. It may not be cost-effective to send a handful of documents out to be processed when a paralegal can manually add them into Concordance by dropping the file on the Concordance workspace.

When the Edit view is opened the Edit pane appears on the left and the Edit toolbar at the bottom of the workspace. By default the Edit view is blank, providing the ability to customize
the view to display only those fields you want to edit for each record in the database. The Edit pane lists all the available fields that can be added to the view. Only those fields you have full rights can be edited.

The customization of the Edit view is not available for the Append and Ditto features.

Edit View

**Edit tools**

When you click the Edit button on the Standard toolbar, the four Edit view tools on Dynamic toolbar are displayed:

- **Fields** - accesses a field listing to insert data from another field
- **Ditto** - allows you to copy field data from another record
- **Delete/Undelete** - adds or removes a record for deletion
- **Edit Options** - allows you to choose reset, blank, delete, or abandon and quit a record

The Ditto feature is not available for E-Documents databases created in or converted to
a Concordance version 10.21 or later database.

- **Edit Options dialog box**

Clicking the Edit Options button on the Dynamic toolbar opens the Edit Options dialog box.

The Edit Options box offers the following options:

- **Reset document** - removes applied edits and restores the record to its original state
- **Blank document** - erases all field content in a record
- **Delete document** - marks the record status for deletion
- **Undelete document** - removes the Delete status for a record
- **Abandon and quit** - exits the current record and exit Edit mode, any applied edits are not saved

- **Rich Text Toolbar**

When you click the Edit button on the Standard toolbar, the Rich Text toolbar displays under the Standard toolbar. On the Rich Text toolbar you can adjust the font size, color, and spacing in edit form fields.

- **Edit Mode Options**

When opening up a record in edit mode in the Edit view, Concordance has formatting options that can be applied to data within a specific field. These formatting options include: Upper case, Lower case, Capitalize, and Reset field formatting.
To change the format of existing data within a field:

1. In the Edit view, select the word or blocks of text that you want to format.
2. Right-click the text and click the applicable formatting option.

Your changes are saved when you navigate to another record or view in Concordance.

Creating edit layouts

To make editing easier, Concordance provides the ability to select specific fields and change the
order they are displayed in the Edit view. Changing field display settings only affects your view of the fields, it does not affect field display for other users. These field settings apply to all records within the database.

Concordance uses edit layouts to determine the fields and order of the fields displayed within the view. Edit layouts are created and maintained on the Edit Layout dialog box and stored in the `<databasename>.Editlayout` file. An edit layout can be created or edited by anyone in the database. However, only the Concordance Administrator or person who created the layout have permissions to delete it.

When creating an Edit Layout for a concatenated set, only the fields of the primary database are displayed in the Available Fields list for non-identical concatenated databases.

The `.Editlayout` file should never be marked as Read-Only, as this will prevent users from creating or switching layout views.

**To create an edit layout**

You can only make new layouts for the database currently selected. All edit layouts are accessible to all reviewers and can be altered by them as well.

1. Do one of the following:
   - On the View menu, point to Edit View, and then click Edit Layout.
   - On the Standard toolbar, click the Edit button arrow, and then click Edit layout.
   - On the Standard toolbar, click the Edit button, right-click within a field, point to Layout and then click Edit Layout.
2. In the Edit Layout dialog box, click the New button to create a new layout.
3. Type the name of the new layout.

4. To add fields to the layout, in the Available fields list do any of the following:
   - Drag a field to the new layout.
   - Double-click a field to add the field to the new layout.
   - Press CTRL+click or SHIFT+click to select multiple fields and then drag the fields to the new layout.

   The order the fields are listed in the Layouts tree is the order the fields appear in the Edit view.

5. To change the order of the fields in the layout, in the Layouts tree, click a field and drag it to the desired position.

6. When finished, click OK.

   The new layout view is displayed in the Edit view.

To modify an edit layout

1. Do one of the following:
   - On the View menu, point to Edit View, and then click Edit Layout.
   - On the Standard toolbar, click the Edit button arrow, and then click Edit layout.
   - On the Standard toolbar, click the Edit button, right-click in a field, point to Layout and then click Edit Layout.

2. In the Edit Layout dialog box, from the Layouts tree, select the layout you want to edit.

3. Do any of the following:
   - To change the field order, click a field and drag it to the desired location in the Layouts tree.
   - To remove a field, right-click a field in the Layouts list, and then click Delete.

   You can also double-click a field in the layout to remove the field.

4. When finished, click OK.

   If all the fields are removed from a layout, then the layout itself is removed. The active layout cannot be deleted.

To view saved edit layouts

In the Edit view you can switch between the different edit layouts created for the selected database.

Do any of the following:
   - On the View menu, point to Edit View, and then click the layout name to view.
   - On the Standard toolbar, click the Edit button arrow, and then click the layout name to apply.
On the Standard toolbar, click the **Edit** button, right-click in a field, point to **Layout** and then click the layout name to view.

The check mark next to a layout indicates the edit layout currently displayed in the Edit view.

---

**Editing records**

Editing existing records is done most often when records are added to Concordance but are missing information that needs to be captured in the system to identify it, such as the document title, author, and date it was created.

If you are an attorney entering summary notes or a paralegal adding missing data to records, you are only able to access fields that you have permission to edit. Fields that can’t be edited display in gray. Other data entry restrictions may be placed on fields by your Concordance administrator.

Each time you edit a record, any changes are saved when you navigate to another record or change your view in Concordance. New information is not full-text searchable until the database is reindexed to refresh the dictionary.

If you try to edit a record that someone else has open for editing, the record will be locked and displays as read-only with gray fields and a LCK notification displays in the Status bar.

For more information about field lists containing word selections that reduce data entry time, see Using Word Lists.

⚠️ **Editing = coding.** Use caution when working in the Edit view. You can spoliate documents if you are not careful, damaging the integrity of your original database records and impacting the search results of others.
To edit an existing record:

1. In the Browse or Table view, select the record.

2. On the Standard toolbar, click the Edit button to activate edit mode for the record.

   By default, all the fields are displayed in the Edit view. Some fields may be gray because you don’t have permission to edit these fields.

3. To apply an edit layout, do one of the following:
   - On the View menu, point to Edit View, and then click the layout name to apply.
   - On the Standard toolbar, click the Edit button arrow, and then click the layout name to apply.
   - In the Edit view, right-click within a field, point to Layout and then click the layout name to apply.

   For more information about Edit Layouts, see Creating edit layouts.

4. To resize a field in the Edit view, select the bottom right corner of the field and drag it down the page to expand the field size. The fields are distinguishable by having a raised border and can be resized during data entry to make editing easier.
5. Make your edits.

Concordance automatically saves your edits as soon as you navigate to another record or change your view in Concordance.

Changes are immediately viewable. However, in order to run full-text searches on the edits in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.

To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays in the File menu next to Reindex.

6. To reindex the database, on the File menu, click Reindex.

Using Word Lists

In most document databases, some data entry work is unique, like attorney review comments, but much of it is repetitive. For example, if you are cataloging correspondence between the principal players in a case, the same names are repeated again and again.

Having these names or other repetitive words available in word lists allows you to insert them in respective database fields reducing the amount of typing necessary. This feature also minimizes data entry errors. For example, you can pick Wocjieweski from a list instead of having to remember how to spell it each time you need to enter the name into a field.

Word lists can be used for any repetitive data entry fields, such as document type (letters, memos, reports, etc.), privilege (attorney client privilege, trade secret, etc.), or any field
where the same set of terms is used over again.

Word lists are set up by your Concordance administrator. If you want a word list added to a particular field, contact your Concordance administrator.

There are numerous ways to open a word list in Concordance. You can only open a word list when you are in the Edit view.

- **To open a word list:**

  For fields associated with a word list, the first time you click in the field, the associated word list automatically opens. To open the word list if the word list does not automatically open, begin typing the value or right-click in the field to open the associated word list.

  For fields not associated with a word list, do one of the following:
  - Press **CTRL + L**, select the word list, and click **Open**.
  - Right-click in the field and click **Word Lists** or the associated field list. If you select Word Lists, navigate to and open the word list file.
  - On the Edit menu, point to **Lists**, click **Word Lists**, navigate to and open the word list file.

- **To populate a field using a word list:**

  1. In the Browse or Table view, select the record.
  2. On the Standard toolbar, click the **Edit** button to open the Edit view and activate edit mode for the record.

     By default, all the fields are displayed in the Edit view. Some fields may be gray because you don’t have permission to edit these fields.
  3. To apply an edit layout, do one of the following:
On the **View** menu, point to **Edit View**, and then click the layout name to apply.

- On the Standard toolbar, click the **Edit** button arrow, and then click the layout name to apply.
- In the Edit view, right-click within a field, point to **Layout** and then click the layout name to apply.

For more information about Edit Layouts, see Creating edit layouts.

4. For fields associated with a word list, the first time you click in the field, the associated word list automatically opens in the **Word List** dialog box. To open the word list if the word list does not automatically open, begin typing the value or right-click in the field to open the associated word list.

For fields associated with a word list, you can also populate the field with a value from a different word list. To use a value from a different word list, click the field. From the Edit menu, point to Lists, and click Word Lists. Navigate to and open the word list file.

For fields not associated with a word list, click field you want to populate and open a word list. To open a word list do one of the following:

- Press **CTRL + L**, click the word list, and then click **Open**.
- Right-click in the field and select **Word Lists** or the associated field list. If you click Word Lists, navigate to and open the word list file.
- On the Edit menu, point to **Lists**, click **Word Lists**, and then navigate to and open the word list file.

5. Select a value from the word list and click the **Add** button.

For long word lists, you can quickly locate the value you are looking for by typing the first couple letters or characters of the value in the field below the word list. For example, typing **S** takes you to the values beginning with the letter **S**.

The Add button adds the selected value to the field and closes the Word List dialog box.

Concordance automatically saves your edits as soon as you navigate to another record or change your view in Concordance.

Changes are immediately viewable. However, in order to run full-text searches on the edits in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.

To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays in the File menu next to Reindex.

6. To reindex the database, on the **File** menu, click **Reindex**.

**To add a new entry to a word list:**

1. Open a word list.
2. Type the value you want to add to the list in the field below the word list.
3. Click the **Insert** button.

**To delete a value from a word list:**

1. Open a word list.
2. Select the value you want to delete from the word list.
3. Click the **Delete** button.

### Formatting field text

In the Edit view you can format individual field text. You can change the text's case and add or remove rich text formatting. When you modify text formatting in a field in the Edit view, the formatting only applies to the field text in the current record.

If rich text formatting has been applied to field data, you may need to change the rich text formatting in a field to plain text to save space or remove certain text formatting that affects the precision of hit highlighting when searching in Concordance.

If you need to remove rich text formatting from a field in multiple records in the database, administrators can use the Bulk Field Format Reset feature. For more information about the Bulk Field Format Reset feature, see Removing rich text from multiple records.

**To change text case in the Edit view:**

1. In the **Edit** view, open the record containing the text you want to modify.
2. Select the text.
3. Right-click the selected text and click one of the following:
   - **Upper** - changes each letter in the selected text to upper case.
   - **Lower** - changes each letter in the selected text to lower case.
   - **Capitalize** - changes the first letter of the selected text to upper case. If you selected multiple words, the first letter of each word will be capitalized.

The Upper, Lower, Capitalize functions are also available using the Format option under the Edit menu.

Concordance automatically saves your edits as soon as you navigate to another record or change your view in Concordance.

Changes are immediately viewable. However, in order to run full-text searches on the edits in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.
To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays in the File menu next to Reindex.

4. To reindex the database, on the File menu, click Reindex.

To add rich text formatting to text in the Edit view:

Rich text can be imported into Concordance or added to text from the Format toolbar in the Edit view.

1. In the Edit view, open the record containing the text you want to modify.
2. Select the text.
3. On the Format toolbar, apply the rich text formatting you want for the text.

Concordance automatically saves your edits as soon as you navigate to another record or change your view in Concordance.

Changes are immediately viewable. However, in order to run full-text searches on the edits in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.

To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays in the File menu next to Reindex.

4. To reindex the database, on the File menu, click Reindex.

To reset a field's rich text formatting to plain text:

1. In the Edit view, open the record containing the text you want to modify.
2. Right-click in the field containing the text you want to modify and click Reset Field Formatting.

Clicking Reset Field Formatting removes the rich text formatting from all text in the field and changes the text to plain text. Clicking Reset Field Formatting does not change the field's case sensitivity.

The Reset Field Formatting function is also available using the Format option under the
Edit menu.

Concordance automatically saves your edits as soon as you navigate to another record or change your view in Concordance.

Changes are immediately viewable. However, in order to run full-text searches on the edits in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.

To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays in the File menu next to Reindex.

3. To reindex the database, on the File menu, click Reindex.

Creating new records

When you are creating new records in the Edit view, each new record added is automatically saved at the end of the existing records list. New records are not full-text searchable until a reindex is performed to refresh the dictionary. If you are adding a lot of new records, coordinate with your Concordance administrator to ensure the reindexing process schedule coincides with your schedule to keep the database dictionary up-to-date.

There are two ways to create new records in the Edit view:

- The Append command to create a new blank record.
- The Ditto feature to create a new record with data from another document.

For more information about creating new records using the Ditto function, see Using Ditto.
The Append and Ditto features are not available for E-Documents databases created in or converted to a Concordance version 10.21 or later database.

To create a new blank record:

1. In the **Edit** view, on the **Edit** menu, click **Append** to open an empty record form.
   
   Some fields may be gray because you do not have permission to edit these fields.

2. Fill out the applicable fields for the record.

   You can scroll or use the TAB, up arrow, or down arrow keys to navigate between fields.

   For more information about the record text editing options available in Concordance, see Navigating Concordance.

   For more information about filling out fields using word lists, see Editing records.

   Some fields are distinguished by having a raised border and can be resized during data entry to make editing easier. To resize a field in the Edit view, click the bottom right corner of the field and drag it down the page to expand the field size.

3. On the **Standard** toolbar, click the **Edit** button to turn off edit mode and save your record.

© 2018 LexisNexis. All rights reserved.
Concordance automatically saves the new record as soon as you close the Edit view or navigate to another record.

Changes are immediately viewable. However, in order to search the edits in the record, the database needs to be reindexed. Once this action is performed, all reviewers can search the updates.

To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays on the File menu next to Reindex.

4. To reindex the database, on the File menu, click Reindex.

It is best practice to close out of the Edit view by clicking the Edit button after you are done adding or editing records – and before you exit Concordance – to ensure that all new records have been saved. If you do not close the Edit view before exiting, you may lose your work.

**Using Ditto**

Another tool for repetitive data entry is the Ditto feature. The Ditto feature copies fields of data from one record to another, minimizing data entry errors. The Ditto feature is only available in the Edit view. The Ditto button on the Dynamic toolbar in the Edit view or the Ditto (Edit View) command on the Edit menu open the Duplicate dialog box.

The Ditto feature is not available in Concordance version 10.21 or later.

**The Duplicate dialog box offers the following options:**

- **Append new** - copies data from the current document into a new document
- **Copy previous** - copies data from a previous document into a new or edited document
- **Copy from another** - copies data from another document into a new or edited document

If you are copying field data from a document to a field containing data in the current document, when you select Copy previous or Copy from another, the data for the selected fields in the current document is overwritten by the data from the other document.

For concatenated databases, only documents in the primary (first) database can be used for copying data.
To create a new record with data from another document:

1. In the Browse or Table view, select the record containing the field data you want to use in the new record.

2. On the Standard toolbar, click the Edit button to open the Edit view.

3. To open the Duplicate dialog box, do one of the following:
   - On the Edit menu, click Ditto (Edit View).
   - On the Dynamic toolbar click the Ditto button.

4. From the field list, select the fields containing the data you want to copy to the new record.

   You can select multiple fields by pressing the SHIFT or CTRL key while selecting multiple fields.

5. Click the Append new option and click OK.

   Clicking OK creates a new record containing the selected field data from the record you opened in the Browse or Table view.

6. Fill out the applicable fields for the record.

   Some fields may be gray because you don’t have permission to edit these fields.

   You can scroll or use the TAB, up arrow, or down arrow keys to navigate between fields.

   For more information about the record text editing options available in Concordance, see Navigating Concordance.

   For more information about filling out fields using word lists, see Editing records.

   Some fields are distinguished by having a raised border and can be resized during data entry to make editing easier. To resize a field in the Edit view, click the bottom
right corner of the field and drag it down the page to expand the field size.

7. On the Standard toolbar, click the Edit button to turn off edit mode and save your record.

Concordance automatically saves the new record as soon as you close the Edit view or navigate to another record.

Changes are immediately viewable. However, in order to run full-text searches for data in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.

To ensure that your edits are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays on the File menu next to Reindex.

8. To reindex the database, on the File menu, click Reindex.

To populate fields using Ditto:

1. In the Browse or Table view, select the record containing the fields you want to populate from another record.

2. On the Standard toolbar, click the Edit button to open the Edit view.

3. To open the Duplicate dialog box, do one of the following:
   - On the Edit menu, click Ditto (Edit View).
   - On the Dynamic toolbar click the Ditto button.

4. From the Field list, select the fields containing the data you want to copy to the record.

   You can select multiple fields by pressing the SHIFT or CTRL key while selecting multiple fields.

5. Do one of the following:
   - To copy the data from the previous record, click Copy previous.
   - To copy the data from another record, click Copy from another and type this document's current record number.

6. Click OK.

   Clicking OK copies the data from the selected fields in the other document to the fields in the current document.

7. On the Standard toolbar, click the Edit button to turn off edit mode and save your record.

Concordance automatically saves the new record as soon as you close the Edit view or navigate to another record.

Changes are immediately viewable. However, in order to run full-text searches on the
edits in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the updates.

To ensure that your new records are searchable in a timely manner, coordinate with your Concordance administrator regarding the reindexing schedule. If any edits are made that require a reindex, a check mark displays on the File menu next to Reindex.

8. To reindex the database, on the File menu, click Reindex.

Searching for edited records

To query the database for any documents that have been edited use the Search for edited documents command. When you select Search for edited documents, all documents that have been edited since the last database reindex or index are displayed in Browse or Table view.

Deleting records

You can mark records for deletion one at a time using the Editing tools on the Dynamic toolbar that are available when the Edit view is open. When a record is marked for deletion, DEL is displayed in the status bar. Concordance administrators can review and retrieve these documents before removing them permanently from the database.

You can also mark multiple records for deletion at one time. For example, when using Append feature you may unintentionally create several new records that need to be removed from the database. By querying for these records, you can mark all of them for deletion at once.
Records are not permanently removed from the database until your Concordance administrator removes them, so retrieval of documents marked for deletion is available.

To mark individual records for deletion:

1. In the **Browse** or **Table** view, select the record you want to mark for deletion.
2. On the **Standard** toolbar, click the **Edit** button to open the **Edit** view.
3. Do one of the following:
   - On the **Dynamic** toolbar, click the **Delete** button.
   - On the **Dynamic** toolbar, click the **Undo** button, click the **Delete document** option in the **Edit Options** box, and then click **OK**.

   Clicking the Delete button or clicking Undelete Document in the Edit Options box marks an individual record for deletion. DEL is now displayed in the status bar for the record.

Before a record is permanently deleted by your Concordance administrator, you can unmark a record for deletion.

To unmark individual records for deletion:

1. In the **Browse** or **Table** view, select the record you want to unmark for deletion.
2. Click the **Edit** button on the **Standard** toolbar to open the **Edit** view.
3. Do one of the following:
   - On the **Dynamic** toolbar, click the **Delete** button.
   - On the **Dynamic** toolbar, click the **Undo** button, select the **Undelete document** option in the **Edit Options** box, and then click **OK**.

When a record is marked for deletion, clicking the Delete button or clicking Undelete Document in the Edit Options box removes the mark for deletion from the record and DEL is removed from the status bar for the record.

To mark multiple records for deletion:

1. Run a search for a batch of records that you want to mark for deletion.
2. Verify that the desired records appear in **Table** view.
3. On the **Edit** menu, click **Delete and Undelete**.
4. In the **Range** field, confirm the range of records to mark for deletion, and then click **OK**.

Selected records are marked for deletion and a DEL is shown in the status bar for each of the records.

If you accidentally mark records for deletion that should not be deleted, follow the procedures above for deleting multiple records but select Undelete instead of Delete in the Delete and Undelete box. You can also remove the mark for deletions from the individual records using the Delete or Edit buttons on the Dynamic toolbar. Be sure to verify that the DEL status no longer appears for these records.

---

**Working with Transcripts**

**About transcripts**

With Concordance you get the benefit of managing your transcripts within the same application as your documents. As a transcription management tool, Concordance provides you with additional review and annotation features necessary for working with transcripts. You can also join a transcript database with other discovery databases to search across all documents and transcripts at once.

Like other Concordance databases, transcripts are searched using full-text operators. You can narrow your search to a specific deponent, transcript date, or volume number. Specific fields are used in transcript databases to capture that information.

For more information about joining a transcripts and records database together, see About concatenating databases.

**Viewing Transcripts**

Concordance displays transcripts in a traditional format familiar to most attorneys and paralegals. Transcripts are reviewed in the Browse view with the database listing of individual transcripts in the Table view.

A transcript database has name, date, and volume fields with the full-text of the deposition stored in the text field. These fields are not visible in the Browse view, but you will see them in
the Table and Edit views. In a transcript database, you can mark transcripts by line, add notes and issues, and add file attachments or hyperlinks.

Right-click menu options for transcript databases:

- Change the font size and color while reviewing the transcript on the screen, especially useful if more than one database is open.
- Print the transcript.
- Print selected content of the transcript.
- Add or edit a note or attachment.
- Export the transcript to other litigation software, like CaseMap and Sanction.

You can easily navigate to a transcript you want to review by using the Go to button on the Dynamic toolbar, and entering the document page and line numbers in the Go to box. The transcript document is identified in the Concordance title bar by name, date, and volume.

There are four ways to annotate a transcript:

- Apply a Quick Mark
• Create a Note
• Apply an Issue tag
• Add an Attachment

Adding Quick Marks to transcripts

A Quick Mark is highlighting applied on the left side of a transcript denoting the page and line number. Simply click on a line number during a cursory review. This is a great way to remind yourself there may be content worthy of a note or issue tag, or simply marks the place where you may want to return in the future.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>) Defendant.</td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>HIGHLY CONFIDENTIAL</td>
</tr>
<tr>
<td>17</td>
<td>DEPOSITION UPON ORAL EXAMINATION OF</td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>EDWARD FELTEN, Ph.D.</td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

Quick Marks made in West® LiveNote® are retained if the transcript is imported from that application into Concordance.

Adding notes to transcripts

Creating notes within a transcript is an ideal way to create a reminder of relevance for case arguments. When you need to find these comments later, you can search the entire transcript database, locate notes attached to a particular transcript, or find both at the same time.

There is no limit to the number of notes or quick marks you can apply per transcript. The first lines of your notes are displayed in the Notes task pane and are also displayed as floating text when you move your cursor over a highlighted note. Notes disappear the instant you delete them, but are not physically removed from the database until your Concordance administrator removes them.
To add transcript notes:

1. In the Browse view, select the transcript text or region where you want to apply a note.

2. Right-click the selected text and select New note to open the Notes dialog box.

3. On the Note tab, type the applicable comments.

   To apply issues to a transcript, see Applying issue tags to transcripts.

   To add attachments to a transcript, see Adding attachments to transcripts.

4. Click OK to save the note and close the Notes dialog box.

   Once a note is applied, the area you selected is highlighted and underlined. To view the note text, float your cursor over the highlighted text.

5. If you need to edit a note, right-click a note and then click Edit note.

6. Modify the note text as needed and click OK.

   Changes are immediately viewable. However, in order to run full-text searches on new or modified notes in the record, the database needs to be reindexed. Once this action is performed all reviewers can search the notes.

7. To reindex the database, on the File menu, click Reindex.

To delete a note:

1. In the Browse view, click the note or right-click the note and select Edit note to open the Notes dialog box.
2. Click the **Delete** button, and then when prompted click **Yes** to verify that you want to delete the note.

The note is removed from the database and the next note in the database displays in the Notes box.

3. Click **OK** to close the Notes box.

Notes disappear the instant you delete them, but are not physically removed from the database until your Concordance administrator removes them.

---

**Searching Transcript Notes**

Once transcript notes are applied, there may be times when you need to search for them in a lengthy transcript.

You can search transcripts notes using:

- Advanced Search panel - enter words found in the notes
- Notes task pane - review notes and jump to a specific note within the transcript

The database must be reindexed before any new notes you entered are searchable.

---

To search transcript notes using the Advanced Search panel:

1. In the Search task pane, open the Advanced Search panel.
2. From the Options list, select **Search notes only**.
3. Type the search value or string in the **Advanced Search** panel.

4. Click the **Search** button or press Enter to initiate the query.

Your search results display those transcripts that include notes containing the search value or string.

If multiple transcripts display in your search results, use the Notes panel to review each transcript to find other notes containing the search value or string.

---

**To search transcript notes using the Notes task pane:**

1. Open the **Notes** task pane, in the **Note** panel, select **View by notes**.

   When you select View by notes, the transcript's notes are displayed in the Notes panel.

2. To view a specific note in the transcript, double-click on the note in the note list to jump directly to that note in the transcript.

   - In the Notes panel, lines with <empty> are simply transcript notes that do not contain any note text in the note.

   Quick marks are also displayed in the Notes panel. The text of a transcript line marked by a quick mark is what is displayed for each quick mark in the Notes panel.
Applying issue tags to transcripts

Tags work well for categorizing documents, because tags mark or categorize an entire document. Transcripts are handled differently from documents in Concordance. Instead of marking the entire transcript, you are marking a section of text within a transcript. An issue is a type of tag applied to a section of transcript text. When you're adding issues to transcripts, you also have the option of entering comments along with the issue tag for further distinction.

Applying tags to transcripts is not the same method as applying tags to documents records. Tagging is done during review to categorize an entire document. Tagging transcripts with issues is done to digest a transcript based upon a review category.

You can apply issue tags to transcripts from both the Tags task pane and the Notes dialog box.

Document Tags Versus Issue Tags

The difference between a document tag and an issue tag:

- A document tag is applied at the document level. When a document tag is applied to a document, the tag name displays in black text with a white check box in the Tags task pane.
- An issue tag is applied at the text level, within the document. When an issue tag is applied to a document, the tag name displays in red text with a gray check box in the Tags task pane.

To add issue tags from the Notes dialog box:

1. In the Browse view, select the transcript text or region where you want to apply an issue tag.
2. Right-click the highlighted text and select New note to open the Notes dialog box.
3. In the **Issues** field on the **Note** tab, select the check box next to the tags you want to apply.

A red check mark next to a tag in the Issues field indicates the issue tag has been applied to the selected text.

To apply notes to a transcript, see Adding notes to transcripts.

To add attachments to a transcript, see Adding attachments to transcripts.

4. Click **Apply** and then **OK** to save the issue tag and close the Notes dialog box.

Once an issue tag is applied, the area you selected is highlighted and the tags you applied are selected. The tag name is displayed in red in the Tags panel.

5. If you need to edit the issue tags, right-click the highlighted text and select **Edit note**.

To remove an issue from a document in the Notes dialog box, in the Issues field on the Notes tab, clear the issue tag check box.

You can also remove an issue from a document in the Tags task pane by right-clicking the issue in the Tags task pane and clicking the Uncheck issue command. Removing the tag in the Notes dialog box or clicking the Uncheck issue command in the Tags task pane does not delete the issue code from the database. Issue codes can be deleted from the Add/Delete panel in the Tag and Issue Management dialog box.

6. Modify the tags as needed and click **OK** to save your changes.

To view the issues applied to highlighted text, you can double-click the highlighted text or open the Notes task pane, select View by Issues or View by Notes, and double-click the applicable issue or note to open the Notes dialog box.

**To add issue tags from the Tags task pane:**

1. In the **Browse** view, select the transcript text or region where you want to apply an
issue tag.

2. Open the Tags task pane.

3. In the Notes panel, press **SHIFT** and select the check box next to the tags you want to apply.

The default setting for adding issue tags using the Tags task pane is **SHIFT+Left Click**. If your Concordance administrator changed the issue tagging setting to only use a single left click, just select the check box next to the tags to want to apply.

A red check mark next to a tag indicates the issue tag has been applied to the selected text.

To remove an issue from a document in the Tags task pane, right-click the issue in the Tags task pane and click the Uncheck issue command.

You can also remove an issue from a document in the Notes dialog box, by clearing the issue tag check box in the Issues field on the Notes tab. Removing the tag in the Notes dialog box or clicking the Uncheck issue command in the Tags task pane does not delete the issue code from the database. Issue codes can be deleted from the Add/Delete panel in the Tag and Issue Management dialog box.

Some people find that they highlight and select text as they read documents and transcripts. Doing so may cause accidental issue tagging if you are using a single left click to add issue tags. For those users in this scenario, it is best to train yourself to add issue tags using only the right-click menu option. When applying document tags to an entire document record, make certain that no text in the record is highlighted.

---

### Adding attachments to transcripts

Transcripts often reference exhibits and evidence. The ability to view that evidence as you are reading a transcript is useful in your review. Exhibits attached directly to a transcript excerpt are an easy way to refer back to those exhibits.

Concordance allows you to browse to your hard drive, network, or the Internet to attach a file, creating a direct hyperlink to a file or Web site so that it can easily be referenced later.
To add attachments to transcripts:

1. In the Browse view, select the transcript text or region where you want to add an attachment.

2. Right-click the highlighted text and select New note.

3. Click the Attachment tab.

4. Select the file type's destination or location from the Attachment type list:
   - <none> - field defaults to <none> until an attachment is added
   - External - to attach an external file or link to a Web site
   - Viewer - to attach a document image from a Concordance database
   - Clipboard - to copy the highlighted text to the Microsoft Windows clipboard
   - Internal - used by the system only

5. Click the Browse button next to the Attachment field and locate the applicable files or Web site.

6. Click the Open button on the Open dialog box to add the path to the files or Web site address to the Attachment field.

7. To automatically launch the file or Web site with one click, select the Open attachment when note is clicked check box.

   If the Open attachment when note is clicked check box is not selected, users have to right-click the note and select Run attachment to open the attachment.

   To apply notes to a transcript, see Adding notes to transcripts.

   To apply issues to a transcript, see Applying issue tags to transcripts.

8. Click OK to save the attachment.
9. If you need to edit the attachment, right-click the highlighted text and select Edit note. Modify the attachment information as needed and click OK to save your changes.

If you select <none> from the Attachment type field but do not delete the file path or Web site address from the Attachment field, Concordance does not permanently remove the path or address. Concordance only blocks the attachment from launching when someone is reviewing the highlighted text.

10. To save a copy of the attachment, right-click the highlighted text and select Save attachment as to save it to your hard drive or network.

Reviewing transcript notes

A quick review of a transcript notes and issues can be done in the Notes task pane. The notes, issue tags, and attachments associated with the current transcript are listed in the Notes and Issues panels. Click a listed item to quickly jump through all the annotations in a transcript.
To review notes and issues in a transcript:

1. Open the transcript in the Browse view.

2. Open the Notes task pane.

3. In the Notes panel, do one of the following:
   - To view by notes, select View by notes.
   - To view by issues, select View by issues.

   Selecting View by notes displays a list of the notes applied to the transcript in the Notes panel.
   Selecting View by issues displays a list of the issues applied to the transcript in the Issues panel.

4. Click a note in the Notes panel to instantly jump to the highlighted region of the transcript.

5. Click an issue in the Issues panel to instantly jump to the tagged region of the transcript.

   You can also double-click a note or issue to jump to the transcript note and open the Notes dialog box and edit the note, issue, and/or attachment.

   Notes and issues in the Notes task pane display in the order they appear in the transcript, not in the order applied.
The properties for the selected note or issue are displayed in the Properties panel below the Notes and Issues panels. The Properties panel displays the location of the note or issue in the transcript, any added note text, and the path to any attached file or Web site address.

Printing transcript annotations

Because your transcripts are unique documents with added notes, highlights and attachments, Concordance offers an Annotation Report Writer tool for customizing reports from your transcript database.

Depending on your needs, each annotated report created in the wizard may include several types of annotations and the text included in the annotations.

To print annotations using the Annotation Report Writer wizard:

1. In Concordance, open your transcripts database.
2. On the Standard toolbar, click the arrow next to the Report button and select Annotation report writer.
3. In the Annotation Report dialog box, select Annotation Report Wizard and click OK.
4. In the Report dialog box, select the type of annotated report you want to print and click Next.
   - Issue report - prints an issues report
   - Attachment report - prints a report of annotations containing attachments
   - Note report - prints a report of annotations containing notes
   - Quick mark report - prints a report of all transcript line number highlights
5. If you are printing an issue report, select the **Print all issues** option or select the **Print selected issues** option and select the issues you want to include on the report, and then click **Next** on the **Issues** dialog box.

To select individual issues in the list, use CTRL+click. To select a block of issues in the list, use SHIFT+click.

If you are printing an attachment, note, or quick mark report, just click Next on the Issues dialog box.
6. In the Annotations field, select the one of the note printing options and select whether you want to print the quick marks, attachments, and/or issue list.

7. In the Select the user(s) to print annotations field, select the users for which you want to print annotations and click Next.

To select individual users in the list, use CTRL+click. To select a block of users in the list, use SHIFT+click.
8. Select the transcript context you want to include when printing the notes and issues in the **Context** dialog box and click **Next**.

![Context dialog box]

9. To add a custom header and/or footer to the report, fill out the fields in the **Formatting** dialog box and click **Next**.

You can include an annotation header, page numbers, the print date, and the print time on the report. You can also select whether to print a page border and multiple pages per sheet of paper in the Compressed print field.
10. Define your final print options in the **Print** dialog box, like customizing the font and page layout, and whether to print a hard copy or save to a file.

To preview or edit your report, click the **Click this button to preview your report** button.

We recommend that you always preview the report before printing a hard copy or saving multiple files of it on your hard drive or server. This also allows you to edit the font, headers, footers, or other print options before you process the report. Click the **Close button in Print Preview** if you need to return to the Annotation Report dialog box to make any additional changes to the report.

11. Click the **Print** button to print the report.
Concatenating Databases

About concatenating databases

Concatenation within Concordance is joining databases together to search information across multiple open databases, at one time.

There are three main reasons for joining databases:

- Very large record collections are often broken into smaller databases for administrative maintenance needs and need to be joined for the review team to access all case documents
- Databases separated based on record and/or file type still make up the case’s record collection and need to be searched together during particular review projects
- Attorneys may request that records are separated by category, yet still need to combine the databases during case review

Because one case can garner thousands of records and transcripts, your firm’s Concordance administrator most likely will create several databases and join them together to reduce time indexing a vast amount of information, which can take several hours. Separate databases are also created based on type: emails, transcripts, and non-transcript records, so joining them for search purposes is ideal during review projects. Sometimes attorneys may want subsets of records broken by category, such as all pleading documents and correspondence documents separated by database, and again having the benefit of concatenating them for specific review projects.
As a member of the review team, you must ensure that every pertinent record has been reviewed, sorted and tagged appropriately regardless of the database location. The way to do this efficiently is by concatenating databases and saving appropriate search queries during the discovery process. You will still be able to see every tag and issue, entered by all users, and listed alphabetically.

**Concatenating databases is a powerful feature that includes:**

- Searching up to 128 databases simultaneously and treating them as a single large file, depending on network set up
- Opening transcript and non-transcript databases together
- Using drop-down database lists on field’s with selection functions

An administrator may want to divide a very large database into smaller databases for ease of maintenance, differing security levels, improved indexing speed, or to reindex several databases at once.

**Joining multiple databases**

When you concatenate a set of databases, the databases remain joined only for the duration of your current Concordance session unless you save the concatenated database set as a Concatenated (.cat) file.

Saving a .cat file allows you to easily reopen the same list of databases so that you can search across all the other joined databases in another session or restore saved queries that were previously run on the concatenated set.

There are some instances where setting up a concatenated set can affect other users. You should consult with your database administrator before saving a concatenated set of databases.

If you want to preserve your search history for the concatenated set, you need to save your queries during the current session while the databases are joined. You can restore the queries at a later time. When restoring saved queries for a concatenated database, you need to rejoin the databases before re-running the searches.

When reviewing a concatenated dataset, all tags in all databases display in the Tags panel. If you apply a tag from one database to a record in another database, Concordance automatically writes that tag into the record’s corresponding database.

For more information about saving and managing search queries, see Saving search queries. For more information about saving .cat files, see Saving a concatenated file set.

**To concatenate databases:**

1. Do one of the following:
In the Databases task pane, click Concatenate database.

On the File menu, point to Concatenate, and then click Add database.

2. In the Concatenated Databases dialog box, click the Add button.

3. In the Add Concatenated Databases dialog box, locate and open the database file you want to join with your current database.

   The file path is added to the Concatenated Databases box.

4. When finished, click the Done button to join the database files.

   The Current Database panel in the Databases task pane displays all the concatenated databases, the total number of documents in the concatenated set, and whether the databases need reindexing.

   You can also verify whether a database is concatenated in Properties dialog box.

Joined databases in a Concatenated database set only remain concatenated for the current session unless you save the concatenated database set. Once you close out of the database, the concatenation is removed from each of the databases in the set.

To remove the database concatenation, on the File menu, point to Concatenate, and
then click Clear database.

To save the concatenated database set, see Saving a concatenated file set.

The Table view layout corresponds to the active database you are reviewing. If you view a record from a concatenated database, your Table view layout changes to display the fields and sort order for that database. Remember to reference the Concordance Title bar to see what database you are viewing for a particular record.

If you are reviewing multiple joined databases at a time, it may be helpful to change the font color or size in each database to help you differentiate between the databases at a glance.

Indexing and reindexing concatenated databases

Edits and changes on various databases are occurring simultaneously by all users who are adding tags and comments, and editing records. Make sure that team members are updating the dictionary for searches by regularly reindexing all the databases in concatenated database sets.

When you Index a concatenated set of databases, Concordance indexes each database in the set. If you have access to multiple workstations, you can Index various databases simultaneously, saving time. When you Reindex a concatenated set of databases, each database in the concatenated set is reindexed, updating the whole concatenated database collection.

If a check mark is displayed next to Reindex on the File menu, the databases need updating. The check mark disappears from this setting after the process is completed. Collaborate with the review team lead to ensure that reindexing schedules coordinate with case review objectives.

Related Topics

About indexing databases
Indexing and reindexing updates

Saving searches in concatenated databases

When searching concatenated databases, Concordance searches across all concatenated databases but because it searches each dictionary file one by one, searches may take a bit longer.

Saving queries executed on concatenated databases is the same process as saving them when
reviewing one database at a time. All searches from all databases in the concatenated set are
saved. Query files are stored in a .qry file, and can be restored on a concatenated set as you
would a single database. You just need the databases to be joined when you save the query
and when you re-run the query. Re-running the queries on a concatenated database set
gathers any updates made since the last time any database was reindexed.

**Related Topics**

Saving search queries
Running previous search queries

**Printing from concatenated databases**

When printing from a concatenated database set, you have the option to show or hide certain
fields.

If you are printing a standard report in Concordance, you need to designate the database you
are printing from on the Fields tab in the Print documents dialog box. To open the Print
documents dialog box, click the Print button on the Standard toolbar. You can also select the
fields you want to print and can arrange the field order for printing on the Fields tab.

For more information about printing standard reports, see Printing standard reports.

**Saving a concatenated file set**

Always consult with your Concordance administrator before saving personal concatenated files
to your hard drive or network to ensure you are following internal guidelines for this process.
Saving .cat files can affect other users, so you need to exercise care and caution.

⚠️ If you name your personal concatenated file set's .cat file the same name as the primary
database and store it in the same folder location as the primary database, then all the
databases listed in the file launch automatically when the primary database is opened.
This could create confusion and search problems for other team members.

You have two options for saving your personal concatenated files:

- Name the concatenated file as you wish and save it to your hard drive or network in a
directory that is not the directory containing the primary database file.
- Name the file differently than the primary database and save it in the primary database's
directory or another network or hard drive folder.

⚠️ **To save a personal concatenated file:**
1. Join the databases you want to include in the concatenated file.

   For more information about joining databases, see Joining multiple databases.

2. After joining the databases, do one of the following:
   - In *Concatenated Databases* dialog box, click the *Save* button.
   - On the *File* menu, point to *Concatenate*, and then click *Save list*.

3. Browse to where you want to save the file, type the name of the .cat file in the *File name* field, and click *Save*.

   Do not name the .cat file the same name as the primary database and place it in the same folder as the primary database. If the file has the same name and is saved in same folder as the primary database .dcb file, then all the databases listed in the .cat file launch automatically when the primary database is opened.

4. In the *Concatenated Databases* dialog box, click the *Done* button.

   To open the .cat file, see Opening a concatenated file set.

   - If you want to know which databases are joined together in a concatenated file, you can open the .cat file in Concordance, or you can open it in any text editor program to view the list of databases.

### Opening a concatenated file set

When you open concatenated (.cat) files in Concordance, Concordance automatically opens each of the databases joined together in the file, and lets you search and review the databases as one database.

A concatenated file is an editable text file that you can open in any text editor program to review and edit the joined databases.

- **To open a concatenated file in Concordance:**
  1. In Concordance, on the *File* menu, point to *Concatenate*, and then click *Open list*.
  2. Locate and open the .cat file.

   When you open a .cat file, a new tab displays on the Workspace pane. The new tab name defaults to the name of the primary database in the concatenated file.

- **To open a concatenated file in a text editor:**
  1. Locate and right-click to select the .cat file on your hard drive or network.
  2. Select *Open With* and select the text editor program.
The all the joined databases listed, along with their corresponding directory paths.

You can manually edit the .cat file, including cutting and pasting database directory paths directly into the text editor program and saving the file.

Deleting a concatenated file set

If you no longer want databases to be joined in a concatenated file or automatically launch each time the primary database is launched, simply delete or rename the .cat file in the directory you originally saved the .cat file.

Printing

About printing

Media files are usually only printed in productions by your Concordance administrator once annotations are completed and all redacted content marked. This ensures that opposing counsel does not receive any original copies and other staff do not view privileged content. However, there may be instances when you need to print images or create certain reports for case review prior to production.

In Concordance you can print:

- Records directly from the Browse view
- Record batches based on queries
- Transcript annotation reports (Annotation Report Writer)
- Tagged record lists
- Summary reports from the Table view (Report Writer or Send to Excel)
- Selected field data
- Multiple annotated media files from CNV as a batch

In Concordance Native Viewer you can print:

- Redacted media (documents/images)
- Single documents (a single document may contain multiple pages)
In Concordance Image you can print:

- Redacted images
- Annotated summary reports
- Record batches based on queries
- Saved or appended redline files

The following print options are available:

- Printing an entire image view
- Printing all or only specific redlines
- Printing a range of pages and documents with recalculated page numbers
- Adding date and time stamps and custom text to document headers and footers
- Saving print settings to print format files for future printing
- Inserting separator sheets in large document print runs
- Suppressing errors or writing errors to a .log file

When a batch of images are printed, the original images never change. Annotations, highlights, and other markings are stored in the Concordance database, and can be modified without modifying the original image. Selected annotations and headers and footers can be applied to only the paper copies of images for printing or fused directly onto new images when produced. When images are printed, they have a slightly smaller output than the original image. Images are automatically reduced by 2 or 4 percent, based on the type of image file.

When printing documents that have been reviewed and redacted in Concordance Native Viewer, be aware that any redaction placed on the document will print transparent revealing the text underneath. If you want to print redactions as opaque, you need to use the Production tool in Concordance and then print the production copy of documents.

Your Concordance administrator or Litigation Support Manager is typically in charge of printing productions because of the sensitivity involved in running a production. We highly recommend that any staff tasked with printing productions receives proper Concordance administration training before attempting to do so with live databases.

To print images to paper copies or to an electronic file, such as an Adobe Acrobat PDF file, see Printing images.

For more information about producing new image files using the Production Wizard, see Creating a production.
Dear Mr Sandoz

Re: COWCO IN BANKRUPTCY

We are writing to inform you of a decision reached by the Invcuson Committee in Dallas 21.1.84. The decision made is to allow you to file an adversary proceeding against MMC & Fidelity Security Bank of Utah to determine the validity/extent/priority of the collateral interest from COWCO.

We believe all MMC claims against COWCO should be subordinated to those of the participants. Listed below are the reasons.

1. On 1.4.80 MMC agreed in the contract 02/02 to pay all matters and indemnify COWCO without any limitation.
2. MMC’s directors have given personal indemnities to fulfill this obligation.
3. MMC were aware of losses as early as 3.2.84, see document 59.
4. MMC have been in control of our assets since the bankruptcy on 5.6.82.
5. Counsel have advised us we are legally protected from claims of MMC ranking in priority in accordance with the decision of the Supreme Court. Re A Ltd, [1990] 4339.

Best regards,

Chaffe 1466
McCall 3567
Phillips 5197
Tolery 6566
Sandoz 6567
Suzie DH 3555

Images supplied by Elliott Slone, London, UK

CRANE POOLE & SCHMIDT
Printing documents in Concordance

Printing options

Concordance provides several printing options for document records and transcripts, and can be used to create and print a variety of customized reports based on search results, field content, tagged document sets, and transcript annotations. Printing options are available in the Browse and Table views. The view you print from determines the format of the print output. The print output format looks similar to the view you print from.

You can print single pages in Concordance Native Viewer or a set of media or image files from Concordance using the Print CNV command on the Tools menu. For more information, see Printing individual documents in CNV or Printing document sets in Concordance.

Document images can also be printed from Concordance Image. For more information about printing in Concordance Image, see Printing images.

Use Concordance to print:

- Records directly from the Browse view
- Record batches based on queries
- Transcript annotation reports (Annotation Report Writer)
- Tagged record lists
- Summary reports from the Table view (Report Writer or Send to Excel)
- Selected field data
- Print multiple documents and images

While you have basic options for printing page numbers and dates, Concordance also offers selections for printing highlighted annotations, underlined hits, field labels, and more. These print options are useful for printing sets of records for full-text review or to print annotations from transcripts.

You can also print a spreadsheet report of queries displayed in Table view with field text in the sort order selected. This option is useful when a summary listing is appropriate.

With lengthy documents like depositions, transcripts, and research reports, print a Keywords in Context (KWIC) report to capture pertinent information in context, like the deponent’s name or article title.

If you need to print from the Table view, try exporting the content to Excel and printing it from there. For more information about exporting table data and exporting numerical data, see Exporting Concordance data.

Printing individual records and transcripts

You can print an individual record, transcript, or selected text from the Browse view. When you print from the Browse view, Concordance only prints the record or transcript file currently
displayed in the Browse view.

Before you print a record or transcript, you can preview how the document will print by clicking Print Preview on the File menu.

If you have another view, such as the Table view, open with the Browse view, the Print and Print Preview menu selections may be disabled on the File menu. Click on the record or transcript file in the Browse view to activate the Print Preview and Print menu selections.

For additional print options, you can click the Print button on the Standard toolbar. For more information about printing from the Standard toolbar, see Printing standard reports.

To print an individual record or transcript:

1. In the Browse view, open the record or transcript you want to print.
2. On the File menu, click Print or right-click in the Browse view and click Print record.
3. Click OK to print the record or transcript file.

To print selected text in the Browse view:

1. In the Browse view, select the text you want to print.
2. Right-click the selected text and click Print selection.
3. Click OK to print the selected text.

Printing standard reports

If you want to print multiple records or transcripts, you can generate a standard report. Your current search query determines which records or transcripts are available to print on a standard report. For example, if your current search query contains 47 records, you can include some or all of the 47 records in the query on the standard report.

Standard reports have a number of customizable features such as headers, footers, date and time stamps, page numbering. When you print a standard report in Concordance, by default the printed font format for records is determined by your personal Concordance display settings. For example, if your display font setting is: Sea Green, 14 point, Monotype Corsiva, your document will be printed with the larger italic green font (for color printers) or gray font (for black and white printers). If you do not want to use the default format, you can define your preferred print settings on the Print documents dialog box before printing. You can also save your preferred print settings for future printing, or use previously saved print settings for printing.

To ensure records print the way you want, we recommend previewing your print job before sending it to the printer. To preview your print job, click the Print preview button on the Print tab in the Print documents dialog box.
When you print in Concordance, you are printing from database records. When you print in Concordance Image, you are printing from .tif files in the imagebase. For more information about printing in Concordance Image, see Printing in Concordance Image.

To print standard reports in Concordance:

1. On the Standard toolbar, click the Print button.
2. Click the Fields tab.

   The Fields tab is used to define the fields and their order to include on the report for the selected database. The fields are listed alphabetically in the Available fields field.

3. In the Database list, select the database containing the records you want to print.

   The Database field defaults to the current Concordance database.

4. In the Available fields list, choose the fields you want to include on your report.

   For example, to print the record’s body text, click the OCR1 field.

   You can choose multiple fields by pressing the SHIFT or CTRL key while clicking multiple fields.

5. Click the Select button to add the fields to the Selected fields list.

   The standard report includes data from each of the fields in the Selected fields list, and displays the field data in the order the fields are displayed in the Selected fields list.
To add all of the fields to the Selected fields list, click the Select all button. To change the order of the fields in the Selected fields list, click a field and click the Move down or Move up button.

To remove a field from the Selected fields list, click the field you want to remove and click the Remove button. To remove all the fields from the Selected fields list, click the Remove all button.

5. To print the keywords (search hits) for the current query, click the KWIC tab and select the Print key words in context (KWIC) check box.

6. The database and fields you selected on the Fields tab are displayed below the Print key words in context (KWIC) check box.

7. In the fields list, select the check box next to the fields you want to print key words in context.

8. To include record text above and below the key words, select the Print line(s) above and below check box and type the number of lines to include above and below in the line number fields.

9. To print the question and answer pair associated with the key words in transcripts, select the Print Q&A pairs check box.

   This check box only applies to transcripts. Leave the Print Q&A pairs check box blank if you are not printing from a transcript.

10. To add header and footer text, determine widows and orphans on page breaks, and define other printing controls, click the Formatting tab.
11. In the **Header** field, type the report header.

The header displays at the top of each printed page and is left justified on the page.

12. In the **Footer** field, type the report footer.

The footer displays at the bottom of each printed page and is left justified on the page.

13. In the **Widows and Orphans** field, type the number of widows and orphans to allow on each page.

Widows are the lines of text left at the bottom of a page when a record is split in two. Orphans are the lines of text at the top of the next page.

The number entered in the Widows field controls the minimum number of lines Concordance allows to remain at the bottom of a page. If the number of lines to print at the bottom of the page is less than the number in Widows field, then the document is moved to the top of the next page.

The number entered in the Orphans field controls the minimum number of lines Concordance prints at the top of a page when splitting a document between pages. If the lines left to print are less than the number in the Orphans field, then lines will be borrowed from the previous page until the orphan minimum is met. This may cause the preceding page to go below the widows threshold, causing the entire document to print at the top of the new page.

14. In the **Options** section, select the print options you want to apply to your report.

- [ ] **Formatting Options Field Names and Definitions**
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print date</td>
<td>Prints the current date on each page below the footer.</td>
</tr>
<tr>
<td>Print time</td>
<td>Prints the current time on each page below the footer.</td>
</tr>
<tr>
<td>Print field labels</td>
<td>Prints the field name before each field.</td>
</tr>
<tr>
<td>Print page numbers</td>
<td>Prints the page number at the bottom of each page on the right side of the page.</td>
</tr>
<tr>
<td>Print document numbers</td>
<td>Numbers each document in the report and prints the document number before each document in the report. For example, Document 1 of 100.</td>
</tr>
<tr>
<td>New page for each record</td>
<td>Prints each document on a separate page.</td>
</tr>
<tr>
<td>Highlight annotations</td>
<td>Highlights the notes and annotations in the report.</td>
</tr>
<tr>
<td>Compressed printing</td>
<td>Prints the selected number of pages on one single page.</td>
</tr>
<tr>
<td></td>
<td>You can print up to nine pages per sheet of paper. Printing multiple pages on one single page is sometimes referred to as N-up printing. The N represents the number of pages you are printing on one single page.</td>
</tr>
<tr>
<td>Print page borders</td>
<td>Prints a border around each page when you are printing multiple pages on one single page.</td>
</tr>
<tr>
<td></td>
<td>This field is only available if you are printing 2 or more pages on one single page.</td>
</tr>
<tr>
<td>Underline hits</td>
<td>Underlines search hits in full-text paragraph fields.</td>
</tr>
<tr>
<td>Bold hits</td>
<td>Bolds search hits in full-text paragraph fields.</td>
</tr>
<tr>
<td>Italicize hits</td>
<td>Italicizes search hits in full-text paragraph fields.</td>
</tr>
<tr>
<td>Hit Color</td>
<td>Adds the selected color to search hits in full-text paragraph fields.</td>
</tr>
<tr>
<td></td>
<td>To change the hit color, click the Hit Color button and select the hit color.</td>
</tr>
</tbody>
</table>

Search hits are only highlighted in the full-text paragraph fields, not in fixed-length text, date or numeric fields.

If a record is edited after the search, the record’s search hit will not be highlighted in the report. To include the edited record’s search hit, index or reindex the database and re-run the search.

When printing documents with ideographic text, like Chinese, a character underlined for hit highlighting can easily be confused with other characters. Select bold, italicize, or color to highlight search hits in these languages.

15. To define the document print range, change the font, margin, orientation and printer settings, and preview and save your print settings, click the Print tab.
The Total field is a read-only field, and displays the total number of documents in the current query. The First and Last fields determine the document print range for the report. The First field defaults to the first document in the current query, and the Last field defaults to the last document in current query.

16. In the **First** field, type the number of the first document you want to include on the report.

17. In the **Last** field, type the number of the last document you want to include on the report.

Concordance prints all documents between and including the first and last documents defined in the First and Last fields.

18. Click one or more of the following buttons:

- **Print Button Names and Definitions**

<table>
<thead>
<tr>
<th>Button Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save to Print file</strong></td>
<td>Click to open the Print Format dialog box and save your settings to a print format file (.fmt). For more information see To save your print settings.</td>
</tr>
<tr>
<td><strong>Open an existing print file</strong></td>
<td>Click to open the Print Format dialog box and select an existing print format file (.fmt) to use for printing the report. For more information, see To print a standard report from an existing print file.</td>
</tr>
<tr>
<td>Button Name</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Change the font</strong></td>
<td>Click to open the font menu. Click the font type you want to modify to open the <em>Font</em> dialog box and modify the font. You can modify the font for the fields, data, transcripts, and header and footer in the report.</td>
</tr>
<tr>
<td><strong>Change the margin, orientation, and other print settings</strong></td>
<td>Click to open the Page Setup dialog box and define the paper size and source, and the page orientation and margin settings. By default, reports print to your computer’s default printer. You can click the Printer button in the Page Setup dialog box to select a different printer for the report.</td>
</tr>
<tr>
<td><strong>Print preview</strong></td>
<td>Click to preview the report. To print directly from the preview screen, click the Print button. To return to the Print documents dialog box, click the Close button.</td>
</tr>
</tbody>
</table>

19. Click the **Print** button to generate and print the report.

**To save your print settings:**

1. On the **Standard** toolbar, click the **Print** button.
2. In the **Print documents** dialog box, define your print settings on the tabs.
3. On the **Print** tab, click the **Save print file** button to open the **Print Format** dialog box.
4. Browse to where you want to save the file, type the file name in the **File name** field, and click the **Save** button.

   All of the print settings are saved including selected fields, fonts, page orientation, paper size, headers and footers. The file is saved in plain text format and can be edited with any text editor or word processor that uses plain text. The print format file’s file extension is .fmt.

**To print a standard report from an existing print file:**

1. On the **Standard** toolbar, click the **Print** button.
2. On the **Print** tab, click the **Open an existing print file** button to open the **Print Format** dialog box.
3. Browse to and select the print format file you want to use.
4. Click the **Open** button to load the print settings into the **Print documents** dialog box.
5. Click the **Print preview** button to preview the report, and make any necessary changes to the print settings.
6. Click the **Print** button to generate and print the report.
Exporting Concordance data

In Concordance, you can export record data from the Table view to Microsoft Excel, CaseMap, and Equivio. The export feature is a great tool for making custom reports, as well as contact and mailing lists. In order to export to Microsoft Excel, CaseMap or Equivio, the software you are exporting to must be installed on your computer.

If you want to export data to Microsoft Word, you can simply copy and paste data from Concordance to Microsoft Word.

Exporting to Microsoft Excel

When you export data from the Table view to Microsoft Excel, Concordance exports data from the records you select in the Table view. The fields and field order currently displayed in the Table view determine which field data is exported for the selected records and the order of the fields exported to Microsoft Excel. Before exporting, you can run a search to display the records you want to export in the Table view, and modify the table layout to define the fields and field order you want to include in the export.

Microsoft Excel has capacity limitations. If you are primarily exporting your data to Microsoft Excel 2003, you need to be aware that this version of Excel is limited to printing a maximum of 65,000 rows, and also has limitations for the number of characters per cell.

To export table data to Microsoft Excel:

1. Run a search to locate the records you want to include in the export to Microsoft Excel.

   For more information about searching, see Available search tools.

2. In the Table view, adjust your table layout to include the fields and field order you want to export to Microsoft Excel.

   For more information about adjusting a table layout, see Using table layouts.

3. In the Table view, select the records you want to export.

   You can export multiple adjacent records and non-adjacent records.

   - Adjacent records: SHIFT + Click to select a block of consecutive records.
   - Non-adjacent records: CTRL + Click to select random records from the list.
   - All records: CTRL + A to select all records in the list.
4. Right-click in the Table View, point to Send To, and then click Excel.

Microsoft Excel automatically launches and displays your exported Concordance data in the field order you selected.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BEGNO</td>
<td>ENDNO</td>
<td>DOCDATE</td>
<td>DOCTYPE</td>
</tr>
<tr>
<td>2</td>
<td>10008</td>
<td>10008</td>
<td>11/23/1983</td>
<td>Accounts</td>
</tr>
<tr>
<td>3</td>
<td>10013</td>
<td>10013</td>
<td>6/5/1983</td>
<td>Correspondence</td>
</tr>
<tr>
<td>4</td>
<td>10016</td>
<td>10017</td>
<td>5/25/1983</td>
<td>Correspondence</td>
</tr>
<tr>
<td>5</td>
<td>10018</td>
<td>10018</td>
<td>7/16/1984</td>
<td>Correspondence</td>
</tr>
<tr>
<td>6</td>
<td>10023</td>
<td>10024</td>
<td>04/06/1983</td>
<td>Financial Paper</td>
</tr>
</tbody>
</table>

Exporting to CaseMap

When you export table data to CaseMap from the Table view, all of the records listed in the Table view are exported to CaseMap. Before exporting data to CaseMap, run a search to capture only the records you want to include in the export.

To export table data to CaseMap:

1. In Concordance, run a search to locate the records you want to include in the export to CaseMap.

   For more information about searching, see Available search tools.

2. In the Table view, right-click the records, point to Send To, point to CaseMap, and then click Send all documents in query.

Selecting Send all documents in query opens the following message: CaseMap does not support Unicode and we will only send single-byte (Ascii) text to them. Press OK if you want to continue.
3. Click **OK** to continue.

   Clicking OK opens the *Completed gathering the document data* message dialog box.

4. Click the **Continue** button.

   Clicking the Continue button opens the Bulk Send to CaseMap wizard in CaseMap.

   For more information about exporting Concordance data to CaseMap and using CaseMap’s Bulk Send to CaseMap wizard, see the CaseMap documentation.

---

### Exporting Numerical Data

When you export numerical data from Concordance to Microsoft Excel, if the field value begins with leading zeros, the leading zeros are trimmed from the field value. For example, if you are exporting the BEGNO field value `00020177`, the value is exported to Excel as `20177`. To keep record numbering consistent with Concordance data, you need to add the leading zeros back onto the applicable field data in Microsoft Excel. See, Microsoft Excel documentation.

- Numerical field values starting with alphabetical prefixes are not affected when exporting to Microsoft Excel.

Only the field data that is displayed in the Table view is exported. Field data is exported in the order that is displayed in the Table view, based on the selected table layout. You can use custom table layouts to determine the field data and order of field data exported to another application.

---

### Exporting to Equivio

Equivio is an optional companion product for Concordance version 10.19 or earlier E-mail databases. In Concordance, Equivio highlights the textual differences between two e-mail documents.

The Equivio commands on the File menu and shortcut menu in the Table view are used to compare two e-mail messages selected in the Table view.

Before you can compare e-mail messages in the Table view, the e-mail messages have to be exported to Equivio for processing, and have had their Equivio results updated by the Equivio import.

For more information about exporting data to Equivio and comparing e-mail messages in the Table view, see Using Equivio with Concordance.
Using Equivio with Concordance

Equivio® is an optional companion product for Concordance version 10.19 or earlier E-mail and Attachments databases. In Concordance, Equivio highlights the textual differences between two e-mail documents. Equivio helps you identify and skip redundant text during document reviews in Concordance, allowing you to focus on the unique text in each e-mail message.

Currently, you can only use Equivio with Concordance E-mail and Attachments databases.

There are two Equivio commands on the Tools menu in Concordance: Export Current Query and Import Equivio Results. The Export Current Query command is used to export Concordance textual data for processing by Equivio. The Import Equivio Results command is used to import the extracted statistical information for the exported Concordance data back into Concordance.

If you are working with concatenated Concordance databases, only the main database’s records will be exported to Equivio and only the main database will be affected when importing records back into Concordance.

Once the extracted data is imported into Concordance from Equivio, you can select two e-mail messages in the Table view and view the compared records in Equivio using the Equivio menu commands on the File menu or shortcut menu in the Table view. You can only compare e-mail messages that have been exported to Equivio for processing, and have had their Equivio results updated by the Equivio import.

There are two Equivio commands in Concordance: Compare by words and Compare by characters (Asian Languages). The Compare by words command launches the Equivio Text Compare Web page with the word differences between the two selected e-mail messages highlighted. The Compare by characters (Asian Languages) command launches the Equivio Text Compare Web page with the character differences between the two selected e-mail messages highlighted.

The Equivio menu commands are only available when Equivio is installed on your computer and you have permissions for the commands in Concordance.

Here are the steps you need to follow to successfully use Equivio with Concordance:

Set up a Concordance database for Equivo.

1. Open an existing or create a new E-mail and Attachments database in Concordance version 10.19 or earlier.
   
   If you created a new E-mail and Attachments database, import the e-mail messages you want to compare into the database.
   
   For more information about creating Concordance databases, see Creating databases.

2. Create Equivio fields in the database.
   
   To create Equivio fields in the database, click the Append Equivio Fields button on the New or Modify dialog box.
   
   Clicking the Append Equivio Fields button adds all the pre-defined Equivio fields to the...
database. All Equivio field names in Concordance start with EQV_. The Equivio fields are required for the export and import between Concordance and Equivio. Clicking the Append Equivio Fields button also creates the Equivio Work and Extract for Equivio folders in the same directory as the database.

When you export the current Concordance query, Concordance creates the export files in the Extract for Equivio folder. The Equivio Work folder is the work folder used by Equivio when it is processing the exported Concordance data.

3. Close and re-open the database after creating the fields.

**Define the field and menu rights for the Equivio fields and Equivio menu selections.**

1. On the File menu, point to Administration, and then click Security.

2. In the Administration dialog box, type your Concordance administrator name and password and click OK.

   Clicking OK opens the Field rights tab in the Security dialog box.

3. In the users list, select the users you want to provide access to Equivio fields.

4. In the field list, select the Equivio fields.

   To select all the Equivio fields, use SHIFT+click.

5. Select the Full access check box.
6. Click the Menu access tab.

7. Make sure that the following menu check boxes are selected:
   - Tools
   - Equivio
   - Export Current Query
   - Import Equivio Results
8. Click the **Apply** button and click **OK** to save your Equivio security settings.

For more information about Concordance field and menu security, see Setting up security.

**Export Concordance data to Equivio.**

1. Run a search to capture the e-mail messages you want to export to Equivio.

For more information about running searches, see Available search tools.

2. On the **Tools** menu, point to **Equivio**, and then click **Export Current Query**.

Clicking the Export Current Query exports the text of all the e-mail messages in the current Concordance search query to individual .txt text files in the Extract for Equivio folder. The export creates an individual .txt file for each e-mail message that was in the query when you clicked the Export Current Query command. The export also creates a scan file, ScanFile_[date]_[time].csv, in the folder.

Equivio uses the data in the scan and .txt files to identify and group the near-duplicate documents and e-mail threads contained in the exported Concordance query.

If you are working with concatenated Concordance databases, only the main database’s records will be exported to Equivio and only the main database will be affected when importing records back into Concordance.

3. Copy and paste the **ScanFile_[date]_[time].csv** file in the **Extract for Equivio** folder to the **Equivio Work** folder in the same directory.
Process the Concordance data in Equivio.

1. Run the Equivio CreateDB utility to create an Equivio statistics database for the Concordance database query.

2. Run the Equivio Near Duplicates utility to load the textual data exported from Concordance into the Equivio statistics database and generate statistics for the Concordance data.

3. Run the Equivio Extract utility to extract the statistical information and generate the .csv file that will be imported into Concordance to update the e-mail documents originally exported from Concordance.

For more information about running the Equivio utilities, see the Equivio product documentation.

Import Equivio data into Concordance v10.19 or earlier

1. On the File menu, point to Administration, and then click Import Equivio Results.

2. In the Open dialog box, locate the .csv file generated by the Equivio Extract utility and click the .csv file name.

3. Click the Open button to import the contents of the .csv file into Concordance.

When you import a .csv file created by the utility, the import updates the corresponding e-mail messages and Equivio fields in Concordance that were originally exported to Equivio. All Equivio field names in Concordance start with EQV_.

If you are working with concatenated Concordance databases, only the main database’s records will be exported to Equivio and only the main database will be affected when importing records back into Concordance.

Compare e-mail documents in Concordance.

1. Select two e-mail messages in the Table view.

   To select the two records, press the CTRL key while clicking the records.

   You can only compare e-mail messages that have been exported to Equivio for processing, and have had their Equivio results updated by the Equivio import.

   To make it easier to identify Equivio-processed e-mail messages in the Table view, you can make a table view layout containing the relevant Equivio fields. All Equivio field names in Concordance start with EQV_. For more information about table view layouts, see Using table layouts.

2. Right-click the selected records, point to Send to, point to Equivio, and then click one of
the following:

- Compare by words to launch the Equivio Text Compare Web page with the word differences between the two selected e-mail message highlighted. When comparing records by words, Equivio compares the text at the word level, not the individual letters. If a word appears in both e-mail messages, but is spelled differently by one letter, such as Monday versus Mondaye, Equivio highlights the entire word, not just the letter.

- Compare by characters (Asian Languages) to launch the Equivio Text Compare Web page with the character differences between the two selected e-mail messages highlighted. The Compare by characters (Asian Languages) command is typically used when comparing e-mail messages containing East Asian languages that do not use spaces to indicate where one word ends and another word begins in its sentence structure.

**Equivio Highlighting Conventions**

When comparing records, Equivio considers the first record selected in the Table view to be the base document, and considers the second record selected as the changed record. Text removed from the first record selected is highlighted with red text and a strikethrough. Text added to the second record is highlighted with blue underlined text. Text that is identical in the first and second record is displayed in regular black text.

For example:

<table>
<thead>
<tr>
<th>Document</th>
<th>Equivio Highlighting Convention</th>
</tr>
</thead>
<tbody>
<tr>
<td>First document</td>
<td>The meeting on <em>Monday</em></td>
</tr>
<tr>
<td>Second document</td>
<td>The meeting on <em>Monday</em></td>
</tr>
</tbody>
</table>

Equivio only compares the text in e-mail messages. It does not identify formatting changes, such as plain text versus bolded or italicized text, and does not identify space or carriage return changes.

For more information about Equivio, visit their Web site at http://www.equivio.com/default.asp.

**Tallying records for reports**

The tally feature in the Tally task pane itemizes field information for searching, and is also a great tool for helping you organize your document collection in preparation for printing reports. For example, if you want to print a subset of records based on the document type, such as a group of financial reports. The fastest way to locate these records is by running a tally count and then printing them based on your needs.
To tally records for reports:

1. In the **Table** view, right-click a record in the field column you want to tally, and click **Tally [field name]**.

   ![DOCTYPE Table View]

   Clicking **Tally [field name]** displays the tally results in the Tally task pane.

2. In the **Tally** task pane, double-click an item in the **Tally** list.

   Double-clicking an item in the tally list displays only those records in the Table view. For example, if you ran a tally on the DOCTYPE field, and double-clicked Financial Report in the Tally task pane, only financial reports are displayed in the Table view.

3. Print the applicable records.
To print an individual record listed in the Table view, open the record in the Browse view and see Printing standard reports and for more information.

To print multiple records listed in the Table view, see Printing standard reports for more information.

To export the data in the Table view to Microsoft Excel, see Exporting Concordance data for more information.

**Printing transcript annotations**

Because your transcripts are unique documents with added notes, highlights and attachments, Concordance offers an Annotation Report Writer tool for customizing reports from your transcript database.

Depending on your needs, each annotated report created in the wizard may include several types of annotations and the text included in the annotations.

1. In Concordance, open your transcripts database.
2. On the Standard toolbar, click the arrow next to the Report button and select Annotation report writer.
3. In the Annotation Report dialog box, select Annotation Report Wizard and click OK.
4. In the Report dialog box, select the type of annotated report you want to print and click Next.
   - **Issue report** - prints an issues report
   - **Attachment report** - prints a report of annotations containing attachments
• **Note report** - prints a report of annotations containing notes
• **Quick mark report** - prints a report of all transcript line number highlights

5. If you are printing an issue report, select the **Print all issues** option or select the **Print selected issues** option and select the issues you want to include on the report, and then click **Next** on the **Issues** dialog box.

To select individual issues in the list, use CTRL+click. To select a block of issues in the list, use SHIFT+click.

If you are printing an attachment, note, or quick mark report, just click Next on the Issues dialog box.
6. In the **Annotations** field, select the one of the note printing options and select whether you want to print the quick marks, attachments, and/or issue list.

7. In the **Select the user(s) to print annotations** field, select the users for which you want to print annotations and click **Next**.

To select individual users in the list, use CTRL+click. To select a block of users in the list, use SHIFT+click.
8. Select the transcript context you want to include when printing the notes and issues in the **Context** dialog box and click **Next**.

![Context dialog box]

9. To add a custom header and/or footer to the report, fill out the fields in the **Formatting** dialog box and click **Next**.

You can include an annotation header, page numbers, the print date, and the print time on the report. You can also select whether to print a page border and multiple pages per sheet of paper in the Compressed print field.
10. Define your final print options in the **Print** dialog box, like customizing the font and page layout, and whether to print a hard copy or save to a file.

   To preview or edit your report, click the **Click this button to preview your report** button.

   We recommend that you always preview the report before printing a hard copy or saving multiple files of it on your hard drive or server. This also allows you to edit the font, headers, footers, or other print options before you process the report. Click the **Close button** in Print Preview if you need to return to the Annotation Report dialog box to make any additional changes to the report.

11. Click the **Print** button to print the report.
Printing documents in CNV

Printing individual documents

Using the print command in Concordance Native Viewer, you can print the current document displayed in the viewer. If you need to print a set or batch of documents, you can run a query and use the CNV Printing command in Concordance. See, Printing document sets in Concordance.
When printing documents, be aware of the following:

- Printing documents that have been reviewed and redacted in Concordance Native Viewer, be aware that any redaction placed on the document will print transparent revealing the text underneath. If you want to print redactions as opaque, you must run the documents through the Production process in Concordance, then print the document produced document.

- Printing documents that contain markups to Adobe PDF using the File > Print option, does not permanently burn the markups in the document. If you want markups burned in, you must run the documents through the Production process in Concordance, then print the produced document.

To print the current document in CNV:

1. In Concordance Native Viewer, locate the document you want to print, and then from the File menu, click Print.

2. In the Printer list, select the printer where you want to send the document for printing.

3. To modify the printer settings, click the Printer Setup button, specify the paper size, orientation, and other general printing options, and then click OK.

   Options may vary with different printers and drivers.

4. In the Print dialog box, select the General tab.

5. In the Print Range section, click one of the following:
6. In the **Options** section, specify the following:
   - In the **Number of copies** field, type or select the number of copies you want to print.
   - In the **Minimum line thickness** field, type a value from 0 to 99 for the thinnest line weight for markups, and then click **points** (1 point = 1/72 inch) or **mm** (millimeters) for the unit value.

7. From the **Print** list, click one of the following:
   - Click **Lines as Black** to print all lines black, markups print with color (if applicable).
   - Click **As Grayscale** to print in shades of gray.
   - Click **Original Colors** to print using the colors shown in the viewer.

8. Specify any of the following print settings:
   - Select the **Automatically rotate for best fit** check box to allow more of the image to fit within the margins of the printed page.
   - Select the **Print Changemarks notes** check box to include the text in any notes in the current document on a separate sheet.
   - Select the **Print Redaction Reasons** check box to include the text in any redactions in the current document on a separate sheet.
   - Select the **Optimize for PDF/Postscript Printing** check box if you are printing a PDF document.

   - The Optimize for PDF/Postscript Printing option resolves the issue where some older printers and the PDF Distiller and Writer may not properly invert printouts resulting in reversed prints (black background and white foreground). When selected, this produces a bitmap of the current document/image that is sent to the printer giving accurate printouts for the problematic printer or print driver. However, selecting this option results in slower print time and a larger print spool file.

9. To add header, footer, or watermark text to the printed page, click the **Watermark/Banner** button, edit the text strings, and then click **OK**.

   - **To edit headers/footers and watermark**:
     1. Click the folder next to the Header/Footer or the Watermark you want to edit.
     2. For each header, footer, or watermark, click the <blank> field, and then do one of the following:
        - Type the text you want to be displayed.
        - Type % to display the available macros list, and then select the macro you want.

   - **Available macros:**
<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%Date</td>
<td>Inserts the current date</td>
</tr>
<tr>
<td>%SysDatePlusDays</td>
<td>Inserts a date the specified number of days after the system date.</td>
</tr>
<tr>
<td>(X)</td>
<td></td>
</tr>
<tr>
<td>%Time</td>
<td>Inserts the current time the print is executed based on a 12-hour clock.</td>
</tr>
<tr>
<td>%MilTime</td>
<td>Inserts the current time the print is executed based on a 24-hour clock.</td>
</tr>
<tr>
<td>%Title</td>
<td>Inserts the current title of the document</td>
</tr>
<tr>
<td>%Page</td>
<td>Inserts the page number of the document</td>
</tr>
<tr>
<td>%TotalPages</td>
<td>Inserts the total number of pages of the document</td>
</tr>
<tr>
<td>%BatesPgNo(X)</td>
<td>Inserts a page number (x) to include for each printed document. The number entered is the beginning page number for each document. Multi-page documents are numbered incrementally. For example, %BatesPgNo(0001) would print 0001 on each single-page document. However, if a document had more than one page, the first page would appear as 0001, the second as 0002, and so on.</td>
</tr>
<tr>
<td>%Login, User</td>
<td>Inserts the user name of the person who executed the print</td>
</tr>
<tr>
<td>%Hostname</td>
<td>Inserts the hostname of the machine where the print was executed from</td>
</tr>
<tr>
<td>%IPAddress</td>
<td>Inserts the IP address of the machine where the print was executed from</td>
</tr>
<tr>
<td>%©</td>
<td>Inserts a copyright symbol</td>
</tr>
<tr>
<td>®</td>
<td>Inserts a registered trademark</td>
</tr>
</tbody>
</table>

5. To edit the font for the all the text, click the **Font** button, and then in the Font dialog box, specify the font name, style, and size.

6. To view a list of all the headers, footers, and watermark set for the production, click **List**.

7. When finished, OK.

Printing and Production headers/footers and watermark settings are separate entities. Parameters you set in the CNV Printing dialog box are only available for printing.

For more information about editing header, footer, and watermark text, see Modifying print headers/footers and watermarks.

10. When finished, click **Print**.
**Printing document sets in Concordance**

When you want to print a set or batch of documents or image for the current Concordance Image Base (CIB), use the CNV Printing feature in Concordance. The CNV Printing feature allows you to print markups (annotations), add synopsis and separator sheets, and add headers/footers and watermarks.

If you want to print documents or images from concatenated databases or back-end concatenated databases, each database must be similar in structure, contain media keys, a current .cib file, and you must have a minimum of ReadOnly access.

**When printing documents, be aware of the following:**

- Printing documents that have been reviewed and redacted in Concordance Native Viewer, be aware that any redaction placed on the document will print transparent revealing the text underneath. If you want to print redactions as opaque, you must run the documents through the Production process in Concordance, then print the produced document.

- Printing documents that contain markups to Adobe PDF using the File > Print option, does not permanently burn the markups in the document. If you want markups burned in, you must run the documents through the Production process in Concordance, then print the produced document.

**The CNV Printing bulk printing feature is only available in Concordance when you are using Concordance Native Viewer for reviewing and annotating documents.**

**When including Synopsis and Separator Sheets in a bulk print job, you may experience delayed print times. This is due to how Concordance processes the synopsis and separator sheets at print time.**
Before scheduling a batch print run, you first need to identify and locate the documents you want to print using one of the Search tools available in Concordance. See, Available search tools.
To locate documents for printing:

1. In Concordance, open the database containing the documents you want to print.
2. Run a search query to locate the documents you want to print.

To print Concordance Native Viewer documents or images:

1. In Concordance, from the Tools menu, click CNV Printing.
2. Specify the printing parameters:

   To set the printing run parameters:

   1. From the Printer list, select the printer you want to print the documents/images.

   When using the CNV Printing option to print to a PDF Distiller or a PostScript printer, printouts print inverted (black background and white foreground). To print to a PDF Distiller or a PostScript printer, produce the files as PDF documents first using the Production module and then print the produced documents.

   2. From the Printing Run Parameters section, in the Document Range list, do one of the following:
      - To include all the documents in the query, click All.
      - To include a selected set of documents from the query, click Range, and then specify the range of documents you want to print. The default range is the complete range of documents in the current Concordance query.

   3. In the Page Range list, do one of the following:
      - To include all the pages of a document in the query, click All.
      - To include a selected set of pages of a document in the query, click Range, and then specify the range of pages for a document.

   4. To include data from Concordance fields that you have Read access (minimum), in the Concordance Synopsis list, click Yes.

      The Synopsis Separator sheets may, together, contain up to 32 unique DBCB fields. Both sheets may contain the same DBCB fields, which counts as a single unique field. For example, if you add three fields, BegNo, Admin1, and Filepath field to the Synopsis sheet, and two fields, BegNo, and Date Sent to the Separator sheet. You have added four unique fields. The BegNo field counts as one unique field.

   5. In the DBCB Field Names field, click the field, and then click Browse button.

   6. In the DBCB Fields dialog box, do any of the following to select DBCB fields:
      - To select all the fields, click Select All.
      - To select specific fields, select the check box for each DBCB field you want to include on the Synopsis sheet.
      - To change the order the fields appear on the Synopsis sheet, select the field,
and then click the Move Up or Move Down button.

5. When finished, click Save.

The synopsis page prints the first 60 characters of data within the specified Concordance database fields. If security is enabled, only those fields with a minimum of "Read" access are displayed.

6. In the Font field, click the field, and then click the Browse button.

7. In the Font dialog box, do the following:
   - In the Font list, click the font.
   - In the Font Style list, click the font style.
   - In the Size list, click or type the font size.

8. To add separator sheets at the beginning of each document, in the Separator Sheets list, click Yes.

9. In the Text Field, click the field, and then click the Browse button.

10. In the Separator Sheet Editor dialog box, do any of the following:
    - Type the text you want to appear on the separator sheets.
    - To insert a Concordance macro, right-click in the editor field, and then select any of the Concordance Macros (Date, DateTime, DocNo, or Time)
    - Right-click and select a Concordance DBCB field to display within the text. The fields are displayed in the order they appear in the corresponding database. If security is enabled, only those fields with a minimum of "Read" access are displayed.

When you add print macros or select database fields, they appear in the text between angled brackets <>. When the print job is executed, the information associated with the macro or database field appears within the text where the macros or database fields were placed. There is no limit to the number of macros or database fields you can add.

11. In the Font field, click the field, and then click the Browse button.

12. In the Font dialog box, do the following:
    - In the Font list, click the font.
    - In the Font Style list, click the font style.
    - In the Size list, click or type the font size.

To set the printing format parameters:

1. From the Printing Format Parameters section, in the Orientation list, do one of the following:
   - Click Portrait.
   - Click Landscape.
Click **Rotate to Fit** — allows more of the image to fit within the margins of the printed page.

Some document types, such as .xls, the landscape option will split the page by columns and orientated as portrait.

2. In the **Color Setting** list, do one of the following:
   - To print the documents using the document's original colors, click **Color** (default).
   - To print the documents to shades of gray, click **Grayscale**.

To ensure the print job prints the documents as expected, make sure that the printer's color properties are set appropriately.

3. In the **Copies to Print** field, type the number of copies you want to print. The maximum number of copies is 100 and the copies are automatically collated.

4. When printing a PDF document, in the **Optimize for PDF/Postscript Printing** field, click **Yes**.

The Optimize for PDF/PostScript Printing option resolves the issue where some older printers and the PDF Distiller and Writer may not properly invert printouts resulting in reversed prints (black background and white foreground). When selected, this produces a bitmap of the current document/image that is sent to the printer giving accurate printouts for the problematic printer or print driver. However, selecting this option results in slower print time and a larger print spool file.

**To specify markup types to include in the print job:**

From the **Markup Types** section, do any of the following:

- To include all markups, in the **Select All** list, click **Yes**.
- To exclude all markups, in the **Select All** list, click **No**.
- To include some of the markups, for each markup you want to include click **Yes** from the corresponding markup list.

When printing Concordance Native Viewer documents, any documents that contain redaction markups are printed with transparent redactions. If you want the redactions to print opaque, you need to use the Production tool in Concordance to produce the document(s) and then print the produced document.

Due to how the markups are rendered during printing, if you want to include any applied crossout, strikeout, highlight, or underline markup in a print job, please note that all four markups are treated as one and all four if applied will be included in the printed file. For example, if a crossout and highlight markup are applied to a document, if the crossout markup is selected in the CNV Printing parameters, both the crossout and the highlight markup are printed.

**To add headers/footers and watermark:**
1. In the **Printing Run Parameters** dialog box, select the **Include Hdr/Fts Spec** check box.

2. Click the **Edit Headers/Footers and Watermarks** button.

3. Click the (+) sign next to the Header/Footer or the watermark you want to edit.

4. For each header, footer, or watermark, do one of the following:
   - Type the text you want to be displayed.
   - Type % to display the available macros list, and then select the macro(s) you want to add.

### Available macros:

Keep the following in mind when adding macros to headers/footers, and watermarks:

- Each line of a header or footer can use multiple macros. For example, you can add %Date %Time to the Top Left header. This prints 09/22/2010 02:10 PM in the location you specified on each page of the print.
- All macro values are case insensitive, except for the %FIELD_ macro.
- All settings in the Header and Footers dialog box are saved for all documents and images in the Wind

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%FIELD_</td>
<td>Inserts database field data up to 60 characters for a each specified field. For example, %FIELD_OCR1 %FIELD_OCR2, would print the first 60 characters of the OCR1 field and the first 60 characters of OCR2 field. If security is enabled, only those fields with a minimum of &quot;Read&quot; access are displayed.</td>
</tr>
<tr>
<td>%Date</td>
<td>Inserts the current date</td>
</tr>
<tr>
<td>%SysDatePlusDays(0)</td>
<td>Inserts a date the specified number of days after the system date. Replace the 0 a number to indicated the number of days.</td>
</tr>
<tr>
<td>%Time</td>
<td>Inserts the current time the print is executed based on a 12-hour clock</td>
</tr>
<tr>
<td>%MilTime</td>
<td>Inserts the current time the print is executed based on a 24-hour clock</td>
</tr>
<tr>
<td>%Title</td>
<td>Inserts the current title of the document</td>
</tr>
<tr>
<td>%Page</td>
<td>Inserts the page number of the document</td>
</tr>
<tr>
<td>%TotalPages</td>
<td>Inserts the total number of pages of the document</td>
</tr>
<tr>
<td>%BatesPgNo()</td>
<td>Inserts a page number (x) to include for each printed document. The number entered is the beginning page number for each document. Multi-page documents are numbered incrementally. For example, %BatesPgNo(0001) would print 0001 on each single-page document. However, if a document had more than one page, the first page would</td>
</tr>
</tbody>
</table>
appear as 0001, the second as 0002, and so on.

| %Login, %User | Inserts the user name of the person who executed the print |
| %Hostname | Inserts the hostname of the machine where the print was executed from |
| %IPAddress | Inserts the IP address of the machine where the print was executed from |
| %% | Inserts a single % character |
| © | Inserts a copyright symbol |
| ® | Inserts a registered trademark |

6. To edit the font for all the text, click the **Font** button, and then in the **Font** dialog box, specify the font name, style, and size.

7. Click **List** to review the applied header/footer and watermark text and macros set for the production.

8. Click **Edit** to make any changes.

9. When finished, **OK**.

Printing and Production header/footer and watermark settings are separate entities. Parameters you set in the Printing dialog box are only available for printing.

3. When finished, click **Start**.

**To save print parameters:**

1. Set the printing parameters.

2. Do one of the following:
   - To save the parameters as a named parameter set, in the **Parameter Set Selected** field, enter a name, and then click **Save Parameter Set**.
   - To save the parameters as the default set, click **Save as Default Parameter Set**. The default parameter set is loaded each time the CNV Printing command is executed.

All the parameters are saved, with the exception of document range as this always defaults to 1-n, where n is the total number of documents in the current Concordance query.

**To load saved print parameters:**

1. In the **Parameter Set Selected** list, click the parameter set you want to load.

2. Click **Load User Parameter Set**.
**Modifying print headers/footers and watermarks**

Headers and footers are a string of text assigned to a specific location within a document. Headers and footers contain information such as date, time, page number, user name, etc. For productions and printing, the text is not restricted to just the top and bottom margins of a document, you can also place them in the right and left margins of a document. Each margin may be 10 lines deep giving you 120 individual strings of text.

A watermark is a semi-transparent string of text that appears behind the existing document content. A watermark appears across each printed document from bottom left to top right and has a transparency setting of 20%.
Fidelity Security Bank
Internal Note

RE: Goniff J.A. Cash Flows for 1982-83

TO DO
1. Compare estimated cash flow with actuals (1982/83)

NB. March 1983, Goniff, J.A. cash flow projections prepared as recently as 12/82 and 3/83 have not even come close to the co's actual results and therefore have little credibility.

03/83 Goniff J.A. trying to convert from reliance on milking to butter and cream sales.

Confidential  4/22/2011 10:57 AM
The Edit Header/Footers and Watermarks parameters are not directly saved with the print parameters. Make sure that you verify the parameters are set as intended before starting a print job.

To edit a header, footer or watermark:

1. In Concordance, from the Tools menu, click **CNV Printing**.
2. In the **Printing Run Parameters** dialog box, select the **Include Hdr/Fts Spec** check box.
3. Click the **Edit Headers/Footers and Watermarks** button.
4. Click the Header/Footer or Watermark folder you want to edit.
5. For each header, footer, or watermark, do one of the following:
   - Type the text you want displayed.
   - Type `%` to display the available macros list, and then select the macro you want to print.

Available macros:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%FIELD_</td>
<td>Inserts database field data up to 60 characters for each specified field. For example, %FIELD_OCR1 %FIELD_OCR2, would print the first 60 characters of the OCR1 field and the first 60 characters of OCR2 field. If security is enabled, only those fields with a minimum of &quot;Read&quot; access are displayed.</td>
</tr>
<tr>
<td>%Date</td>
<td>Inserts the current date</td>
</tr>
<tr>
<td>%SysDatePlusDays(x)</td>
<td>Inserts a date the specified number of days after the system date.</td>
</tr>
<tr>
<td>%Time</td>
<td>Inserts the current time the print is executed based on a 12-hour clock</td>
</tr>
<tr>
<td>%MilTime</td>
<td>Inserts the current time the production is executed based on a 24-hour clock</td>
</tr>
<tr>
<td>%Title</td>
<td>Inserts the current title of the document</td>
</tr>
<tr>
<td>%Page</td>
<td>Inserts the page number</td>
</tr>
<tr>
<td>%TotalPages</td>
<td>Inserts the total number of pages</td>
</tr>
<tr>
<td>%BatesPgNo(x)</td>
<td>Inserts a page number (x) to include for each printed document. The number entered is the beginning page number for each document. Multi-page documents are numbered incrementally. For example, %BatesPgNo(0001) would print 0001 on each single-page document. However, if a document had more than one page, the first page would appear as 0001, the second as 0002, and so on.</td>
</tr>
<tr>
<td>%Login, %User</td>
<td>Inserts the user name of the person who executed the print</td>
</tr>
</tbody>
</table>
6. To edit the font for all the text, click the **Font** button, and then in the **Font** dialog box, select the font, the font style, and the font size.

7. To view a list of all the headers, footers, and watermark set for the production, click **List**.

8. When finished, click **OK**.

Printing and Production headers/footers and watermark settings are separate entities. Parameters you set in the CNV Printing dialog box are only available for printing.

*Monitoring print jobs*

When a print job is executed, the Print Console is displayed. The Print Console displays the progress of the files as they are processed and sent to the selected default printer.
Printing in Concordance Image

Printing images

To print images:

1. Do one of the following:
   - From the File menu, click Print.
   - On the Standard toolbar, click the Print button.

2. In the Print Range section, click one of the following:
   - Entire Image - prints the current image (page).
   - Viewed Portion - prints only the currently viewed (zoomed) portion of the image (page).
   - Pages - prints a range of pages from the current document. The To field default to the total number of pages in the current document.
   - Documents - prints a range of documents from the current Concordance query. This option is disabled Concordance Viewer and Concordance are out of sync.
- **List** - prints a list of images from a Concordance Image print file. See, To print a list of images from a print file.

3. In the **Number of copies** field, type or scroll to the number of copies you want to print.

4. If you are printing multiple copies and want to collate the copies, select the **Collate** check box.

5. Click the **Header & Footer** tab and enter the header and footer information you want to include. See, To specify header & footer print settings.

6. Click the **Options** tab to specify additional print settings, such as redlines, notes, separator sheets, or suppress print errors. See, To set additional print options.

7. When finished click **Print**.

**To print a list of images from a print file:**

1. Do one of the following:
   - From the **File** menu, click **Print**.
   - On the Standard toolbar, click the **Print** button.

2. In the **Print** dialog box, click the **List** option, and then click the **List** button.

3. Locate the print file, and then click **Open**.

**Print file format:**

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db</td>
<td>Full path to the imagebase including any drive letter or UNC mapping excluding extension</td>
</tr>
<tr>
<td>ik</td>
<td>Image key as it appears in the Concordance imagebase.</td>
</tr>
<tr>
<td>pages</td>
<td>Number of pages to print including this image. Normally you can set this value to 1 if you remember to specify each page in the list file.</td>
</tr>
<tr>
<td>reserved</td>
<td>Do not specify anything for this value.</td>
</tr>
<tr>
<td>upper_left</td>
<td>Left header text to insert in the upper left corner of the image</td>
</tr>
<tr>
<td>upper_right</td>
<td>Right header text to insert in the upper right corner of the image</td>
</tr>
<tr>
<td>lower_left</td>
<td>Left footer text to insert in the lower left corner of the image</td>
</tr>
<tr>
<td>lower_right</td>
<td>Right footer text to insert in the lower right corner of the image</td>
</tr>
<tr>
<td>paper_source</td>
<td>Driver dependent paper tray to pull the separator sheet.</td>
</tr>
<tr>
<td>extra_text</td>
<td>Text to insert on the separator sheet.</td>
</tr>
</tbody>
</table>

**To specify header & footer print settings:**

1. In the **Print** dialog box, click the **Header & Footer** tab.
2. In the Left header, Right header, Left footer, and/or Right footer fields, type or select the header and/or footer text you want to display when you print the images.

3. For each header and footer, select from the following options for the text that appears:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually typed text</td>
<td>Type any text in the field, such as Defendant, and the text appears on all printed images.</td>
</tr>
<tr>
<td>System command</td>
<td>Select one of the following system commands from the drop-down list. The system commands are denoted by the angle brackets around the command (&lt;Time&gt;).</td>
</tr>
<tr>
<td></td>
<td>- &lt;Date &amp; Time&gt; – The date and time the image was printed</td>
</tr>
<tr>
<td></td>
<td>- &lt;Date&gt; – The date the image was printed</td>
</tr>
<tr>
<td></td>
<td>- &lt;Page number&gt; – The current page number (Page 1 of 4)</td>
</tr>
<tr>
<td></td>
<td>- &lt;Time&gt; – The time the image was printed</td>
</tr>
<tr>
<td>Concordance field</td>
<td>Select a Concordance field to place the contents (up to the first line and first 60 characters) of a Concordance field into a header or footer</td>
</tr>
<tr>
<td></td>
<td>Concordance Viewer automatically formats and prints the appropriate text for the selected system command.</td>
</tr>
</tbody>
</table>

4. To increment a header or footer value, select the Auto Increment check box.

Concordance Image can print an auto-incrementing header and footer. If the Auto increment check box is selected, for each image, the header or footer value is increased by 1. For example, if you type the header text PM-00001 and select the Auto increment check box, Concordance Viewer prints the text PM-00001 on the first image, print PM-00002 on the second image, and so on. This feature is helpful for creating sequentially numbered production sets.

5. To customize the header or footer text font, click the Font button, modify the settings, and then click OK.

To set additional print options:

1. In the Print dialog box, click the Options tab.

2. To include redlines on the printed image, select the Print redlines check box, and then select one or more of the redline types.

   When the check box next to a redline type is selected, if the redline type has been applied to the image, the redline type is printed on the image. When the check box next to a redline type is cleared (empty), the redline type is not printed on the image.

3. To print the text of a note attached to an image, select the Print notes check box, and then click the Font button to customize the note text. The note text is printed on the
4. To add separator sheets at the beginning of each document, select the **Insert separator sheet between documents** check box, and then specify the following:

- In the **Source** field, select the printer's paper source for the separator sheet paper.
- In the **Text** field, type or select from the following options the text you want to print on the separator sheets:

<table>
<thead>
<tr>
<th>Separator Sheet Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually typed text</td>
<td>Type any text in the field, such as <em>Confidential</em>, and this text appears on all separator sheets.</td>
</tr>
<tr>
<td>System command</td>
<td>Select one of the following system commands from the Text drop-down list. The system commands are denoted by the angle brackets around the command (&lt;Time&gt;).</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;Date &amp; Time&gt;</code> – The date and time the image was printed</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;Date&gt;</code> – The date the image was printed</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;Document number&gt;</code> - The document number of the current image (Document 4 of 10)</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;Time&gt;</code> – The time the image was printed</td>
</tr>
<tr>
<td>Concordance field</td>
<td>Concordance Image automatically formats and prints the appropriate text for the selected system command.</td>
</tr>
<tr>
<td></td>
<td>If there is an active link to the associated documents in Concordance, the drop-down list contains a list of the Concordance fields.</td>
</tr>
<tr>
<td></td>
<td>You can select a Concordance field to place the contents (up to the first line and first 60 characters) of a Concordance field on the separator sheets.</td>
</tr>
</tbody>
</table>

5. To suppress printing errors during the print process and write the errors to a log file, select the **Suppress error and write errors to file** check box.

Concordance Image keeps track of errors during the print process, such as images that are no longer present or decompression errors. Many times on large print jobs, it is inconvenient to have Concordance Viewer stop for each error and await user input. It may be easier to have it suppress any errors by skipping the image and writing the error to a log file. You can view the error log as it is being written during the print process and after the process completes.

6. Click the **Browse** button to specify where you want to save the log file, type the file name in the **File** name field, and click the **Save** button.

To suppress error messages without creating a log file, leave the error log directory field blank. If you do not specify a log file, Concordance Image does not create a log file and skips all images that have errors.
1. In the **Print** dialog box, click the **Print** tab.

2. Do one of the following:
   - To save the print settings to a file, click the **Save the current print settings to file** button, specify the filename and location, and then click **Save**.
   - To save the print settings as new default print settings, click the **Save current settings as default** button.

**To retrieve print settings:**

1. In the **Print** dialog box, click the **Print** tab.

2. Click the **Retrieve print settings** button.

3. Locate the print settings file you want to use, and then click **Open**.

- If your images are not printing properly, check with your Concordance administrator to ensure that you have the proper DPI settings for each printer being used for important print jobs or productions.

---

**Productions**

**About productions**

Once a document collection review is completed, documents typically need to be produced to opposing parties. Database administrators prepare the electronic production using Concordance and Concordance Native Viewer or Concordance Image based on queries or tagged sets of documents that are identified for production during the review phase.

**Numbering Documents**

As part of the production process, a new set of images are generated for documents that need to be produced. A Bates number series is then applied to all pages of all documents included in the production, with the option of *burning* or *fusing* the numbers to the image during the process. This number series usually differs from that of your internal collection. You can then track what has actually been produced and your Bates number series for the production is sequential with no gaps in the numbering.

**Fusing Markups**

Redactions or other markups can be *burned* or *fused* to the images during production so that they cannot be altered. Confidentiality headers or footers can also be fused to the images during production. Production numbers are usually cross-referenced to those in the original review collection.
If the Concordance administrator included fields for production numbers in your database, these numbers are then written to the production number fields during the production process. Later when you look at your internal document collection, you are able to see the production number for any documents that were produced.

For multiple or rolling productions, tags or sequentially numbered production fields are tracked for which production series a document was produced under. For example, fields named PRODBEG1/PRODEND1, PRODBEG2, PRODEND2, etc.

Production Output

The output generated by an electronic production in Concordance or Concordance Image is a set of images or PDF files and an image load file. Both the production image set and the load file are typically burned onto CDs or DVDs (or for very large collections, an external hard drive). Output volumes, such as CDs or DVDs, are labeled to track the production series.

Native Files

For native productions, the set of documents to be produced is typically converted to TIFF or PDF formatted files during production. Organizations need to adhere to proper forensic procedures for handling native files.

For Concordance version 10.21 E-documents databases, the Native File Production produces a copy of the original native file. The produced document does not include any annotations or markups.

Non-Production Documents

Non-production documents and images from Concordance may also need to be shared with outside counsel, experts, clients, or other parties. Concordance Image's production tool is used to generate a non-production set of images and load files for this distribution.

For shared document reviews, you can use Concordance FYI, FYI Reviewer and Hosted FYI from LexisNexis.

Generating Load Files and Images

The output from a production from Concordance is a set of image or PDF files and an OPT file. The output generated depends on production requirements agreed upon with opposing counsel. A best practice is to know in advance what the recipient needs for output format. The database administrator can collaborate with someone from opposing counsel's technology department to determine their exact needs.

The output from a Concordance Image production is a set of images and a load file. Production load files enable recipients to import images into their own viewer software. Images and load files are generated for either single or multi-page .tif format. Load files for data are generated during the export process.

Administrators can also export specific fields of data and OCR from Concordance to include with the production. OCR text files are generated using a Concordance CPL (script).
Learning more about productions

Anyone tasked with preparing productions should receive Concordance Administration training before attempting to produce documents from a live database. The litigation industry guidelines regarding how discovery documents are handled, processed, and shared between parties is a sensitive matter.

If you or anyone on your IT or Litigation Support Team are interested in learning more about productions, please contact our Client Training Administrator at 1-800-227-9597 ext. 1252111, or email us at litservtraining@lexisnexis.com to register for the Concordance Administration Fundamentals and the Certified Concordance Software Administrator courses.

Additional course information is available on LexisNexis University.

Protecting Data

About protecting data

Protecting discovery document collections is a sensitive and demanding job. Your Concordance administrator or Litigation Support Manager must perform a variety of maintenance processes and manage various files to preserve the integrity of your document collection. Stringent litigation guidelines must be adhered to and maintenance schedules followed to protect the information and ensure your databases are up-to-date and running efficiently for the review team.

Many of the processes involved in protecting your Concordance databases include:

- Taking Snapshots
- Backing Up Databases
- Zapping Databases
- Packing Databases
- Deleting Tags
- Performing Global Replacements

Consult with your Concordance administrator or Litigation Support Manager to gain a deeper understanding of your organization’s maintenance process schedule. If you are responsible for maintaining the database at an administrative level, it is recommended that you attend our Concordance Administration Fundamentals and Concordance Certified System Administrator classes.

If you or anyone on your IT or Litigation Support Team are interested in learning more about Concordance classes, please contact our Client Training Program Administrator at 1-800-227-9597 ext. 52111, or email us at litservtraining@lexisnexis.com.

Concordance training course catalog

⚠️ Avoid using administrative features in Concordance that you are unfamiliar with, because using these features without fully understanding the feature may cause data loss or corruption. These features may also require a backup of the database before proceeding.
Whenever possible, consult with your database administrator before attempting to use any administrative features so they can either backup the database before you proceed or take care of administrative tasks for you.

Saving and restoring snapshots

Snapshots are a point-in-time picture of your work history. Using snapshots is one way reviewers can help track and preserve both search history and search results.

Saved snapshots can easily be restored to see what the contents of a database were on a particular day, and what search results were found at that moment in time. During a lengthy review, tracking your work for the day is also important, not only to manage tasks and schedules, but to provide a placeholder for searches so you can jump right back into your project without duplicating previous efforts.

Unlike a query file, a snapshot saves the search results for documents retrieved, not which words were searched. This means that a snapshot will not locate new or updated documents in a database; a snapshot only displays those documents captured at the time the picture was taken.

Because snapshots provide a picture-in-time reference, all your search queries and customized sort settings are preserved and can be displayed again or restored at a later time. If your database is actively being edited, changes will not be reflected in a snapshot saved last week. For instance, a document deleted from the database since the snapshot was taken will display as blank when you open the snapshot in Concordance. To capture updates after edits have been made, rerun your snapshot queries.

Snapshots are saved as .snp files and can only be restored on the original databases. When you restore a snapshot file, Concordance automatically opens the databases associated with the file, with all queries and sorts preserved.

If you regularly save snapshots at the end of every work session, we recommend that you periodically review and delete outdated or unnecessary files due to their large file size on your hard drive or network.

There are two ways to save snapshots in Concordance. You can manually save snapshots or you can use the Auto restore command to have Concordance automatically save snapshots for you.

To manually save a snapshot in Concordance

1. To open the Save Snapshot dialog box, do one of the following:
   - In the Databases task pane, click Save snapshot.
   - On the File menu, point to Snapshot, and then click Save snapshot.
2. Browse to where you want to save the snapshot file, type the file name in the File name field, and then click the Save button.

All search queries and customized sort settings for the current Concordance session are
saved in a .snp file.

**Auto-Restoring Snapshots**

With the Auto-restore feature, Concordance can automatically create and save a snapshot each time you close the Concordance application. The next time you open a Concordance session, the application automatically displays the exact record and view settings you had when you closed the application, including displaying your last search in the Review view.

The Auto-restore feature functions differently than manually saving separate snapshots of your work sessions. When the Auto-restore feature is enabled, Concordance creates the autosave.snp file and automatically saves the snapshot created by the Auto-restore feature to this file at the end of each session, overwriting the previous work session’s autosave.snp file. The autosave.snp is automatically saved to the ...\Documents and Settings\UserID\My Documents\Concordance [version#] (Windows XP) or ...\Users\UserID\My Documents \Concordance [version#] (Windows 7) directory on your machine.

By default, the Auto-restore feature is enabled. The Auto-restore feature is enabled and disabled by clicking the Auto restore option in the Snapshot menu. When a check mark is displayed next to the Auto restore menu selection, the Auto-restore feature is enabled. When the check mark is not displayed, the Auto-restore feature is disabled.

To restore a snapshot

1. To open the Restore Snapshot dialog box, do one of the following.
   - In the Databases task pane, click Restore snapshot.
   - On the File menu, point to Snapshot, and then click Restore snapshot.

2. Browse to and select the snapshot file (.snp) you want to open, and then click Open.

When you restore a snapshot file, Concordance remembers what databases and documents were accessed during the search session captured by the snapshot and launches them. The search results are displayed in the Review view, and the restored snapshot file is listed in the Recent panel in the Databases task pane.
About backing up databases

Database administrators take stringent precautions against data loss. Data loss can occur for many reasons, including hardware failures, file corruption, human error, and natural disasters such as fire, floods, electrical surges that can cause damage to equipment containing data. It is important that precautions are in place to deter any data loss by backing up data on a regular basis and having disaster recovery plans in place.

Most organizations have backup programs that run automatically at scheduled times to backup data on their network servers. We recommend becoming familiar with your company’s backup policies and disaster recovery plans in case you need to recover data that has been lost or damaged.

Every organization handles backups differently, so it is important to know how often backups occur on your network or off-site hosted network. Sometimes backups are stored off-site or may be difficult to recover on short notice, so it is helpful to know what to expect.

Concordance databases on a network should be backed up on a regular basis to protect work product. Concordance databases that are stored on local hard drives or hosted on off-network computers should have an alternative means of backing up the data, such as an external hard drive or other backup device that can be easily attached to the computer. Many of these devices come with software programs that are designed to run backups automatically at a scheduled time, or files can be backed up by copying them manually to a storage device attached to the computer.

Consult with your Concordance administrator or Litigation Support Manager if you need more information regarding your organization’s backups and disaster recovery plans.

About other maintenance tasks

In addition to backing up and preserving databases, your Concordance administrator performs several processes that keep your document collection streamlined and running efficiently.

Reviewers should understand how these processes affect their document collections, but should not attempt to use any of these tools without consulting their Concordance administrator or having received proper database administration training for Concordance.

The following administrative functions do not have an undo feature to retrieve data once the process is performed:

- **Zap** - deletes every record in the database
- **Pack** - if not done properly, can delete all of the records in the database
- **Delete Tags** - deletes all tags in the database
- **Global Replace** - if not done properly, can change data throughout the entire database unintentionally

We highly recommend that security is applied to every Concordance database to preserve document collections and protect staff from inadvertently deleting or altering critical information.
This is an administration-only function. The Zap feature is used to remove all documents from a database, freeing space in Concordance. Once all documents are purged, only the stopwords file and field definitions are retained in the database. When zapping a database, there is no undo feature for document retrieval so administrators must back up databases before running this process.

**Pack**

This is an administration-only function. The Pack feature is used for both the document database and dictionary file. Packing a database removes all documents that are marked for deletion. Packing a dictionary optimizes its file structure to increase search speed and reindex processing time. Once performed, there is no undo button for data retrieval, unless your Concordance administrator has made a backup file of all deleted records.

**Delete Tags**

The Delete Tags feature is used either to remove a tags from all documents, or remove all tags from a database. There is no undo feature once this process is performed.

**Global Replace**

Global editing is basically running a Find and Replace process for words or phrases in a database. The Global Replace function can perform replacements on specific fields, full or empty fields, with or without case sensitivity, and with or without confirmation before replacement. Caution must be used when replacing data, otherwise information in your document collection may be unintentionally and permanently altered. There is no undo feature once this process is performed.
Using Concordance Native Viewer

**About viewing native files**

Content review of documents is primarily done with Concordance Native Viewer. Concordance Native Viewer allows you to magnify the original document image for clarity and inspection, and provides a variety of markup tools specifically designed for privileged content and trial preparation. Once you have reviewed and annotated the content, especially redacting key information, the document markings are automatically saved and the changes secured.

Concordance Native Viewer stores references to all native documents and image information in a single Concordance Image Base database (.cib) file. The .cib file is located in the same folder as the associated Concordance database (.dcb).

- When using Concordance Native Viewer, make sure that only one instance of Concordance is running as multiple instances may cause Concordance to stop functioning.

- Due to changes within Brava, our third party vendor, if you are currently working on a review with Concordance Native Viewer version 1.08 or earlier, it is recommended that you complete the review and produce the files before upgrading to Concordance Native Viewer version 1.10 or later. For more information, contact Concordance Technical Support.

**Supported Files**

Concordance Native Viewer works with the following file types:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.tif, *.tiff</td>
<td>Tagged Image File</td>
</tr>
<tr>
<td>*.jpg, *.jpeg</td>
<td>Joint Photographic Experts Group</td>
</tr>
<tr>
<td>*.gif</td>
<td>Graphic Image File</td>
</tr>
<tr>
<td>*.bmp</td>
<td>Bitmap</td>
</tr>
<tr>
<td>*.asc</td>
<td>ASCII text</td>
</tr>
<tr>
<td>*.pcx</td>
<td>PC Paintbrush Bitmap</td>
</tr>
<tr>
<td>*.csv</td>
<td>Comma-Separated Values</td>
</tr>
<tr>
<td>*.cal, *.cals</td>
<td>Facsimile</td>
</tr>
<tr>
<td>*.pdf</td>
<td>Adobe Portable Document Format</td>
</tr>
<tr>
<td>*.doc, *.dot, *.docx</td>
<td>Microsoft Word</td>
</tr>
<tr>
<td>*.ppt, *.pps, *.pptx, *.pptm</td>
<td>Microsoft PowerPoint®</td>
</tr>
<tr>
<td>*.xls, *.xlsx</td>
<td>Microsoft Excel® (See note below)</td>
</tr>
<tr>
<td>*.msg</td>
<td>Microsoft Outlook 2010 Message File</td>
</tr>
<tr>
<td>*.txt</td>
<td>ASCII Text</td>
</tr>
</tbody>
</table>
When working with a Microsoft Excel workbook that contains more than one worksheet, the data for all the worksheets is store in the corresponding Concordance database; however, Concordance Native Viewer only displays the first worksheet during review.

**Working with Concordance Native Viewer**

**Navigating Concordance Native Viewer**

The Concordance Native Viewer workspace displays the document associated to the record currently open in the Concordance database. Using the tools in Concordance Native Viewer you can review documents, navigate between records, apply markups (annotations), and adjust the display of the documents.

The Thumbnails pane displays small images of the pages of the current document. The Media Information pane displays additional information about the current document, such as corresponding document information, image information (images only), and markup history.
Concordance Native Viewer toolbars

The following toolbars are available for adding annotations, navigating, and viewing documents.

- **The Markup toolbar**

  The Markup toolbar provides a variety of tools for adding markups (annotations) to a document during the review process.
<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🖤</td>
<td>Pan</td>
<td>Moves the current page in any direction</td>
</tr>
<tr>
<td>🌱</td>
<td>Selection</td>
<td>Selects a markup to edit, move, copy, resize, reshape, or delete</td>
</tr>
<tr>
<td>🗒️</td>
<td>Text Box</td>
<td>Places a box that contains text on the page</td>
</tr>
<tr>
<td>📜</td>
<td>Notes (Changemarks)</td>
<td>Places a note icon on the page and opens a pop-up for the content, status, classification reason</td>
</tr>
<tr>
<td>📡</td>
<td>Image</td>
<td>Places an external raster image (JPG, BMP, or PNG) on the page</td>
</tr>
<tr>
<td>👑</td>
<td>Stamp</td>
<td>Places a predefined stamp on the page</td>
</tr>
<tr>
<td>🔁</td>
<td>Straight Line</td>
<td>Draws a straight line in any direction on the page</td>
</tr>
<tr>
<td>🔮</td>
<td>Polyline</td>
<td>Draws a jointed line on the page</td>
</tr>
<tr>
<td>✈️</td>
<td>Crossout</td>
<td>Draws an X on the page</td>
</tr>
<tr>
<td>🔥</td>
<td>Arrow</td>
<td>Draws a line with an end arrowhead on the page</td>
</tr>
<tr>
<td>Tool</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Rectangle</td>
<td>Draws a rectangle around the selected area on the page</td>
</tr>
<tr>
<td></td>
<td>Ellipse</td>
<td>Draws an ellipse around a selected area on the page</td>
</tr>
<tr>
<td></td>
<td>Redaction</td>
<td>Blocks out areas on the page that are considered confidential or sensitive from being viewed or copied after production</td>
</tr>
<tr>
<td>abc</td>
<td>Strikeout</td>
<td>Draws a strikeout line over the selected text</td>
</tr>
<tr>
<td>abc</td>
<td>Underline</td>
<td>Draws an underline under the selected text</td>
</tr>
<tr>
<td>abc</td>
<td>Highlight</td>
<td>Highlights the selected text</td>
</tr>
</tbody>
</table>

Strikeout, Underline, and Highlight markup tools are only available if the document contains selectable text.

The Markup properties toolbar

The Markup properties toolbar displays properties you can set for the selected markup tool when adding or editing a markup.

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Fill</td>
<td>Defines color for a markup tool</td>
</tr>
<tr>
<td></td>
<td>Text format</td>
<td>Defines font name, style, size, and effect:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(T) - Transparent, match background, or custom color</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(U) - Underline</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(I) - Italic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(B) - Bold</td>
</tr>
<tr>
<td></td>
<td>Line Style</td>
<td>Defines style and width for lines and shapes</td>
</tr>
</tbody>
</table>

The Navigation toolbar

The Navigation toolbar allows you to move between documents and records. See, Displaying records.
### The View toolbar

The View toolbar adjusts the magnification, size, and orientation of the current document.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom on Selection" /></td>
<td>Zoom on Selection</td>
<td>Enlarges a selected region</td>
</tr>
<tr>
<td><img src="image" alt="Magnifier" /></td>
<td>Magnifier</td>
<td>Displays a magnifier window for viewing sections of the current document</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Height" /></td>
<td>Fit to Height</td>
<td>Adjusts the zoom height so that the entire height of the document appears in the workspace</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Width" /></td>
<td>Fit to Width</td>
<td>Adjusts the zoom width so that the entire width of the document appears in the workspace</td>
</tr>
<tr>
<td><img src="image" alt="Zoom slider" /></td>
<td>Zoom slider</td>
<td>Controls the magnification of the document being displayed</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Clockwise" /></td>
<td>Rotate Clockwise</td>
<td>Rotates the document in 90 degree clockwise increments</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Counter Clockwise" /></td>
<td>Rotate Counter Clockwise</td>
<td>Rotates the current document in 90 degree counter clockwise increments</td>
</tr>
</tbody>
</table>
The Thumbnails pane

The Thumbnails pane displays small images of the pages within the current document. The green rectangle indicated the currently displayed page. The red exclamation point (!) next to the thumbnail image indicates the page contains markups. See, Displaying documents in CNV.

Use the navigation tools in the Thumbnails pane to navigate the pages of the current document.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>First Page</td>
<td>Navigates to the first page of the document or image</td>
</tr>
<tr>
<td></td>
<td>Previous Page</td>
<td>Navigates to the previous page of the document or image</td>
</tr>
<tr>
<td></td>
<td>Next Page</td>
<td>Navigates to the next page of the document or image</td>
</tr>
<tr>
<td>Tool</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Last Page</td>
<td>Navigates to the last page of the document or image</td>
</tr>
<tr>
<td></td>
<td>Previous Markup Page</td>
<td>Navigates to the previous page that contains markups</td>
</tr>
<tr>
<td></td>
<td>Next Markup Page</td>
<td>Navigates to the next page that contains markups</td>
</tr>
</tbody>
</table>

**The Media Information pane**

The Media Information pane contains detailed information about each document within a record. Each media button can be configured to display the information most important to you. See, Using the Media Information pane.
<table>
<thead>
<tr>
<th>Media Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Information</td>
<td>Displays numeric, date, text and paragraph data, up to 60 characters, from the document's corresponding Concordance field in the order you specify.</td>
</tr>
<tr>
<td>Image Information</td>
<td>Displays metadata for the current image-type object displayed in the native viewer. TIFF image types display full information. Other image types such as GIF and BMP display only minimal information as these image types do not allow for the storing of descriptive information within the image.</td>
</tr>
<tr>
<td>Markup History</td>
<td>Displays a complete history, in descending chronological order, of all markup additions, modifications, and deletions that have taken place for the current document.</td>
</tr>
</tbody>
</table>
Displaying native files

Utilizing the media key (image key) field in Concordance, Concordance Native Viewer can synchronize with the current Concordance database and display the associated documents. Using Concordance Native Viewer you can also view native documents, removing the need to purchase and open the document in its native application. CNV opens the near-native view of the supported document types allowing you to review and annotate them.

With Concordance Native Viewer open alongside the Concordance application, you can view a record in the Browse and Table views while viewing the same record in the Native Viewer.

To open documents in Concordance Native Viewer:

1. In Concordance, open the database you want to view.
2. On the Dynamic toolbar, click the View Image (camera) button.

Documents may consist of multiple pages. There are two ways to determine if a document contains multiple pages:

- Appended is displayed next to the media key near the top of the view workspace.
- The Next Page button is activated.
To navigate between documents and pages:

On the Navigation toolbar, do any of the following:

- To move to the next document, click the Next document button.
- To move to the previous document, click the Previous document button.
- To move to the next page in the document, click the Next page button.
- To move to the previous page in the document, click the Previous page button.
- To move to a specific document, click the Go To Document or Image page button, in the Go To dialog box select the document number you want to view, and then click GoTo.
- To move to a specific page in the document, click the GoTo Document or Image page button, in the Go To dialog box, select the page number you want to view, and then click GoTo.

To display a page within the current document using the Thumbnails page:

1. To open the Thumbnails pane, do one of the following:
   - On the Navigation toolbar, click the Toggle Thumbnails button.
   - On the right side of the workspace, click the arrow button.
2. In the Thumbnails pane, click the page you want to view.
Opening views

When synchronized with Concordance, each tab in Concordance has an associated tab in CNV displaying the associated document view. You can have up to 16 Concordance Image Base views open at the the same time. Each view is accessible using the named tabs at the top of the workspace.
If the Concordance Image Base (.cib) file does not exist for the corresponding Concordance database, then you will be prompted to convert the existing Concordance Image imagebase or select the load file exported from LAW PreDiscovery (OPT) or Concordance Image (LOG) file.

**To view media files in Concordance Native Viewer:**

1. In Concordance, select the database tab you want to view.
2. On the Dynamic toolbar, click the **View Image** (Camera) button.

Concordance Native Viewer opens the view for the document associated with the current record in Concordance.

**To close the current view:**

From the **File** menu, click **Close.**
Magnifying near-native records

In Concordance Native Viewer, you can zoom, magnify, pan and rotate documents depending on the record type and particular content. For instance, handwritten documents are harder to read online and perhaps illegible in some instances too. Special magnifying tools allow you to read with ease and inspect signature details.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Zoom on Selection" /></td>
<td>Zoom on Selection</td>
<td>Enlarges a selected region</td>
</tr>
<tr>
<td><img src="image" alt="Magnifier" /></td>
<td>Magnifier</td>
<td>Displays a magnifier window for viewing sections of the current document</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Height" /></td>
<td>Fit to Height</td>
<td>Adjusts the zoom height so that the entire height of the document appears in the workspace</td>
</tr>
<tr>
<td><img src="image" alt="Fit to Width" /></td>
<td>Fit to Width</td>
<td>Adjusts the zoom width so that the entire width of the document appears in the workspace</td>
</tr>
<tr>
<td><img src="image" alt="Zoom slider" /></td>
<td>Zoom slider</td>
<td>Controls the magnification of the document being displayed</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Clockwise" /></td>
<td>Rotate Clockwise</td>
<td>Rotates the document in 90 degree clockwise increments</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Counter Clockwise" /></td>
<td>Rotate Counter Clockwise</td>
<td>Rotates the current document in 90 degree counter clockwise increments</td>
</tr>
<tr>
<td><img src="image" alt="Toggle Thumbnails" /></td>
<td>Toggle Thumbnails</td>
<td>Opens the Thumbnails pane</td>
</tr>
</tbody>
</table>

**To adjust the magnification of the document view:**

On the Navigation toolbar, do any of the following:

- To enlarge a selected area, click the **Zoom on Selection** tool and drag the tool across the area you want to enlarge.
- To open a magnifier window, click the **Magnifier** tool and drag the tool over the area you want to magnify.
- To fit the entire height of a document in the workspace, click the **Fit to Height** button.
- To fit the entire width of a document in the workspace, click the **Fit to Width** button.
- To zoom in or out on a document, using the **Zoom** slider drag the slider to the right to increase the magnification or to the left to decrease the magnification.
- To rotate a document in 90 degree increments, click the **Rotate Clockwise** or **Rotate Counter Clockwise** button.

If your mouse has a scroll wheel, you can use the wheel to quickly zoom in or out on a document. Click in the workspace, and then turn the mouse wheel to zoom in or out of the document.
To toggle the options of the Magnifier window:

1. On the Navigation toolbar, click the Magnifier tool.

2. Toggle the icon in the upper left corner for different viewing preferences.
   - When the Eyeglass icon displays, click on any area of the document and the window will snap to that area and display the selected section.
   - When the Bird's Eye icon displays, a small rectangle displays with the cursor when it is moved off the magnifier window.
     As you move your cursor over the document, the area contained in small rectangle displays in the magnifier window.
   - When the Dock icon displays, you can click on an area of the document and that area stays docked in the magnifier window.
     You can scroll on the document and the view that is currently in the magnifier remains the same until another area selection is made.

3. Click or drag the corner or edge of the magnifier window to expand its size.

4. Click on the Adjustment Handle to decrease or increase the font size within the magnifier window.

5. Click the Close button to exit the magnifier window.

Using sticky zoom and sticky rotate

Many documents are often scanned with a portrait page view setting, making online reading a challenge unless the page is rotated. The Sticky Zoom and Sticky Rotate settings make reviewing easier by changing the page layout to a landscape view and keeping it there even while navigating between records.

The Sticky Zoom and Sticky rotate functions are located on the View menu:

- **Sticky Zoom** - keeps your preferred magnification settings as you move from record to record. If you uncheck the selection, and then navigate to the next record, the record defaults to the full page view.

- **Sticky Rotate** - retains the rotated settings as you page through a record. These settings are especially helpful if you are reviewing a spreadsheet. If you uncheck the selection, and then navigate to the next record, the record defaults its original view.

A check mark next to each option on the Tools menu indicates that this setting is selected. The selections are maintained for the current database when Concordance Native Viewer is closed and reopened.
Using the media information pane

The Media Information pane provides quick access to additional information (metadata) about the current document or image. The information is directly linked to the information in Concordance and is stored in the Concordance Image Base (CIB) file.
The Media Information pane organizes the information into three views.

<table>
<thead>
<tr>
<th>Media Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Information</td>
<td>Displays numeric, date, and text up to 60 characters and paragraph data truncated to 60 characters from the document's corresponding Concordance data in the order you specify.</td>
</tr>
<tr>
<td>Image Information</td>
<td>Displays metadata for the current image-type object displayed in the native viewer. TIFF image types display full information. Other image types such as GIF and BMP display only minimal information as these image types do not allow for the storing of descriptive information within the image.</td>
</tr>
<tr>
<td>Markup History</td>
<td>Displays a complete history, in descending chronological order.</td>
</tr>
</tbody>
</table>

© 2018 LexisNexis. All rights reserved.
The upper section of the Media Information pane displays detailed information about the document for the selected view. The lower section displays a set of buttons for one-click access to the corresponding view. When you click a view button, its contents are displayed in the upper section. The horizontal splitter bar located between the view and the buttons allows you to collapse the buttons into a button tray.

<table>
<thead>
<tr>
<th>Media Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>order, of all markup additions, modifications, and deletions that have taken place for the current document.</td>
</tr>
<tr>
<td>Field</td>
<td>Content</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>STARTPAGE</td>
<td>00010002</td>
</tr>
<tr>
<td>ENDPAGE</td>
<td>00010002</td>
</tr>
<tr>
<td>DATE</td>
<td>00/00/0000</td>
</tr>
<tr>
<td>DOCTYPE</td>
<td>File Note</td>
</tr>
<tr>
<td>TITLE</td>
<td>Untitled</td>
</tr>
<tr>
<td>AUTHOR</td>
<td></td>
</tr>
<tr>
<td>AUTHORG</td>
<td>MMC</td>
</tr>
<tr>
<td>RECIPIENT</td>
<td></td>
</tr>
<tr>
<td>RECIPORG</td>
<td></td>
</tr>
<tr>
<td>CC</td>
<td></td>
</tr>
<tr>
<td>SUMMARY</td>
<td></td>
</tr>
<tr>
<td>CONDITION</td>
<td></td>
</tr>
<tr>
<td>ATTACH TYPE</td>
<td></td>
</tr>
<tr>
<td>LEAD DOC</td>
<td></td>
</tr>
<tr>
<td>ATTACHMENTS</td>
<td></td>
</tr>
<tr>
<td>PRIMARYDATE</td>
<td>00/00/0000</td>
</tr>
<tr>
<td>PAGES</td>
<td>1</td>
</tr>
<tr>
<td>CCORG</td>
<td></td>
</tr>
<tr>
<td>ATT</td>
<td></td>
</tr>
<tr>
<td>ATTORG</td>
<td></td>
</tr>
<tr>
<td>OCR1</td>
<td>*** 00010002 ***MAf C Fli</td>
</tr>
<tr>
<td>OCR2</td>
<td></td>
</tr>
<tr>
<td>OCR3</td>
<td></td>
</tr>
<tr>
<td>OCR4</td>
<td></td>
</tr>
<tr>
<td>OCR5</td>
<td></td>
</tr>
<tr>
<td>RENUMBER</td>
<td>00054</td>
</tr>
<tr>
<td>ISSUE</td>
<td></td>
</tr>
<tr>
<td>DISC STATUS</td>
<td></td>
</tr>
<tr>
<td>TITLE</td>
<td>Untitled</td>
</tr>
<tr>
<td>PAGES</td>
<td>1</td>
</tr>
</tbody>
</table>
To show and hide the media information pane:

In the upper left corner of the media information pane, click the Expand/Collapse (<<) button.

The Document Information and Image Information views are customizable so that you can display only the information you want.

To configure the Document Information view:

1. In the Media Information pane, click the Document Information view button.

2. To designate the Concordance database fields to display in the view, click the View button.

   The Grid View Options dialog box lists all the corresponding Concordance imagebase fields available to display.

3. To select fields, in the Imagebase fields section, do any of the following:
   - To select individual fields, select the field name check box.
   - To select all the fields, click the Select All button.
   - To cancel all the selections, click the Clear All button.

4. To reset the order the fields appear in the view, select the field you want to move, and then click the Move Up or Move Down button.

5. When finished, click Save.

To configure the Image Information view:

1. In the Media Information pane, click the Image Information view button.

2. To designate the Concordance database fields to display in the view, click the View button.

   The Grid View Options dialog box lists all the metadata information available to display.

3. To select metadata, in the Imagebase fields section, do any of the following:
   - To select individual metadata, select the metadata check box.
   - To select all the metadata, click the Select All button.
   - To cancel all the selections, click the Clear All button.

4. To reset the order the metadata information appears in the view, select the field you want to move, and then click the Move Up or Move Down button.

5. When finished, click Save.

You can also print or save any of the information in the Media Information views.
To print a media view:

1. In the Media Information pane, open the view you want to print.
2. Click the Print button.
3. In the Print preview dialog box, review the information, and then click the Print button.

Annotating documents

Applying markups

During the discovery process, marking up record detail is the phase when deeper content investigation and case record preparation begins.
Mr S. McCorman  
The Boat House  
Lake Texoma  
Dallas  
Texas 9786.09568  
December 19, 1983

Dear Steve,

It was wonderful seeing you and Rita on Sunday. You certainly have the perfect garden for a summer drinks party. Rita's looking stunning, she's obviously recovered from Jeremiah's birth very quickly.

As we discussed last week, the funding of our T.0 Texaco is still problematic. I want to reassure you that CONGO 81-2 funds will not go towards retaining any lawyers or accountants for the other milking funds. There are funds earmarked for that particular purpose which are in bulks account already. We've already made this very clear to the lawyers and accountancy firms involved. If there are any further murmurs, I won't hesitate to take this to the next AGM, not that they would fully understand the implications. It would have the desired effect, should we fail to contain the situation. I shall also be contacting the senior partners underlining our arrangements will not be changed.

Are you aware that after the merger of our Dallas and Chicago committees on 30.11.83 that if am now part of the combined steering committee. Not bad for a newcomer to the politics. I will of course keep you informed of any exciting events.

My fellow committee members are: Parish RJ, Schiermiester N, Kellett PD and Daily JK. You should be ok with Daily JK as well. He phoned me last week just to tell me how impressed he is at your work in this transaction. One in the eye for you kid!

Call me on Thursday for the latest update - ext.3546.

Best Wishes to you, Rita and Jeremiah.

RC Simmons
The Markup toolbar includes a variety of tools you can use to mark up (annotate) a document or image during review. Applying markups includes redacting information and adding notes. You can also apply color markings to highlight or underline text and add a circle or box to emphasize a block or region of key content. All of these elements can easily be edited, moved, or resized.

There is no limit to the number of markups you can add to a document. As a best practice, use some restraint and stick to the internal review guidelines for your organization, ensuring all annotation marks are sensibly applied and records are kept clean for other reviewers.

Markups for the current document/record are displayed in the Markup History tab of the Media Information panel. The Markup History pane displays markup type, title, and author. Markup history is also saved in the .cib file. See, Viewing media information.

⚠️ The current state for the markups on a document are stored in an XML formatted (.xrl) file in the same directory as the corresponding media file. DO NOT edit this file. Doing so may corrupt all your markups and redactions, as well as, possibly cause Concordance Native Viewer to crash.

⚠️ Due to changes within Brava, our third party vendor, if you are currently working on a review with Concordance Native Viewer version 1.08 or earlier, it is recommended that you complete the review and produce the files before upgrading to Concordance Native Viewer version 1.10 or later. For more information, contact Concordance Technical Support.

⚠️ To add text:

1. On the Markup toolbar, click the Text tool □.
2. Using the Text tool, select the area where you want to add the text.
3. In the Text dialog box, type the text you want to add.
4. On the Markup properties toolbar, specify any of the following:
   - To change the color, click the Color button □, and then select a color from the color picker.
   - To change the font, in the Font list, select a font.
   - To change the font size, in the Font size list, select a font size.
5. To change the background color of the text box, click the Text Background button (T), and then select one of the following:
   - Transparent sets the background as transparent and all text is visible.
   - Match Display Background sets the background color to match the color of the current document background.
   - Select Background Color opens the color picker dialog box, and sets the background to the color selected. The outline color of the text box is set to be the same as the current font color.
6. Set the font style, do any of the following:
   - To underline the text, click the Underline button.
   - To italicize the text, click the Italics button.
To make the text bold, click the **Bold** button.

7. Navigate to another document to save the markup.

**To add a note:**

1. On the **Markup** toolbar, click the **Note** tool.

2. Using the **Note** tool, click in the area of the document where you want to place the note.

3. In the **Changemarks** dialog box, do the following:
   - In the top field, type a title for the note.
   - In the bottom field, type the text you want to include in the note.

4. When finished, click **OK**.

5. To change the note color, on the **Markup properties** toolbar, click the **Color** button , and select a new color from the color picker.

6. Navigate to another document to save the markup.

⚠ You cannot use Rich Text Formatting (RTF) in notes, including copying RTF content from another application and then pasting into a note. Doing so may corrupt all the markups and redactions, as well as, possibly cause Concordance Native Viewer to crash. If this happens, you need to contact Customer Support.

- After applying a note, you can move the pointer over the note to display the first 40 characters of the contents of the note. To view the contents of the note (maximum of 520 characters), double-click the note you want the view to open the Markup History Details dialog box.

**To add lines:**

1. On the **Markup** toolbar, click one of the following:
   - To draw a straight line, click the **Line** tool .
   - To draw a jointed line, click the arrow next to the **Line** tool, and then click the **Polyline** tool .
   - To place an X over an area on the document, click the arrow next to the **Line** tool, and then click the **Crossout** tool.
   - To draw an arrow, click the arrow next to the **Line** tool, and then click the **Arrow Line** tool .

2. Draw on the document:
   - To draw a line, crossout, or arrow, drag the tool across the document where you want the markup to appear.
   - To draw a polyline, click to create the starting point, move the tool, and then click to create each segment.
• To draw a line, polyline, or arrow that is horizontal or vertical, press Shift while you draw.

3. To change the line properties, on the Markup properties toolbar, do any of the following:
   • To change the color, click the Color button, and then select a color from the color picker.
   • To change the line width, select the value from the drop-down list.
   • To change the line style, select the style from the drop-down list.

4. Navigate to another document to save the markup.

To add shapes:

1. On the Markup toolbar, click one of the following:
   • To draw a rectangle or square, click the Rectangle tool.
   • To draw an ellipse or circle, click the arrow next to the Rectangle tool, and then click the Ellipse tool.

2. Draw in the document:
   • To draw a rectangle or ellipse, drag the tool across the document where you want the markup to appear.
   • To draw a square or circle, press Shift while you draw.

3. To change the shape properties, on the Markup properties toolbar, do any of the following:
   • To change the color, click the Color button, and then select a color from the color picker.
   • To change the shape style, select the style from the shape style list.

4. Navigate to another document to save the markup.

To add text edit markups:

When a document contains selectable text, the Strikeout, Underline, and Highlight tools become available.

1. On the Markup toolbar, click one of the following:
   • To draw a strikeout, click the Strikeout tool.
   • To draw an underline, click the arrow next to the Strikeout tool, and then click the Underline tool.
   • To draw a highlight, click the arrow next to the Strikeout tool, and then click the Highlight tool.

2. Draw in the document:
   • To draw a strikeout, drag the tool across the text where you want the strikeout to appear.
   • To draw an underline, drag the tool across the text where you want the underline to appear.
To draw a highlight, drag the tool across the text where you want the highlight to appear.

3. To change the text edit color, on the **Markup properties** toolbar, click the **Color** button [ ], and then select a color from the color picker.

**ASCII**

The **American Standard Code for Information Interchange (ASCII)** is a standard seven-bit code that was proposed by ANSI (American National Standards Institute) in 1963, and finalized in 1968. Other sources also credit much of the work on ASCII to work done in 1965 by Robert W. Bemer. **ASCII was established to achieve compatibility between various types of data processing equipment.**

ASCII, pronounced "ask-key", is the common code for microcomputer equipment. The standard ASCII character set consists of 128 decimal numbers ranging from zero through 127 assigned to letters, numbers, punctuation marks, and the most common special characters (see ASCII Table).

A) **Strikeout**  B) **Highlight**  C) **Underline**

4. Navigate to another document to save the markup.

**Applying images and stamps**

The Images tool allows you to insert raster images (JPG, BMP, or PNG) into the current document. Images are created in an image editor for use with Concordance Native Viewer. Concordance Native Viewer is shipped with 16 images, such as Draft, Final, Reviewed, and Witness.
Mr S. McCorman  
The Boathouse  
Lake Texoma  
Dallas  
Texas 9786.09568  
December 19, 1983  

Dear Steve,  

It was wonderful seeing you and Rita on Sunday. You certainly have the perfect garden for a summer drinks party. Rita's looking stunning, she's obviously recovered from Jeremiah's birth very quickly.

As we discussed last week, the funding of our T.0 Texaco is still problematic. I want to reassure you that CONGO 81-2 funds will not go towards retaining any lawyers or accountants for the other milking funds. There are funds earmarked for that particular purpose which are in Dibbs Account Tuesday. We've already made this very clear to the lawyers and accountancy firms involved. If there are any further murmurs, I won't hesitate to take this to the next AGM, not that they would fully understand the implications. It would have the desired effect, should we fail to contain the situation. I shall also be contacting the senior partners underlining our arrangements will not be changed.

Are you aware that after the merger of our Dallas and Chicago committees on 30.11.83 that if am now part of the combined steering committee. Not bad for a newcomer to the politics. I will of course keep you informed of any exciting events.

My fellow committee members are: Parish RJ, Schiermester N. Kellet PB and Daly JR. You should be ok with Daly JR as well. He phoned me last week just to tell me how impressed he is at your work in this transaction. One in the eye for you kid!

Call me on Thursday for the latest update - ext.3546.

Best wishes to you, Rita and Jeremiah.

RC Simmons
1. On the **Markup** toolbar, click the **Image** tool 📝.

2. On the **Markup properties** toolbar, do one of the following:
   - From the **Image** list, select an image.
   - Click **Browse**, and then select the image you want to add.

3. Select the area where you want to add the image.

4. Navigate to another document to save the markup.

⚠️ The image list in the Markup properties toolbar lists shows the 10 most recently used images providing quick access to the images you apply most often.

Stamps contain predefined information, such as color, content, and other elements that cannot be modified. Concordance Native Viewer is shipped with four predefined stamps:

- Attorney's Eyes Only
- Attorney-Client Privilege
- Confidential
- Under Seal
Mr S. McCormack  
The Boathouse  
Lake Texoma  
Dallas  
Texas 9786.09568  
December 19, 1983  

Dear Steve,  

It was wonderful seeing you and Rita on Sunday. You certainly have the perfect garden for a summer drinks party. Rita’s looking stunning, she’s obviously recovered from Jeremiah’s birth very quickly.

As we discussed last week, the funding of our T.O Texaco is still problematic. I want to reassure you that CONGO 81-2 funds will not go towards retaining any lawyers or accountants for the other milling funds. There are funds earmarked for that particular purpose which are in Dibbs Account Tuesday. We’ve already made this very clear to the lawyers and accountancy firms involved. If there are any further murmurs, I won’t hesitate to take this to the next AGM, not that they would fully understand the implications. It would have the desired effect, should we fail to contain the situation. I shall also be contacting the senior partners underlining our arrangements will not be changed.

Are you aware that after the merger of our Dallas and Chicago committees on 30.11.83 that I am now part of the combined steering committee. Not bad for a newcomer to the politics. I will of course keep you informed of any exciting events.

My fellow committee members are: Parish ED, Schiermieser NJ, Kellet PE and Daly JK. You should be OK with Daly JK as well. He phoned me last week just to tell me how impressed he is at your work in this transaction. One in the eye for you kid!

Call me on Thursday for the latest update - ext.3346.

Best Wishes to you, Rita and Jeremiah.

RC Simmons

Images supplied by Elliott Slone, London, UK
To add a stamp:

1. On the Markup toolbar, click the Stamp tool.
2. On the Markup properties toolbar, select a stamp from the Stamp list.
3. Click the area where you want to add the stamp.
4. Navigate to another document to save the markup.

The stamp list in the Markup properties toolbar lists the four default stamps that are shipped with Concordance Native Viewer.

Applying redactions

A redaction is used when confidential information needs to be hidden in a document for production. Redactions associated with the produced document cannot be edited or removed. Once the document is produced, any text or images concealed by a redaction cannot be viewed, copied, or searched.

If you need to export the body text for a production, you will need to re-OCR the images after the redactions have been burned in.

The Redaction tool allows you to place one or more redactions (rectangular boxes) over various areas of sensitive information within a document. In Concordance Native Viewer, the redaction appears transparent to allow you to make sure the redaction covers the information you want to conceal. When a production is executed, the redaction becomes opaque concealing the information underneath.

When redacting a bullet or numbered list, it is recommended that you always apply redactions using the Rectangle tool. This ensures that the list content is completely redacted when the image is produced and/or printed. Begin drawing the rectangle in the margin, outside the text area, to ensure all information is redacted successfully.

Since PDF files are not flattened or burned, when producing PDF files the redacted information is removed from the file before the redaction is placed. The production process physically removes the hidden text from the produced file, the original document is not altered.

When printing CNV documents, redacted documents print with transparent redactions making the text underneath the redaction visible. If you want redactions to print opaque, you need to use the Production tool in Concordance to produce the documents and then print the output documents. For more information about productions, see About productions.

There are two ways you can apply a redaction:
ASCII

The American Standard Code for Information Interchange is a standard seven-bit code that was proposed by ANSI (American National Standards Institute) in 1963, and finalized in 1968. Other sources also credit much of the work on ASCII to work done in 1965 by Robert W. Bemer. ASCII was established to achieve compatibility between various types of data processing equipment.

ASCII, pronounced “ask-key”, is the common code for microcomputer equipment. The standard ASCII character set consists of 128 decimal numbers ranging from zero through 127 assigned to letters, numbers, punctuation marks, and the most common special characters (see ASCII Table).

<table>
<thead>
<tr>
<th>Dec</th>
<th>Hex</th>
<th>Cmt</th>
<th>Chn</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>00</td>
<td>null</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>01</td>
<td>start of heading</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>02</td>
<td>start of text</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>03</td>
<td>end of text</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>04</td>
<td>end of transmission</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>05</td>
<td>enquiry</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>06</td>
<td>acknowledge</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>07</td>
<td>bell</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>08</td>
<td>horizontal tab</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>09</td>
<td>vertical tab</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>0a</td>
<td>form feed, new page</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>0b</td>
<td>carriage return</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0c</td>
<td>line feed</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>0d</td>
<td>shift out</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>0e</td>
<td>shift in</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>0f</td>
<td>natural linefeed, carriage return</td>
<td></td>
</tr>
</tbody>
</table>

Computers can only understand numbers, so an ASCII code is the numerical representation of a character such as ‘a’ or ‘@’ or an action of some sort. ASCII was developed a long time ago and now the non-printing characters are rarely used for their original purpose. ASCII was actually designed for use with teletypes and so the descriptions are somewhat obscure. If someone says they want your CV however in ASCII format, all this means is they want ‘plain’ text with no formatting such as tabs, bold or underscoring - the raw format that any computer can understand. This is usually so they can easily import the file into their own applications without issues. For instance, Notepad creates ASCII text, or in MS Word you can save a file as ‘text only’.

---

A) Redacted paragraph
B) Redacted text within a paragraph
C) Highlighted text

To add a redaction:
1. On the **Markup** toolbar, click the **Redaction** tool.

2. Using the **Redaction** tool, do any of the following:
   - To redact sentence-level text, click within the text and draw the tool along the text.
   - To redact a section of a document, click outside the text area and draw a rectangular box around the text.
   - To redact a list, click outside the margin of the list, and draw a rectangular box around the text.

   > We recommend that you use different colors when applying redactions and highlighting text. This ensures that the markup type can be easily differentiate when viewing a document or image.

3. With the redaction selected, on the **Markup Properties** toolbar, locate the **Reason** list.

4. In the **Reason** list, do one of the following and then press **Enter**:
   - Type a new reason.
   - Click an existing reason from the list.

   ✔️ If you do not enter a reason for the redaction and press Enter or select a reason from the list, the current redaction reason shown in the Reason list will be applied to the redaction.

   ✔️ The redaction list displays only 40 redaction reasons based on alphabetical order.

4. Navigate to another document to save the redaction.

   ✗ To change the properties of a redaction:

   1. On the **Markup** toolbar, click the **Selection** tool.

   2. Select the redaction you want to change.

   3. On the **Markup properties** toolbar, do any of the following:
      - To change the redaction color, click the **Color** button, and select a new color from the color picker.
      - To change the redaction reason, type a new reason or select it from the list, and then press **Enter**.

   4. Navigate to another document to save the redaction.
Editing markups

You can change the appearance, size, and location of markups after you add them. All changes are tracked in the Markup History view of the Media Information pane.

- **To edit a markup’s properties:**

  1. From the markup toolbar, click the Selection tool.
  2. Select the markup you want to edit.
  3. From the Markup properties toolbar edit any of the properties.

- **To edit another user's markups:**

  1. From the markup toolbar, click the Selection tool.
  2. Press Shift and then select the markup you want to edit.

- **To rotate or resize a markup:**

  1. On the Markup toolbar, click the Selection tool.
  2. Select the markup.

    The markup displays a rotate handle and resize handles around the perimeter.

  3. Do one of the following:

    - To rotate the markup, drag the green rotate handle in the direction you want to rotate the markup.
    - To resize the markup, drag one of the resize handles to transform the markup to the desired size.

- **To delete a markup:**

  1. On the Markup toolbar, click the Selection tool.
2. Do any of the following:
   - To select a single markup to delete, select the markup you want to delete.
   - To select multiple markups, press CTRL and select the markups you want to delete.
   - To select all the markups on the page, drag the Selection tool across all the markups on the page.

3. Press Delete.

---

**Performing OCR**

**About OCR processing**

Optical Character Recognition (OCR) processing can be performed on a single page or an entire document displayed in Concordance Native Viewer. Initiating the OCR Single Image command, scans the page or document and then writes the data to a specified field in the corresponding record in Concordance for indexing and searching. For example, if you receive an update to a document without the corresponding OCR file, you can load the document into Concordance and link it to Concordance Native Viewer. Then using the OCR Single Image command, scan the document and store the data in the associated Concordance database.

- This feature requires activation of the OCR on the Fly license for Concordance Native Viewer. Please contact Concordance Sales by e-mail at LitigationSalesGroup@ReedElsevier.com or phone at 1-800-421-8398. To activate an OCR on the Fly license, see Installing Concordance Native Viewer.

- While the OCR Single Image process is running, do not navigate between records in Concordance or close Concordance. This will cause the process to fail to write the data to the selected record.

- **Accuracy**
  - Digital OCR processing does not offer perfect text recognition
  - Accuracy may be reduced by many conditions:
    - Text appears skewed or uneven on the page
    - Pages are creased or torn
    - Letters are faded, blurry or otherwise distorted
    - Non-standard type faces used in documents
    - Font style, size, and/or color
    - Image files with low resolution (such as .gif formatted images), background noise, inverted colors, black margins, or wrong page orientation
    - Multiple languages selected for processing

- **Scanning Process**
Keep the following in mind:

- Typical processing time is between 1 to 2 pages per second
- Processing OCR text is CPU intensive and can require significant time and computing resources to carry out large jobs. For example, a 32000 page document may take up to 6 hours to OCR the pages and write the data back to Concordance.
- Processing power and memory of computer performing OCR
- Amount of text and other information on the pages
- Quality of the document

**Fields**

All OCR fields must have:

- OCR fields already exist in the associated Concordance database. The OCR fields may already contain data that you can append additional data to the next available OCR field or overlay the existing content with new data.
- Same alpha prefix
- Numerical suffix that start with 1 and are the same numerical length
- Listed in ascending order by suffix (TEXT1, TEXT2, TEXT3, .etc)
- User must have full Read/Write access

**Language**

The following writing systems or scripts can be processed with OCR Single Image:

- Latin (for English, French, Spanish, German, etc.)
- Cyrillic (for Russian, Bulgarian, etc.)
- Greek
- Chinese (Simplified and Traditional)
- Japanese
- Korean

For more information about Unicode Support in Concordance, see About the Unicode Standard.

**Database**

- Concordance Native Viewer is locked once the OCR process is initiated and remains locked until it is completed.
- The corresponding Concordance database record is locked for all users. The database record can be viewed but not edited.
- Indexing cannot be performed on the database during the OCR process.

⚠️ While the OCR Single Image process is running, do not navigate between records. This will cause the process to fail to write the data to the selected record.
Using OCR processing

The OCR Single Image process can be performed on the entire document or just the page currently displayed within the viewer.

Before processing the OCR text:
- Make sure that the OCR fields in the corresponding Concordance database are setup properly (i.e. TEXT01, TEXT02, TEXT03, etc.)
- Make sure that there are enough OCR fields to support the data resulting from the scan
- The fields must be paragraph type fields to ensure the data is indexed and searchable
- You have read/write access to the fields

⚠️ When running the OCR process on a document that contains a markup that is not burned in, the text that lies under the markup will be scanned and imported to the specified database field. If you do not want the text under the markup scanned, you must first produce the document using the Production command in Concordance, load the produced document into the database, and then scan the document.

✔️ When running OCR Single Image, the corresponding Concordance database record is locked until the process is complete.

To OCR the text of a document or image:

1. In Concordance Native Viewer, navigate to the document you want to scan.
2. From the File menu, click OCR Single Image.
3. In the OCR Options dialog box, from the Select a field list, select the database field you want to write the data.
4. Do one of the following:
   - Select **Append** to write the OCR data to the specified field.
   - Select **Overlay** to replace the existing data in the specified field.

   ! If the Overlay option is selected, any existing data in the specified field will be overwritten and lost.

5. Do one of the following:
   - Select the **Current Page** option to scan the text of the page currently displayed in the viewer.
   - Select the **Entire Document** option to scan the text of all the pages of the current document.

6. From the **Language Options** list, select the script that pertains to the OCR characters that are being processed:
   - Latin (English, French, Spanish, German, etc.)
   - Cyrillic (Russian, Bulgarian, etc.)
   - Greek
   - Chinese (Simplified)
   - Chinese (Traditional)
   - Japanese
   - Korean

   Selecting multiple languages options may reduce character recognition accuracy.
7. Click **Start**.

⚠️ While the OCR Single Image process is running, do not navigate between records in Concordance or close Concordance. This will cause the process to fail and the data will not be written to the specified field.

8. In Concordance, verify that the data appears in the specified field.
Using Concordance Image
Using Concordance Image

Using Concordance Image with Concordance

Content review of records is primarily done with Concordance Image. Concordance Image allows you to magnify the original document image for clarity and inspection (especially for dates and signatures), and provides a variety of annotation tools specifically designed for privileged content and trial preparation. Once you have annotated content, especially redacted key information, the document markings are automatically saved and the changes secured. A third-party, such as opposing counsel, will not be able to uncover the redaction information or remove any notable markings once they are burned onto a new set of images during production.

Concordance Image opens image records in a secondary window, which can be resized to view alongside the main Concordance application, allowing you to see both the Browse and Table views while reading the full document content.

You can view your Concordance Images three ways:

- Select your record in Concordance, and then click the View image (camera) button on the Dynamic toolbar.
- Right-click a record in the Browse, Table, or Edit view and select View image.
- Select a record in Concordance, and then on the View menu, click Image.

You can view all case records in the Browse view. This is especially beneficial for cursory reviews, when you are sorting and tagging documents, and performing preliminary content searches based on particular word queries. The majority of content review, however, is done with the increased viewing capabilities and annotation features available while viewing the original image in Concordance Image.

Not all case records are viewable in Concordance Image. Transcript files are text files stored in a separate database and viewable only in the Browse and Table views. Notes entered in the Browse view are not viewable in the image view because they are separate text files. Similarly, notes entered in Concordance Image records are not viewable in the Browse view because they are scanned image files. The same document files are linked in the database for full search functionality, but record additions are not transferable for viewing purposes. Review documents in each available view option as it relates to the level of content review and specific sorting process.
The following image file formats are supported by Concordance Image:

- TIFF files (*.tif)
- JPEG files (*.jpg)
- GIF files (*.gif)
- Bitmap files (*.bmp)
- PCX files (*.pcx)
- CALS files (*.cal, *.mil)
- Concordance Image imagebase (*.dir, *.fyl)

⚠ Printing images that contain markups to Adobe PDF using the File > Print option, does not permanently burn the markups in the document. If you want markups burned in, you must run the documents through the Production process, then print the produced document.

Working with Concordance Image

Navigating Concordance Image

Use the toolbars in Concordance Image to navigate between records, apply redlines, and
adjust how images are displayed.

The following toolbars are available in Concordance Image:

- Standard toolbar
The Standard toolbar offers opening, printing, selecting, and immediate resizing with the Rectangle magnifier, Window zoom, and Mark zoom buttons, as well as quick access to Concordance Image Help.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📡</td>
<td>Open</td>
<td>Opens images not associated with the current database</td>
</tr>
<tr>
<td>📜</td>
<td>Print</td>
<td>Prints documents and pages for the current database</td>
</tr>
<tr>
<td>🗑</td>
<td>Mark</td>
<td>Marks an area in the image to copy</td>
</tr>
<tr>
<td>🗑</td>
<td>Mark Zoom</td>
<td>Zooms in on a selected area</td>
</tr>
<tr>
<td>🕵️</td>
<td>Magnifier</td>
<td>Opens a magnifier window for viewing sections of an image</td>
</tr>
<tr>
<td>🔍</td>
<td>Zoom</td>
<td>Opens the Magnify window for viewing a selected area of an image</td>
</tr>
<tr>
<td>🕵️</td>
<td>Pan</td>
<td>Moves the image in any direction</td>
</tr>
<tr>
<td>💡</td>
<td>Help</td>
<td>Opens Concordance Image Help</td>
</tr>
</tbody>
</table>

**Redlines Toolbar**

The Redlines toolbar provides a variety of tools used to markup or *redline* an image during review.
The View toolbar provides document and page navigation as well as additional viewing tools.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✧</td>
<td>First</td>
<td>Navigates to the first page in the document</td>
</tr>
<tr>
<td>✧</td>
<td>Previous</td>
<td>Navigates to the previous page in the document</td>
</tr>
<tr>
<td>✧</td>
<td>Next</td>
<td>Navigates to the next page in the document</td>
</tr>
<tr>
<td>✧</td>
<td>Last</td>
<td>Navigates to the last page in the document</td>
</tr>
<tr>
<td>✧</td>
<td>Previous Document</td>
<td>Navigates to the previous document in the imagebase</td>
</tr>
<tr>
<td>✧</td>
<td>Next Document</td>
<td>Navigates to the next document in the imagebase</td>
</tr>
<tr>
<td>✧</td>
<td>Zoom Out</td>
<td>Zooms out incrementally</td>
</tr>
<tr>
<td>✧</td>
<td>Zoom In</td>
<td>Zooms into smaller areas on a larger image</td>
</tr>
<tr>
<td>✧</td>
<td>Fit Width</td>
<td>Changes the zoom level such that the entire width of the image appears in the window</td>
</tr>
</tbody>
</table>
### Viewing records in Concordance Image

When the View Image button is activated on the Dynamic toolbar in Concordance, opening a document in Concordance automatically launches Concordance Image. If you do not want images or attachments to automatically launch during your review, you can set this up in the Viewer Preferences, see Defining preferences.

With Concordance Image open alongside the Concordance application, you can view a record in the Browse and Table views while viewing the same record in Concordance Image.

1. **To dock the Concordance Image window next to the Concordance window,** on your Microsoft Windows application bar at the bottom on the screen, press and hold the CTRL key down while clicking Concordance and Concordance Image in the taskbar, right-click either of the applications in the taskbar, and select Tile Horizontally or Tile Vertically. The applications are now displayed side by side.

2. **To view records in Concordance Image:**
   1. In Concordance, on the **Dynamic** toolbar, click the **View Image** (camera) button to open Concordance Image.
      
      Concordance Image automatically launches the current record in the Concordance Image viewer window.
   2. If you know the record you want to view, do one of the following:
      
      - Locate the record in the **Browse** or **Table** view in Concordance, and then click the **View image** (camera) button.
      - Right-click the record and then click **View image**.
      - On the **View** menu, click **Image**.
      
      You can also locate a record from within Concordance Image.
   3. To open the **Goto Image key** dialog box, on the **Page** menu, click **Go to image**.
      
      Image keys are merely Bates numbers for documents that appear in text.
   4. Select the record you want to view and click the **Go to** button to display the record in Concordance Image.
You can quickly locate a record in the Goto Image key dialog box by typing the image key number (Bates number) in the field below the image key list. Be sure to include any leading zeros in the number.

To open an imagebase:

1. In Concordance Image, on the File menu, click Open Image.
2. Click OK to acknowledge the message.

   Normally, an imagebase is automatically opened by clicking the View Image button in Concordance, but you can also open an imagebase that does not have an accompanying Concordance database using the Open Image command.

3. In the Open dialog box, navigate to and open the Concordance Image .dir or .fyi imagebase file.

⚠️ Warning: Concordance version 10 databases and Concordance Image version 5 imagebases are not compatible with Concordance FYI Server version 3.53 or earlier and FYI Reviewer version 3.55 or earlier. Concordance 10 databases and Concordance Image 5 imagebases are compatible with FYI Server and FYI Reviewer versions 4.x or later.

To navigate records in the database:

1. To navigate between records, do any of the following:
   - On the View toolbar, click the Next document button or Previous document button.
   - On the Pages menu, click Next document or Previous document.
2. To navigate between images, do any of the following:
   - On the View toolbar, click the Next image or Previous image button.
• On the **Pages** menu, click **Next** or **Previous**.

3. To navigate to the first or last image of a document set, do any of the following:
   • On the **View** toolbar, click the **First image** or **Last image** button.
   • On the **Pages** menu, click **First** or **Last**.

4. To navigate between document folders, on the **Pages** menu, click **Next folder** or **Previous folder**.

[To adjust the image view:](#)

Locate the record you want to view, on the View menu, click any of the following:

<table>
<thead>
<tr>
<th>View Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scale Quality        | **Fastest** - scales the image as fast as possible  
|                      | **Best Quality** - scales the image slowly to get better results  |
| Anti-alias           | **None** - turns anti-aliasing off  
|                      | **Fast** (4 shades of gray) - turns anti-aliasing on using 4 shades of gray  
|                      | **Partial** (16 shades of gray) - turns anti-aliasing on using 16 shades of gray  |
| Invert color         | Reverses the color of the background and the color of the text.  |
| Zoom in 50%          | Zooms in on the image by 50%  |
| Zoom out 50%         | Zooms out of the image by 50%  |
| Zoom on Selection    | Zooms in on the current selection  |
| Zoom in a little     | Zooms in by a small predefined increment  |
| Zoom out a little    | Zoom out by a small predefined increment  |
| Fit to Width         | Resizes the image to the width of the window  |
| Fit to Height        | Resizes the image to the height of the window  |
| Full Screen          | Places Concordance Image in full-screen mode  |
| Rotate from Original Orientation | **Left** - rotates the image left from its original orientation  
|                      | **Right** - rotates the image right from its original orientation  
|                      | **Flip** - rotates the image 180° from its original orientation  |
| Rotate from Current Orientation | **Left** - rotates the image left from its current orientation  
|                      | **Right** - rotates the image right from its current orientation  
|                      | **Flip** - rotates the image 180° from its current orientation  |
| Reset Rotation to Original | Resets the image to its original orientation state  |
| Mirror Horizontally | Flips the image 180° horizontally  |
| Mirror Vertically    | Flips the image 180° vertically  |
| Mirror Both          | Flips the image simultaneously 180° vertically and horizontally  |
To activate the bar code mode:

The Bar Code Mode gives a bar code reader control of how documents are viewed. You can also use a bar code reader to jump to specific images in your imagebase.

Some bar code readers require you to use a beginning and ending delimiter. By default most use the asterisk character (*). For example, the command to zoom in would be: *E*

2. Scan the bar code equivalents of the following letters:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F</td>
<td>Full Screen</td>
</tr>
<tr>
<td>E</td>
<td>Zoom in</td>
</tr>
<tr>
<td>D</td>
<td>Zoom out</td>
</tr>
<tr>
<td>H</td>
<td>Fit to height</td>
</tr>
<tr>
<td>W</td>
<td>Fit to width</td>
</tr>
<tr>
<td>R</td>
<td>Rotate right</td>
</tr>
<tr>
<td>L</td>
<td>Rotate left</td>
</tr>
<tr>
<td>A</td>
<td>Annotations toggle</td>
</tr>
<tr>
<td>P</td>
<td>Previous page</td>
</tr>
<tr>
<td>N</td>
<td>Next page</td>
</tr>
<tr>
<td>O</td>
<td>Previous document</td>
</tr>
<tr>
<td>V</td>
<td>Next document</td>
</tr>
<tr>
<td>C</td>
<td>Close all images</td>
</tr>
<tr>
<td>I</td>
<td>Invert Color</td>
</tr>
<tr>
<td>G</td>
<td>Go to page</td>
</tr>
</tbody>
</table>

To jump to a specific image:

1. On the Tools menu, make sure that the Toggle Bar Code Menu command is marked.
2. Scan the image key for the image you want to view.
To view information about the current image:

On the Help menu, click Image Information.

Image Information

- **Image title**: 0001001800010018.TIF
- **Page**: Page 1 of 1
- **File Name**: C:CONCORDANCE TRAINING\CLASS EXERCISES\VOL001\IMAG
- **Image Type**: TIFF
- **Compression**: Group 4
- **Color Depth**: 1-bit
- **Orientation**: No rotation
- **Image Width**: 2465
- **Image X Resolution**: 300
- **Image Height**: 3602
- **Image Y Resolution**: 300
- **Window Width**: 1236
- **Window X Resolution**: 96
- **Window Height**: 637
- **Window Y Resolution**: 96
- **OK**

Magnifying records

In Concordance Image, you can zoom, magnify, pan and rotate documents depending on the record type and particular content. For instance, handwritten documents are harder to read online and perhaps illegible in some instances too. Special magnifying options allow you to read with ease and inspect signature details.

Use Concordance Image's Standard toolbar and View menu selections to increase a document's size for distinct inspection and various magnification options. The Standard toolbar offers immediate resizing with the Rectangle magnifier, Window zoom, and Mark zoom buttons.

- **Mark zoom** - captures the selected region of a document and instantly enlarges it to a full-screen view.
- **Rectangle magnifier** - offers an instant, temporary magnification of a document region and is useful to quickly check a date or signature. Holding the mouse’s left button and dragging the magnifying glass across the document will provide instant zoom quality while viewing images. This tool is great for viewing handwritten documents.
- **Window zoom** - captures a magnified region of the document in a window, to keep the magnification static and dramatically increase the zoom percentage in the Magnify list.
To use the magnification buttons on the Standard toolbar:

1. In Concordance Image, locate the record you want to magnify.
2. Use the magnification tools to magnify the current document.
   - Click the Rectangle magnifier tool, and drag the magnifier over the area you want to magnify.
   - Click the Mark zoom tool, and click the record and drag the crosshatch marks in a box surrounding the area you want to magnify, then release the left mouse button to fill the viewing window.
   - Click the Zoom out or Zoom in buttons on the View toolbar to readjust the magnification setting in small increments.
   - Click the Pan tool, click the record, and drag the document in any direction to view other areas of the document while it is magnified.
   - Click the Fit to height button on the View toolbar to reset the record to its original view settings.
   - Click the Window zoom tool, click the record, float the magnifier over the area you want to magnify.

Clicking the Window zoom tool opens the Magnify box. You can adjust the magnification value, up to 500 percent, in the Magnify field.

Using the Sticky Zoom and Sticky Rotate

Spreadsheets are often scanned with a portrait page view setting, making online reading a challenge unless you rotate the image. The Sticky zoom and Sticky rotate settings make your review much easier by changing the page layout to a landscape view and keeping it there while you navigate the record.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Page</th>
<th>Redlines</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Produce...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle Bar Code Mode</td>
<td>Ctrl+B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle Redlines</td>
<td>Ctrl+R</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔴 Sticky zoom</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>🔴 Sticky rotate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export imagebase to log file...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Imagebase Management...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preferences...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Sticky zoom and Sticky rotate functions are located on the Tools menu in Concordance Image:

- **Sticky zoom** - keeps your preferred magnification settings as you move from record to record.
record. If you uncheck the selection, the record size defaults to a full page view.

- **Sticky rotate** - retains the rotated settings as you page through a record. These settings are especially helpful if you are reviewing a spreadsheet.

A check mark next to each option on the Tools menu indicates that this setting is selected for Concordance Image. Save your Sticky zoom and Sticky rotate settings in the Preferences dialog box or contact your Concordance administrator for assistance.

### Annotating images

#### About redlines

During the discovery process, annotating record detail is the phase when deeper content investigation and case record preparation begins. Upcoming depositions and court appearances require that your paperwork is already in order, opposing counsel wants copies, and all records need to be edited with proper annotations: notes added, key content highlighted, related files attached, links to Websites, and privileged information redacted.

Redlines toolbar  
Example of a redlined image
The Redline toolbar, located on the upper left of the Concordance Image window, includes the variety of tools used to mark or redline an image during review. Applying redlines includes redacting information and adding notes. You can also apply color markings to highlight or underline text and add a circle or box to emphasize a block or region of key content. Once redlines are applied, you can search the document for each type. All of these elements can easily be edited, moved, or resized.

As soon as you begin redlining or annotating a document, the right-click menu options are available to you. This is especially important when applying redactions; you can edit the color and text, move or resize the box, or simply delete it. Redaction marks and other redlines can be fused to the image file during print production, securing the document. When Concordance administrators process a production, they can then select which markings are fused to the image, depending on needs and recipient.

There is no limit to the number of redline annotations you can add to a document. Please use some restraint though, and stick to the internal review guidelines for your organization, ensuring all redline marks are sensibly applied and records are kept clean for other reviewers.
Concordance Image stores redline marks in EPS layers (up to nine layers) that cannot be unlocked, which is particularly useful for redacted content. All annotated documents are stored in a separate redlines database. Redlines are automatically saved in this database once applied, but you cannot search a document for redlines and others cannot view these changes until the database is reindexed.

For more information about printing images, see Printing images in Concordance Image.

⚠️ It is best practice to add highlights using the standard yellow default color or the color outlined in your organization’s coding manual. Too many colors may make a record appear messy. Please note that black highlighting is opaque and severe, possibly inferring that covered information is being hidden intentionally from opposing counsel. White highlights are also opaque and could be detrimental to content integrity. Once applied, a white highlight cannot be detected again easily for editing or removal. Critical information could be inadvertently lost or presumed hidden from opposing counsel in a covert manner. Please use restraint and use white highlights only for production needs, such as covering Bates numbers.

You can customize the redaction text, font, and list placement, create a list of redaction terms, and set the default redaction text on the Redaction tab of the Preferences dialog box. If there is more than one redaction term created on the Redaction tab, the terms are available for selection when you right-click a redaction in Concordance Image.

⚠️ Redaction text is not shared between Concordance Image and FYI Reviewer. Redaction text created in Concordance Image is only available in Concordance Image, and redaction text created in FYI Reviewer is only available in FYI Reviewer. If you want the same redaction text to be available in Concordance Image and FYI Reviewer, you will need to create the redaction text in both applications.

In FYI Reviewer, redaction text is created on the Redlines tab in the Preferences dialog box.

Applying redlines to images

⚠️ To apply redlines to a record:

1. Locate the record you want to apply redlines.
2. On the Redlines toolbar use any of the following tools to apply redlines to the current document.
   - To apply a highlight, click the Highlight tool, drag the tool from the beginning of the text you want to highlight.
   - To apply a redaction, click the Redact tool, drag the tool across the area where you want to redact.

   Redaction is the default text displayed within the box. On the Redaction tab of the Preferences dialog box, you can customize the redaction text, font, and list placement, create a list of redaction terms, and set the default redaction text. If there is more than one redaction term created on the Redaction tab, the terms are available for
selection when you right-click a redaction in Concordance Image. See, Defining preferences.

- To apply a box, ellipse, or solid ellipse, click the **Hollow box** 🔴, **Hollow ellipse** ○, or **Solid ellipse** 🔴 tool, drag the tool across the area where you want to add the shape.

- To apply text, such as Privileged, click the **Text** tool A, drag the tool across the area where you want to add the text. In the **Text** dialog box, type the text you want to add, and then click **OK**.

- To apply a line, click the **Line** tool 🆓, drag the tool across the area where you want the line to end, and release the left mouse button.

- To apply a sticky note, click the **Note** tool 📖, drag the tool across the area where you want to add the note, in the **Note** dialog box, type the note text, and then click **OK**.

- To view or edit the note text, double-click the note or right-click the text and select **Edit annotation**.

**Notes added to an image record are not viewable or accessible when the same document is viewed in the Browse view. These database files are linked but cannot transfer or share edits.**

**We recommend incorporating a note standard for the review team by sizing all notes in a one-inch box located in the upper left corner of the document. This ensures that all notes are in a known, visible location for all reviewers and makes searching for them, at a glance, much easier. Remember that notes are still Concordance fields and can retain the 12 million-character per paragraph capacity; a lot of information can be packed into a one-inch note.**

Redlines are saved to the image file when you close the record or navigate records within Concordance Image.

3. To make redline updates searchable and visible to other users, on the **Redlines** menu, click **Reindex**.

   A check mark is displayed next to the Reindex command when the redlines database needs to be reindexed.

4. When you are finished redlining records in Concordance Image, collaborate with your Concordance administrator to determine whether to fuse graphics to the image during production, as well as which redlines to fuse.

You can change the color, move, or delete any of the redlines using the right-click menu. You can reduce the size of a redline using the Resize redline button on the Redlines toolbar.

**Markups applied to a .bmp file using Concordance Image version 5.09 or earlier and viewed in Concordance Image version 5.10 or later or FYI Reviewer version 5.07 or later will not display in the correct location.**

**To change the color of a redline:**

1. Right-click a redline, and then click **Change color**.
2. Select the new color and click OK.

**To move a redline:**

1. Do one of the following:
   - Right-click a redline, and then click *Move*.
   - On the Redlines toolbar, click the Move redline tool.  
2. Drag the redline to the new location.

**To delete a redline:**

Right-click a redline, and then click Delete [redline type].

**To reduce the size of a redline:**

1. On the Redlines toolbar, click the Resize redline tool.  
2. Click the redline.

Using the Resize redline button makes a redline smaller each time you click on it. There is not an option for enlarging redlines, so use the Resize redline button carefully. There is no undo function for this feature.

**To customize redaction text:**

1. In Concordance Image, on the Tools menu, click Preferences.
2. Click the Redaction tab.
   - To create a new redaction term, type the new term in the Redaction text field and click the Add button.
   - To remove a redaction term, select the redaction term in the redaction list and click the Remove button.
   - To customize the font of a redaction term, select the term in the redaction list and click the Font button, and then modify the font settings and click OK to save your changes.
   - To make a redaction term the default when creating redactions, select the term in the redaction list and click the Make default button. A check mark is displayed next to the default redaction term in the redaction list.
   - To change the placement of a redaction term in the redaction list, select the redaction term in the redaction list, and click the Move up or Move down button.

When you right-click a redaction in Concordance Image, the redaction terms are listed in the order they are listed in the redaction list in the Preferences dialog box.

3. When finished, click OK.
Searching redlines

Once records have been reviewed and redlines applied, you may need to edit a comment or assess the number of redactions in a group of records. You can locate redlines in Concordance Image by type or reviewer in the Search task pane.

To search for redlines in Concordance Image:

1. To open the Search task pane, do one of the following:
   - On the Redlines toolbar, click the Search button
   - On the Redlines menu, click Search.

2. Do one of the following:
   - To search by redline type, click the Containing tab and select the check boxes next to the redline types you want to include in the search.
   - To search by reviewer, click the Advanced tab and select the check box next to the reviewers you want to include in the search.

   When a check box is selected, the reviewer is included in the search.

3. Click the Search button.
All records containing your search criteria are displayed in the Search results field. Records are listed as folders, named as the document load order number.

4. Click a folder to review a listing of annotations, based on your search criteria, for this record.

5. To navigate to a specific redline within a document, click the redline in the Search results field.

6. To view the document where redlines were applied, click one of the document’s redlines in the Search results field.

7. To close the Search task pane, do one of the following:
   - Click the X in the upper right of the Search task pane.
   - On the Redlines menu, click Search.

### Saving images

Using the Save As command, you can save the current image under a different file name or format.

**To save an image:**

1. On the File menu, click Save As.

   ![Save as dialog box](image)

   2. In the File box, do one of the following:
      - Type the name of the new file along with a fully qualified path.
      - Click Browse to the location you want to save the file.

   3. Specify any of the following options:
- From the **Image Type** list, select the image type. This selection determines the available compression types, see Image type options.
- From the **Compression** list, select the group. This selection determines the number of colors available.
- From the **Colors** list, select the number of colors.
- From the **Redlines** list, select **No redlines** or **Burn redlines onto image**.

4. When finished, click **Save**.

### Image type options

<table>
<thead>
<tr>
<th>Supported Image Types</th>
<th>Compression</th>
<th>Colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF</td>
<td>None</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td></td>
<td>1-bit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-bit</td>
<td>16 colors</td>
</tr>
<tr>
<td></td>
<td>8-bit</td>
<td>256 colors</td>
</tr>
<tr>
<td></td>
<td>24-bit</td>
<td>16.7 million colors</td>
</tr>
<tr>
<td>Group 3</td>
<td>1-bit</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td>Group 3 2D</td>
<td>1-bit</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td>Group 3 TIFF</td>
<td>1-bit</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td>Group 4</td>
<td>1-bit</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td>Pack Bits</td>
<td>1-bit</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td></td>
<td>4-bit</td>
<td>16 colors</td>
</tr>
<tr>
<td></td>
<td>8-bit</td>
<td>256 colors</td>
</tr>
<tr>
<td></td>
<td>24-bit</td>
<td>16.7 million colors</td>
</tr>
<tr>
<td>PCX</td>
<td>PCX</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td></td>
<td>1-bit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-bit</td>
<td>16 colors</td>
</tr>
<tr>
<td></td>
<td>8-bit</td>
<td>256 colors</td>
</tr>
<tr>
<td>CALS</td>
<td>Group 4</td>
<td>Black &amp; White</td>
</tr>
<tr>
<td></td>
<td>1-bit</td>
<td></td>
</tr>
</tbody>
</table>
**Sending image links to Sanction**

Concordance Image can send image links to Verdict System's Sanction software application.

- Concordance 10.x is only compatible with Sanction 2.9.

---

To send image links to Sanction:

1. On the **File** menu, click **Send to Sanction**.

2. Do any of the following:
   - To send the current image, click **Send current image**.
   - To send the current document, click **Send current document**.
   - To send all the documents in the current query, click **Send current query**.

3. Click **Send**.

---

Supported Image Types | Compression | Colors
---|---|---
JPEG | JPEG | 24-bit 16.7 million colors
Concordance
User Guide

Reference Information
Reference Information

Information and Error Messages

Concordance will display a short message in English if it can load the full description. If it can’t load the message, Concordance displays the error message number. The Error Messages by Error Codes section lists the error messages by error code number. The Error Messages in Alphabetical Order section lists the error messages in alphabetical order.

- **Error Messages by Error Codes**

  - **E0001 Must open database first.**
    You have attempted to manipulate a database without first opening one. Use File Open to open the database, then try again.

  - **E0002 Database already exists.**
    You have specified a database name in Database New that already exists. Enter another name, erase the existing database, or use Database Modify if the document count is zero.

  - **E0003 Database not found.**
    Concordance was unable to find the database you specified. Concordance automatically adds the file extension .dcb to the name you supplied the Database Open command. No matching file was found.

  - **E0004 Insufficient memory.**
    Concordance was unable to continue due to a lack of available memory. Install more memory and try again.

  - **E0005 Error retrieving report.**
    You entered the name of a report to retrieve, but Concordance could not read it. Try loading the report again. If this message is repeated, the report is probably damaged and should be recreated from scratch.

  - **E0006 No previous document.**
    This is the first document in the current query set.

  - **E0007 Invalid character in field name.**
    An error encountered in File/New or Modify. You have entered a field name with a space or other invalid character in it. Only alphanumeric and underline characters can be used for field names.

  - **E0008 Duplicate field name.**
    In Database New or Modify, you have entered a field name that was previously entered. Change the name and continue.

  - **E0010 Error creating file.**
    Concordance encountered an error creating a file. Check that the specified file name is a valid name. Try again.

  - **E0011 You must select at least one field.**
    You have attempted to use fields in a command, but no fields were selected for use. Use the Fields option to select a field, then try the operation again.
- **E0012 Use Text, Numeric, Date, or Paragraph.**
  In Database New or Modify, you have specified a field type that does not exist. Valid entries are Date, Text, Numeric, or Paragraph. Correct the entry and try again.

- **E0013 Use MMDDYY, YYMMDD or DDMMYY for dates.**
  Date formats are month-day-year, year-month-day, and day-month-year. Enter them in New or Modify mode by typing the first letter of the type: M, Y, or D respectively.

- **E0014 Error saving report.**
  You entered the name of a report to save, but Concordance could not save it. The disk may be full, write protected, or the directory could be read-only.

- **E0015 A paragraph field must be selected.**
  This error is encountered when using the Documents Import command. It indicates that a free text paragraph field was not selected as the first field with the Fields menu option. Select a paragraph field as field number one and try again.

- **E0017 Abandon report**
  Not handled in the current implementation.

- **E0018 Cancel processing**
  This error is encountered in the following situations:
  - Canceling a database conversion, Replication, Pack, Modify, or import overlay process
  - Canceling an index (Concordance versions 8 and 9)
  - Canceling a sort in Concordance version 8

- **E0019 Disk full.**
  The diskette or fixed disk is full. Split the database between fixed disk drives and notify Concordance with the File menu's Files or Concatenation commands if necessary. You might try erasing or archiving old files.

- **E0020 Text file not found.**
  The system was not able to locate the database text file, file extension .tex. This file contains the text of the database, the contents of the paragraph fields. Check that the file path is correctly set. Use File Status to display all file paths. If the path is incorrect, change it with the File menu's Files option.

- **E0021 Index file not found.**
  The system was not able to locate the database index file, file extension .ndx. This file contains the fixed fields. Check that the file path is correctly set. Use File Status to display all file paths. If the path is incorrect, change it with the File menu's Files option.

- **E0022 Dictionary file not found.**
  Concordance was unable to locate the database dictionary file, file extension .DCT. If the database has been indexed, ensure that the file's path is correct in the File menu's Files option. You will need to index the database to create the dictionary file the first time. Indexing is a File command.

- **E0023 Inverted text file not found.**
  During normal operation Concordance was unable to access the inverted text file, file extension...
.ivt. The system will abandon any operation that required the file. The inverted text file is created during the database indexing process. It is required to search the database or view the database dictionary. If you have not indexed the database, you’ll need to do that to continue. Otherwise, check that the file path is correctly set. Use File/Status to display all file paths. If the path is incorrect, change it with the File menu's Files option.

- **E0024 Error on inverted text file.**
  An error was encountered while accessing the database inverted text file, file extension .ivt. This may indicate a full disk or a damaged file. Try reopening the database. If the error continues you may have to index the database again.

- **E0025 Error on dictionary file.**
  An error was encountered while accessing the database dictionary file, file extension .DCT. This may indicate a full disk or a damaged file. Try reopening the database. If the error continues you may have to index the database again.

- **E0026 Error on text file.**
  An error was encountered while accessing the database text file, file extension .tex. If the error continues, try restoring a backup copy of the database. If that isn’t possible try deleting all of the data from the bad documents and packing the database. If this doesn’t work, mark the bad records for deletion and pack. You’ll need to index the database again. If the path is incorrect, change it with the File menu's Files option.

- **E0027 Error on index file.**
  An error was encountered while accessing the database index file, file extension .ndx. If the error continues, either restore a backup copy of the database or unload all documents prior to the problem document, all documents following, and a copy of the database structure. Then reload the database to the new structure, excluding the problem document. You’ll need to index the database again.

- **E0028 Search overflow.**
  Your search located too many occurrences to fit into available disk space. Narrow the scope of your search or erase unneeded files.

- **E0029 SYNTAX ERROR: Limiter out of order.**
  In Search mode, a search limiter was found out of order. The limiters must follow a word, a mask character, or a right parenthesis. Edit the search and try again.

- **E0030 SYNTAX ERROR: Missing right parenthesis.**
  In Search mode, the number of parentheses entered was unbalanced, with left parentheses outnumbering right parentheses. Edit your search and try again.

- **E0031 SYNTAX ERROR: Missing left parenthesis.**
  In Search mode, the number of parentheses entered was unbalanced, with right parentheses outnumbering left parentheses. Edit your search and try again.

- **E0032 SYNTAX ERROR: Parenthesis out of order.**
  In Search mode a parenthesis was placed in the wrong order. Either a right parenthesis was used to start the query, or a left parenthesis was used to end the query. Edit the query and try again.

- **E0033 SYNTAX ERROR: Operand out of order.**
  In Search mode, you have entered an operand out of order. Edit your search request and try again.
- **E0034 INTERNAL ERROR: Unrecognized query token.**
  This indicates a Concordance internal error, it may result from a corrupted or user-modified database control file, file extension .dcb. Reset the default query operator with the Tools/Preferences/Searching command and try again. This error should not be encountered under normal circumstances.

- **E0035 Search too complex.**
  In Search mode you have entered a query that was too complex for Concordance to evaluate. Concordance is limited to 50 pairs of parentheses in a single search. Restate your query as two or more searches and try again.

- **E0036 This is the last document.**
  You have reached the last document in the current query set.

- **E0037 Dictionary exists, overwrite?**
  You have attempted to index a database that has already been indexed. If you only want to update the search files, use Reindex. Otherwise select Ok to erase the current dictionary files and force a new index.

- **E0039 Zero documents found in search.**
  Your search located zero documents and you tried to use the resulting occurrence list in a command such as Browse or Sort.

- **E0040 No previous queries have been defined.**
  You have attempted to use a mode or command that operates on queries, but no queries exist. You need to issue a search accessing Review mode, or changing queries in Browse.

- **E0041 Database is full.**
  The database contains the maximum number of documents; none can be added.

- **E0042 Help file not found.**
  You asked for help with function key [F1], but Concordance was unable to find the file concordance_[version #].chm in the default directory or in the directory that Concordance was started from. Ensure that the help file is in the default directory and try again.

- **E0043 Error on query file.**
  A temporary file is created during each Concordance session to store your queries. It is placed in the root directory of the default drive or in the SET TEMP= directory. If the disk becomes full, or the query file is somehow corrupted, Concordance will display this message. Reopening the database will generally solve this problem, though all queries up to this point will be lost. If you are on a network, make sure that the default directory on the default drive has read/write permission.

  **E0044 Invalid query reference.**

- **E0045 Unknown or missing formatted field.**
  An error encountered in fixed field searches. The fixed field was either not specified, or was not defined for the current database. Correct the entry and try again. Use the Field list button while searching to bring up a list of available fields.

  **E0046 Select operator not recognized.**

  **E0047 Missing select criteria.**
E0049 **Search mask operator out of order.**
The Search mask operator was found in the wrong place. It can only be placed at the end or beginning of a word; it cannot be used by itself. Edit your search and try again. If you need to search for a word with the mask operator embedded in it, enclose the word in quotes. If you can’t find the mask operator in your search, check the Set Wildcard character. It may have been inadvertently changed.

E0050 **Search limiter missing.**
In Search mode, your query contains only one of a pair of limiter operators. Edit the query to include the opening or closing limiter, and try again. If your search contains a period or a pair of periods that are not limiters, enclose them in quotes. If you are searching for a decimal number, enclose it in quotes. Concordance is mistaking the decimal point for a limiter operator.

E0051 **Unknown limiter paragraph was specified.**
In Search mode, you have specified a limiter paragraph that is not defined in the current database. Only paragraph fields can be specified between the periods. Select the Field list button from the search screen to display a list of available fields.

E0052 **Missing closing quote character.**
In Search mode you entered a query with a quote character, but Concordance was unable to find the matching quote. Edit the query to include two quote characters and enter it again. If your query does not contain the quote character, check the Tools/Preferences/Searching dialog box. It may have been inadvertently changed.

E0053 **Wrong version of database.**
You have tried to open a Concordance database that was created with a different version of Concordance. You will need to upgrade to the newer version to access this file.

E0054 **File is too large.**
During edit mode, you tried to copy a file into a Concordance document. The file was too large for the amount of space left in the document. It cannot be read in.

E0055 **Error opening database.**
An error was encountered opening the database. Perhaps an invalid database was specified, or Concordance ran into a problem reading in the database file. Try to open the database again.

E0056 **Error accessing temporary query file.**
Each query session is stored in a temporary file. Concordance creates this file in the default directory of the default drive, or in the SET TEMP= directory. An error was encountered while creating, reading, or writing this file. This may indicate a full disk or a write-protected disk. The results of the query that caused this error message are not reliable. Check the amount of free space on the default disk drive.

E0057 **Database access is read only.**
The operating system has only allowed Concordance to open the database in read only mode. Any commands that modify the database, such as Edit, Load, or Modify are disallowed.

E0058 **Error opening cut & paste buffer.**

E0059 **Erase dictionary and abort?**
This message is displayed when you have begun packing the database but pressed the [Esc] key before the process has completed. Concordance has already deleted marked documents from the database and is now adjusting the dictionary files. Answering Yes will cancel the remainder of the
Pack, and erase the dictionary files. You will need to index the database to restore them. Pressing any other key will allow Concordance to finish the Pack without erasing the dictionary.

- **E0060 New compression method, can't decompress.**
  The database was stored with a version of Concordance that used a compression method that is not supported by this version. You need to use the other version, or load the unloaded data.

- **E0061 Database is in use by other users.**
  Another network user had the database open and you tried to access a function that needed to obtain exclusive use, such as Modify. Ask the other network users to logoff and try again. This can also happen if you run a network version of Concordance on a standalone machine, or if the DOS share program has not been loaded.

- **E0062 Spell check word list not found.**
  Cannot find the WORDS.LST file. Please make sure that the WORDS.LST file is located in the Concordance installation directory.

- **E0063 Can’t open database spell check list.**
  Concordance is unable to open the WORDS.LST file. It may be corrupt.

- **E0064 Synonym list is cross-linked.**
  Synonym searching has retrieved a related word that looks-up the original word, causing it to retrieve the related word again, causing it to look-up the original word again... This may involve a large convoluted circle of words. Fix it in the source synonym text and rebuild the thesaurus.

- **E0065 Synonym nesting is too deep.**
  Concordance has expanded the synonym, which caused further expansion of the retrieved synonyms. Too many expansions took place. Edit the source synonym text and rebuild the thesaurus.

- **E0066 Incompatible concatenated databases.**
  You have concatenated databases with differing database structures. The operation you attempted, such as Overlay or Unload, requires exact structures. Unconcatenate the databases or modify the structures, then try again.

- **E0067 Too many concatenated databases.**
  Concordance can only join 128 databases in a concatenation.

- **E0068 Key file out of synch! Rebuild?**
  The key file, primarily used to speed fixed field searches, does not contain the same number of entries as the database. This can happen if a user does not exit Edit or Append mode properly, i.e. [Ctrl-Alt-Del] or a power failure. Answer Yes and Concordance will recreate the file. If you answer No, the file is erased.

- **E0069 Can’t rename/erase temporary files.**
  The temporary files created during a database modify or pack could not be erased and/or renamed. This is caused by insufficient network access rights. Ask your network administrator to either give you erase and rename rights to the database directory, or remove Modify, Pack, and Reindex from your menu.

- **E0071 Your field read/write privileges are insufficient for this.**
  Your database administrator has given you security rights that do not allow you to perform the current function.
E0080 The Connection to the FYI Server could not be completed
This is caused by the Incompatibility of older versions of Concordance when trying to open a registered .FYI file created in Concordance version 10.

E0101 Missing /*, or } statement.
The current statement is missing a /*, or } and cannot be resolved.

E0102 A ( or [ is missing from the statement.
The current statement is missing a ( or [ and cannot be resolved.

E0103 A ) or ] is missing from the statement.
The current statement is missing a ) or ] and cannot be resolved.

E0104 Array index out of range.
E0105 Illegal conversion of a variable or array.

E0106 Insufficient memory.
Concordance was unable to continue due to a lack of available memory. Install more memory and try again.

E0107 Syntax error.
E0108 Assignment to NULL pointer.

E0109 Unknown field.
The field information you have specified is incorrect or does not exist.

E0110 Need a left-side-value, can't make the assignment.
E0111 Stack underflow.
E0112 Stack overflow.
E0113 Insufficient memory for another function.
E0114 Insufficient memory for another variable.
E0115 Initialization error.
E0116 Wrong number of arguments for this function.

E0117 A { is missing from the statement.
The current statement is missing a { and cannot be resolved.

E0118 Illegal assignment with an unsubscripted array.
E0119 A colon is missing from the case/conditional statement.
E0120 Floating point error.
E0121 Unknown function or variable, declare it before using it.

E0122 A semicolon is missing.

E0123 Wrong number of parameters in function call.

E0124 Program stopped.

E0125 Missing */ to end the commented section.

- **E0126 Database isn't open.**
  You must have a database open to perform the current function.

E0127 Carriage return in quoted string, end quote is missing.

E0129 Found an operand without a preceding operator, semicolon may be missing.

E0130 Found two operands without an operator between them.

- **E0131 Missing the closing quote in a quoted string.**
  In Search mode you entered a query with a quote character, but Concordance was unable to find the matching quote. Edit the query to include two quote characters and enter it again. If your query does not contain the quote character, check the Tools/Preferences/Searching dialog box. It may have been inadvertently changed.

E0132 A matching } is missing from the { statement.

E0133 You can only concatenate string values.

E0134 Division by zero.

E0135 Mod by zero.

- **E0136 Wrong version of program.**
  You have the wrong version of the application to run the current function.

E0137 Function requires a different parameter type.

E0138 run() can't find the function to execute.

E0139 run() can't find the program file to load.

- **Concordance Messages in Alphabetical Order**

- **A**

  - **A { is missing from the statement**
    The current statement is missing a { and cannot be resolved.

  - **A ( or [ is missing from the statement**
    The current statement is missing a ( or [ and cannot be resolved.
A ) or ] is missing from the statement
The current statement is missing a ) or ] and cannot be resolved.

A paragraph field must be selected
This error is encountered when using the Documents Import command. It indicates that a free
text paragraph field was not selected as the first field with the Fields menu option. Select a
paragraph field as field number one and try again.

Can’t open database spell check list
Concordance is unable to open the WORDS.LST file. It may be corrupt.

Can’t rename/erase temporary files
The temporary files created during a database modify or pack could not be erased and/or
renamed. This is caused by insufficient network access rights. Ask your network administrator
to either give you erase and rename rights to the database directory, or remove Modify, Pack,
and Reindex from your menu.

Database already exists
You have specified a database name in Database New that already exists. Enter another name,
erase the existing database, or use Database Modify if the document count is zero.

Database access is read only
The operating system has only allowed Concordance to open the database in read only mode.
Any commands that modify the database, such as Edit, Load, or Modify are disallowed.

Database is full
The database contains the maximum number of documents; none can be added.

Database isn’t open
You must have a database open to perform the current function.

Database is in use by other users
Another network user had the database open and you tried to access a function that needed to
obtain exclusive use, such as Modify. Ask the other network users to logoff and try again. This
can also happen if you run a network version of Concordance on a standalone machine, or if the
DOS share program has not been loaded.

Database not found
Concordance was unable to find the database you specified. Concordance automatically adds
the file extension .dcb to the name you supplied the Database Open command. No matching
file was found.

Dictionary exists, overwrite?
You have attempted to index a database that has already been indexed. If you only want to
update the search files, use Reindex. Otherwise select Ok to erase the current dictionary files
and force a new index.
Dictionary file not found
Concordance was unable to locate the database dictionary file, file extension .DCT. If the database has been indexed, ensure that the file's path is correct in the File menu's Files option. You will need to index the database to create the dictionary file the first time. Indexing is a File command.

Disk full
The diskette or fixed disk is full. Split the database between fixed disk drives and notify Concordance with the File menu’s Files or Concatenation commands if necessary. You might try erasing or archiving old files.

Duplicate field name
In Database New or Modify, you have entered a field name that was previously entered. Change the name and continue.

Erase dictionary and abort?
This message is displayed when you have begun packing the database but pressed the [Esc] key before the process has completed. Concordance has already deleted marked documents from the database and is now adjusting the dictionary files. Answering Yes will cancel the remainder of the Pack, and erase the dictionary files. You will need to Index the database to restore them. Pressing any other key will allow Concordance to finish the Pack without erasing the dictionary.

Error accessing temporary query file
Each query session is stored in a temporary file. Concordance creates this file in the default directory of the default drive, or in the SET TEMP= directory. An error was encountered while creating, reading, or writing this file. This may indicate a full disk or a write-protected disk. The results of the query that caused this error message are not reliable. Check the amount of free space on the default disk drive.

Error creating file
Concordance encountered an error creating a file. Check that the specified file name is a valid name. Try again.

Error on dictionary file
An error was encountered while accessing the database dictionary file, file extension .DCT. This may indicate a full disk or a damaged file. Try reopening the database. If the error continues you may have to index the database again.

Error on index file
An error was encountered while accessing the database index file, file extension .ndx. If the error continues, either restore a backup copy of the database or unload all documents prior to the problem document, all documents following, and a copy of the database structure. Then reload the database to the new structure, excluding the problem document. You'll need to index the database again.

Error on inverted text file
An error was encountered while accessing the database inverted text file, file extension .ivt. This may indicate a full disk or a damaged file. Try reopening the database. If the error continues you may have to index the database again.
Error on query file
A temporary file is created during each Concordance session to store your queries. It is placed in the root directory of the default drive or in the SET TEMP= directory. If the disk becomes full, or the query file is somehow corrupted, Concordance will display this message. Reopening the database will generally solve this problem, though all queries up to this point will be lost. If you are on a network, make sure that the default directory on the default drive has read/write permission.

Error on text file
An error was encountered while accessing the database text file, file extension .tex. If the error continues, try restoring a backup copy of the database. If that isn't possible try deleting all of the data from the bad documents and packing the database. If this doesn't work, mark the bad records for deletion and pack. You'll need to index the database again. If the path is incorrect, change it with the File menu's Files option.

Error opening database
An error was encountered opening the database. Perhaps an invalid database was specified, or Concordance ran into a problem reading in the database file. Try to open the database again.

Error retrieving report
You entered the name of a report to retrieve, but Concordance could not read it. Try loading the report again. If this message is repeated, the report is probably damaged and should be recreated from scratch.

Error saving report
You entered the name of a report to save, but Concordance could not save it. The disk may be full, write protected, or the directory could be read-only.

File is too large
During edit mode, you tried to copy a file into a Concordance document. The file was too large for the amount of space left in the document. It cannot be read in.

Help file not found
You asked for help with function key [F1], but Concordance was unable to find the file concordance_[version #].chm in the default directory or in the directory that Concordance was started from. Ensure that the help file is in the default directory and try again.

Incompatible concatenated databases
You have concatenated databases with differing database structures. The operation you attempted, such as Overlay or Unload, requires exact structures. Unconcatenate the databases or modify the structures, then try again.

Index file not found
The system was not able to locate the database index file, file extension .ndx. This file contains
the fixed fields. Check that the file path is correctly set. Use File Status to display all file paths. If the path is incorrect, change it with the File menu's Files option.

- **Insufficient memory**
  Concordance was unable to continue due to a lack of available memory. Install more memory and try again.

- **INTERNAL ERROR: Unrecognized query token**
  This indicates a Concordance internal error, it may result from a corrupted or user-modified database control file, file extension .dcb. Reset the default query operator with the Tools/Preferences/Searching command and try again. This error should not be encountered under normal circumstances.

- **Invalid character in field name**
  An error encountered in File/New or Modify. You have entered a field name with a space or other invalid character in it. Only alphanumeric and underline characters can be used for field names.

- **Inverted text file not found**
  During normal operation Concordance was unable to access the inverted text file, file extension .ivt. The system will abandon any operation that required the file. The inverted text file is created during the database indexing process. It is required to search the database or view the database dictionary. If you have not indexed the database, you'll need to do that to continue. Otherwise, check that the file path is correctly set. Use File/Status to display all file paths. If the path is incorrect, change it with the File menu's Files option.

- **Key file out of synch! Rebuild?**
  The key file, primarily used to speed fixed field searches, does not contain the same number of entries as the database. This can happen if a user does not exit Edit or Append mode properly, i.e. [Ctrl-Alt-Del] or a power failure. Answer Yes and Concordance will recreate the file. If you answer No, the file is erased.

- **Missing closing quote character**
  In Search mode you entered a query with a quote character, but Concordance was unable to find the matching quote. Edit the query to include two quote characters and enter it again. If your query does not contain the quote character, check the Tools/Preferences/Searching dialog box. It may have been inadvertently changed.

- **Missing /*, or } statement**
  The current statement is missing a /*, or } and cannot be resolved.

- **Must open database first**
  You have attempted to manipulate a database without first opening one. Use File Open to open the database, then try again.
- **New compression method, can't decompress**
  The database was stored with a version of Concordance that used a compression method that is not supported by this version. You need to use the other version, or load the unloaded data.

- **No previous document**
  This is the first document in the current query set.

- **No previous queries have been defined**
  You have attempted to use a mode or command that operates on queries, but no queries exist. You need to issue a search accessing Review mode, or changing queries in Browse.

- **Search limiter missing**
  In Search mode, your query contains only one of a pair of limiter operators. Edit the query to include the opening or closing limiter, and try again. If your search contains a period or a pair of periods that are not limiters, enclose them in quotes. If you are searching for a decimal number, enclose it in quotes. Concordance is mistaking the decimal point for a limiter operator.

- **Search mask operator out of order**
  The Search mask operator was found in the wrong place. It can only be placed at the end or beginning of a word; it cannot be used by itself. Edit your search and try again. If you need to search for a word with the mask operator embedded in it, enclose the word in quotes. If you can’t find the mask operator in your search, check the Set Wildcard character. It may have been inadvertently changed.

- **Search overflow**
  Your search located too many occurrences to fit into available disk space. Narrow the scope of your search or erase unneeded files.

- **Search too complex**
  In Search mode you have entered a query that was too complex for Concordance to evaluate. Concordance is limited to 50 pairs of parentheses in a single search. Restate your query as two or more searches and try again.

- **Spell check word list not found**
  Cannot find the WORDS.LST file. Please make sure that the WORDS.LST file is located in the Concordance installation directory.

- **Synonym list is cross-linked**
  Synonym searching has retrieved a related word that looks-up the original word, causing it to retrieve the related word again, causing it to look-up the original word again... This may involve a large convoluted circle of words. Fix it in the source synonym text and rebuild the thesaurus.

- **Synonym nesting is too deep**
  Concordance has expanded the synonym, which caused further expansion of the retrieved synonyms. Too many expansions took place. Edit the source synonym text and rebuild the thesaurus.

- **SYNTAX ERROR: Limiter out of order**
  In Search mode, a search limiter was found out of order. The limiters must follow a word, a
mask character, or a right parenthesis. Edit the search and try again.

- **SYNTAX ERROR: Missing left parenthesis**
  In Search mode, the number of parentheses entered was unbalanced, with right parentheses outnumbering left parentheses. Edit your search and try again.

- **SYNTAX ERROR: Missing right parenthesis**
  In Search mode, the number of parentheses entered was unbalanced, with left parentheses outnumbering right parentheses. Edit your search and try again.

- **SYNTAX ERROR: Operand out of order**
  In Search mode, you have entered an operand out of order. Edit your search request and try again.

- **SYNTAX ERROR: Parenthesis out of order**
  In Search mode a parenthesis was placed in the wrong order. Either a right parenthesis was used to start the query, or a left parenthesis was used to end the query. Edit the query and try again.

- **System fields improper field rights**
  Performing the drag-and-drop operation for a database that contains a system field produces a warning that the field does not have the proper field right settings for the action to be performed. To fix this issue, do the following:
  1. From the File menu, click Modify.
  2. Locate and select the system field, clear the System check box, and then click OK.
  3. Perform the drag-and-drop operation for the files you want to add.
  4. When finished, from the File menu, click Modify.
  5. Locate and select the System field, click the System check box, and then click OK.

- **T**

- **Text file not found**
  The system was not able to locate the database text file, file extension .tex. This file contains the text of the database, the contents of the paragraph fields. Check that the file path is correctly set. Use File Status to display all file paths. If the path is incorrect, change it with the File menu’s Files option.

- **This is the last document**
  You have reached the last document in the current query set.

- **Too many concatenated databases**
  Concordance can only join 128 databases in a concatenation.
- **Unknown field**
  The field information you have specified is incorrect or does not exist.

- **Unknown limiter paragraph was specified**
  In Search mode, you have specified a limiter paragraph that is not defined in the current database. Only paragraph fields can be specified between the periods. Select the Field list button from the search screen to display a list of available fields.

- **Unknown or missing formatted field**
  An error encountered in fixed field searches. The fixed field was either not specified, or was not defined for the current database. Correct the entry and try again. Use the Field list button while searching to bring up a list of available fields.

- **Use MMDDYY, YYMMDD, or DDMMYY for dates**
  Date formats are month-day-year, year-month-day, and day-month-year. Enter them in New or Modify mode by typing the first letter of the type: M, Y, or D respectively.

- **Use Text, Numeric, Date, or Paragraph**
  In Database New or Modify, you have specified a field type that does not exist. Valid entries are Date, Text, Numeric, or Paragraph. Correct the entry and try again.

- **W**

  - **Wrong version of database**
    You have tried to open a Concordance database that was created with a different version of Concordance. You will need to upgrade to the newer version to access this file.

  - **Wrong version of program**
    You have the wrong version of the application to run the current function.

- **Y**

  - **You must select at least one field**
    You have attempted to use fields in a command, but no fields were selected for use. Use the Fields option to select a field, then try the operation again.

  - **Your field read/write privileges are insufficient for this**
    Your database administrator has given you security rights that do not allow you to perform the current function.

- **Z**

  - **Zero documents found in search**
    Your search located zero documents and you tried to use the resulting occurrence list in a command such as Browse or Sort.
**Keyboard shortcuts**

Use the following keyboard shortcuts to perform Concordance and Concordance Image functions from a specific view or task pane. The behavior of the keyboard shortcuts depends on the view or task pane selected. Make sure that the view or task pane you want to work with is selected before using the keyboard shortcuts.

- **Concordance**

- **Browse and Table View**

<table>
<thead>
<tr>
<th>Keyboard Shortcuts: Browse and Table Views</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shortcut Keys</strong></td>
</tr>
<tr>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
</tr>
<tr>
<td>F3</td>
</tr>
<tr>
<td>F4</td>
</tr>
<tr>
<td>F5</td>
</tr>
<tr>
<td>F6</td>
</tr>
<tr>
<td>F8</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>+</td>
</tr>
<tr>
<td>C</td>
</tr>
<tr>
<td>D</td>
</tr>
<tr>
<td>F</td>
</tr>
<tr>
<td>G</td>
</tr>
<tr>
<td>L</td>
</tr>
<tr>
<td>N</td>
</tr>
<tr>
<td>O</td>
</tr>
</tbody>
</table>
## Keyboard Shortcuts: Browse and Table Views

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>P</td>
<td>Navigate to the previous search hit.</td>
</tr>
<tr>
<td>V</td>
<td>Open the current document's corresponding image file in the image viewer.</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>Open the New Database Creation Wizard for creating new databases using load files, E-documents and E-mails.</td>
</tr>
<tr>
<td>CTRL+T</td>
<td>Open the database templates for creating a new database using a template.</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Open the Dictionary dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Open the Fields dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>CTRL+S</td>
<td>Open the Fuzzy Search dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
</tbody>
</table>

### Tags Task Pane

## Keyboard Shortcuts: Tags Task Pane

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPACEBAR</td>
<td>Toggle selected tag.</td>
</tr>
<tr>
<td>C</td>
<td>Open the Copy dialog box to copy document data. (Browse View only)</td>
</tr>
<tr>
<td>D</td>
<td>Open the Goto dialog box to navigate to a specific document.</td>
</tr>
<tr>
<td>F</td>
<td>Navigate to the first document.</td>
</tr>
<tr>
<td>G</td>
<td>Open the Goto dialog box to navigate to a specific document.</td>
</tr>
<tr>
<td>L</td>
<td>Navigate to the last document.</td>
</tr>
<tr>
<td>N</td>
<td>Navigate to the next search hit.</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts: Tags Task Pane

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>Open the Font dialog box to view or modify the font.</td>
</tr>
<tr>
<td>P</td>
<td>Navigate to the previous search hit.</td>
</tr>
<tr>
<td>other letter keys</td>
<td>Navigate to the tag starting with the same letter.</td>
</tr>
</tbody>
</table>

Review View

Keyboard Shortcuts: Review View

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Open Search task pane.</td>
</tr>
<tr>
<td>F3</td>
<td>Open the Review View if it is not already opened.</td>
</tr>
<tr>
<td>F4</td>
<td>Open the Query by Example dialog box to run a form search.</td>
</tr>
<tr>
<td>ENTER</td>
<td>Execute the selected search query.</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Open the Dictionary dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Open the Fields dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>CTRL+S</td>
<td>Open the Fuzzy Search dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancel the current search that is in progress.</td>
</tr>
</tbody>
</table>

Edit View
<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+PAGE UP</td>
<td>Navigate to the previous document.</td>
</tr>
<tr>
<td>CTRL+PAGE DOWN</td>
<td>Navigate to the next document.</td>
</tr>
<tr>
<td>TAB</td>
<td>Navigate to the next field in the document.</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Navigate to the previous field in the document.</td>
</tr>
<tr>
<td>CTRL+TAB</td>
<td>Navigate to the last database or Workspace tab you opened.</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copy the selected text.</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Open the Duplicate dialog box to copy field data to another record.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Open the Find dialog box to find text in the current field.</td>
</tr>
<tr>
<td></td>
<td>Open the Fields dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>CTRL+SHIFT+F</td>
<td>Find the next instance of the text entered in the Find dialog box.</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Open the Replace dialog box to find and replace text in the current field.</td>
</tr>
<tr>
<td>CTRL+L</td>
<td>Open the authority list associated with the current field.</td>
</tr>
<tr>
<td></td>
<td>For fields not associated with an authority list, navigate to and open a saved authority list.</td>
</tr>
<tr>
<td>CTRL+S</td>
<td>Open the Fuzzy Search dialog box when your cursor is in the Advanced Search panel.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste the copied or cut text.</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut the selected text.</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Undo the last action</td>
</tr>
</tbody>
</table>

**Concordance Native Viewer**
### Keyboard Shortcuts: Concordance Native Viewer

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + C</td>
<td>Copy the current selection</td>
</tr>
<tr>
<td>CTRL + X</td>
<td>Cut the current selection</td>
</tr>
<tr>
<td>CTRL + V</td>
<td>Paste the copied selection</td>
</tr>
<tr>
<td>CTRL + SHIFT + A</td>
<td>Pan tool</td>
</tr>
<tr>
<td>CTRL + SHIFT + X</td>
<td>Zoom tool</td>
</tr>
<tr>
<td>CTRL + SHIFT + Z</td>
<td>Magnifier tool</td>
</tr>
<tr>
<td>CTRL + E</td>
<td>Fit to Height</td>
</tr>
<tr>
<td>CTRL + W</td>
<td>Fit to Width</td>
</tr>
<tr>
<td>CTRL + SPACEBAR</td>
<td>Rotate clockwise 90 degrees</td>
</tr>
<tr>
<td>CTRL + SHIFT + SPACEBAR</td>
<td>Rotate counter-clockwise 90 degrees</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>Navigate to the previous page</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>Navigate to the next page</td>
</tr>
<tr>
<td>CTRL + P</td>
<td>Open Print dialog box</td>
</tr>
</tbody>
</table>

### Keyboard Shortcuts: Concordance Image

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + O</td>
<td>Opens the Open dialog box to open an image in the viewer.</td>
</tr>
<tr>
<td>CTRL + B</td>
<td>Turn on or off the Toggle Bar Code Mode function.</td>
</tr>
<tr>
<td>CTRL + R</td>
<td>Toggle the display of the redlines on the image.</td>
</tr>
<tr>
<td>CTRL + P</td>
<td>Open the Print dialog box to print the images.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts: Concordance Image

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+C</td>
<td>Copy the current selection on the image.</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut the current selection on the image.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste the cut or copied selection.</td>
</tr>
<tr>
<td>I</td>
<td>Invert image color. (only works with black and white images)</td>
</tr>
<tr>
<td>CTRL+</td>
<td>Zoom in a little.</td>
</tr>
<tr>
<td>CTRL-</td>
<td>Zoom out a little.</td>
</tr>
<tr>
<td>+</td>
<td>Zoom in 50%.</td>
</tr>
<tr>
<td>-</td>
<td>Zoom out 50%.</td>
</tr>
<tr>
<td>ALT+Z</td>
<td>Zoom on selection.</td>
</tr>
<tr>
<td>W</td>
<td>Fit image to width.</td>
</tr>
<tr>
<td>H</td>
<td>Fit image to height.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Display the full screen.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Rotate left from the original orientation.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Rotate right from the original orientation.</td>
</tr>
<tr>
<td>/</td>
<td>Flip from the original orientation.</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Rotate left from the current orientation.</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Rotate right from the current orientation.</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>Flip from the current orientation.</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>Navigate to the first page.</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>Navigate to the next page.</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>Navigate to the previous page.</td>
</tr>
<tr>
<td>CTRL+END</td>
<td>Navigate to the last page.</td>
</tr>
<tr>
<td>G</td>
<td>Open the Go to page dialog box to navigate to a specific page.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts: Concordance Image

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+G</td>
<td>Open the Go to image key dialog box to navigate to a specific image.</td>
</tr>
<tr>
<td>CTRL+PAGE DOWN</td>
<td>Navigate to the next document.</td>
</tr>
<tr>
<td>CTRL+PAGE UP</td>
<td>Navigate to the previous document.</td>
</tr>
</tbody>
</table>

### FYI Reviewer

#### General

### Keyboard Shortcuts: General FYI Reviewer

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+O</td>
<td>Open the Font dialog box to view or modify the font.</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>Open the Microsoft Internet Explorer Organize Favorites dialog box.</td>
</tr>
<tr>
<td>CTRL+R</td>
<td>Return to the FYI Reviewer login page.</td>
</tr>
<tr>
<td>CTRL+P</td>
<td>Open the Print dialog.</td>
</tr>
<tr>
<td>CTRL+H</td>
<td>Open the Microsoft Internet Explorer History tab.</td>
</tr>
<tr>
<td>I</td>
<td>Invert image color.</td>
</tr>
<tr>
<td>+</td>
<td>Zoom image in 50%.</td>
</tr>
<tr>
<td>-</td>
<td>Zoom image out 50%.</td>
</tr>
<tr>
<td>W</td>
<td>Fit image to width.</td>
</tr>
<tr>
<td>H</td>
<td>Fit image to height.</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Rotate image left from the current orientation.</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Rotate image right from the current orientation.</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>Navigate to first page.</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts: General FYI Reviewer

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+END</td>
<td>Navigate to last page.</td>
</tr>
<tr>
<td>G</td>
<td>Open the Go to dialog box to navigate to a specific page.</td>
</tr>
<tr>
<td>CTRL+PAGE DOWN</td>
<td>Navigate to next document.</td>
</tr>
<tr>
<td>CTRL+PAGE UP</td>
<td>Navigate to previous document.</td>
</tr>
</tbody>
</table>

### Search View

#### Keyboard Shortcuts: Search View

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Open Search task pane.</td>
</tr>
<tr>
<td>F3</td>
<td>Open the Review View if it is not already opened.</td>
</tr>
<tr>
<td>F4</td>
<td>Open the Query by Example dialog box to run a form search.</td>
</tr>
<tr>
<td>ENTER</td>
<td>Execute the selected search query.</td>
</tr>
</tbody>
</table>

### Browse and Table View

#### Keyboard Shortcuts: Browse and Table Views

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5</td>
<td>Open or close the Table View in the Browse View.</td>
</tr>
<tr>
<td>F6</td>
<td>Open or close the Browse View in the Table View.</td>
</tr>
<tr>
<td>F</td>
<td>Navigate to the first document.</td>
</tr>
<tr>
<td>-</td>
<td>Navigate to the previous document.</td>
</tr>
</tbody>
</table>
## Keyboard Shortcuts: Browse and Table Views

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Navigate to the next document.</td>
</tr>
<tr>
<td>L</td>
<td>Navigate to the last document.</td>
</tr>
<tr>
<td>G</td>
<td>Open the Go to dialog box to navigate to a specific page.</td>
</tr>
<tr>
<td>P</td>
<td>Navigate to previous hit.</td>
</tr>
<tr>
<td>N</td>
<td>Navigate to next hit.</td>
</tr>
<tr>
<td>V</td>
<td>Open and close the image associated with the current document.</td>
</tr>
<tr>
<td>C</td>
<td>Open the Copy dialog box for copying field data. (Browse View only)</td>
</tr>
<tr>
<td>O</td>
<td>Open the Font dialog box to view or modify the font.</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>Navigate to the next document. (Table View only)</td>
</tr>
</tbody>
</table>

## Keyboard Shortcuts: Edit View

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+PAGE UP</td>
<td>Navigate to the previous document.</td>
</tr>
<tr>
<td>CTRL+PAGE DOWN</td>
<td>Navigate to the next document.</td>
</tr>
<tr>
<td>TAB</td>
<td>Navigate to the next field.</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Navigate to the previous field.</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copy the selected text.</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Open the Duplicate dialog box to copy field data to another record.</td>
</tr>
<tr>
<td>CTRL+F</td>
<td>Open the Find dialog box to find text in the current field.</td>
</tr>
</tbody>
</table>
# Keyboard Shortcuts: Edit View

<table>
<thead>
<tr>
<th>Shortcut Keys</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+H</td>
<td>Open the Replace dialog box to find and replace text in the current field.</td>
</tr>
<tr>
<td>CTRL+L</td>
<td>Open the Open dialog box to locate an authority list (.LST) file.</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste the copied or cut text.</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut the selected text.</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Undo the last action.</td>
</tr>
</tbody>
</table>
Glossary

- **A - E (ActiveX - Exploded Sort Report)**

- **ActiveX**
  FYI Reviewer is an ActiveX plug-in designed for Microsoft Internet Explorer which provides Web access to Concordance databases.

- **Bates Numbering**
  Documents in litigation collections are assigned a unique sequential number on each page of every document. These numbers are referred to as Bates numbers (named after the Bates automatic numbering machine) and are used to identify a document or page. In Concordance, these numbers are often referred to as BEGNO (beginning number) and ENDNO (ending number).

- **Boolean operator**
  Use Boolean operators such as AND, NOT, OR, and XOR to include or exclude documents by comparing them against conditions. A search for milk OR coffee locates all documents that either contain the word “milk” or “coffee”.

- **Browse View**
  A Concordance screen used to view the current database record in the current query, or the first document in the database if there is no query.

- **Client**
  An FYI Admin Console menu tree designation on the Management tab, depicted by a folder icon. Client folders are not required but can be used to organize data by a client, case name, or topic. Matters are then added to these client folders.

- **Concatenation**
  Combining one or more databases together so that they can be searched as one single database.

  If you are using FYI, all databases that are concatenated through a .cat file must be registered in the FYI Admin Console. Concatenation in FYI Reviewer is achieved through checking multiple databases in the list then clicking the Open button.

- **Concordance Native Viewer (CNV)**
  Near-native document viewer for use with Concordance.

- **Concordance Programming Language (CPL)**
A proprietary programming language used to open, query, and modify databases for Concordance.

- **Context Operator**

  Context operators SAME, NOTSAME, and field limiters are used to locate records that include or exclude combinations of keywords within a specific paragraph field.

- **Database**

  An organized body of related information.

- **Delimited file**

  A digital file that has a text qualifier, a delimiter, and a line separator to structure data uniformly.

- **Deponent**

  A person who testifies under oath, especially in writing.

- **Deposition**

  The memorialized minutes of an interview between a member of the legal profession and a litigant or witness.

- **Dictionary**

  A file created when a database is indexed, which facilitates searches. A database dictionary file contains a list of all words, other than stopwords, that are found in a database. Each word in the dictionary displays with the total number of occurrences and the number of documents it appears in.

- **Document**

  In Concordance, a document record is a record associated with a logical combination of pages. With paper, this term refers to collections of pages. With electronic files, this term refers to a digital file.

- **Edit View**

  A screen in Concordance that's used to edit the contents of a the current database record, or to enter a new record into the document collection. Records viewed in Edit mode are retrieved from the last or current query.

- **Electronic Data Discovery (EDD) or E-Discovery**

  The process of collecting electronic files.
Exploded Sort Report

A report where each entry in a multiple entry field is sorted in alphabetical order and given its own line in the report as if it were a separate record.

F - J (Field Limiter - Issue)

Field Limiter

Field limiters are used to include or exclude field names, and are considered to be context operators. The use of a single period between the search term and the field name includes a field. The use of two periods between the search term and the field name excludes a field.

Fuzzy words

Words that are like homonyms, that look like and sound like a word contained in the database dictionary. This list is unique to each database and is built during indexing.

FYI Admin Console

Allows an administrator to publish databases, restrict access and change security settings, set performance parameters, and generate usage reports for FYI.

FYI Administration Console Server

Works with the FYI Admin Console to control FYI Server.

FYI Server

Sends data to Concordance and Concordance Image or Opticon clients.

Hard Kill

If you are administrating FYI and need to end a user session, a hard kill immediately disconnects users from FYI Reviewer and does not guarantee that files will be closed or session data saved, therefore users risk losing data. Some files may be left open creating file access contention problems. It is best practice to run a soft kill before running a hard kill.

Hits

Keywords used to locate document records, returning the count of words hits located in the active query. Hits are highlighted in red (default color) in records displaying in Browse View.

Imagebase
Just as a collection of Concordance files defines a database, scanned image files are stored together to form an imagebase, which includes the names and locations of the image files.

- **Image key**

  A field attribute. Fields in Concordance are coded to link with files in Concordance Image, providing lookup information about where the associated image is located.

- **Image viewer**

  Concordance Image is a tool used to view images associated with a document record. Image files are stored in a separate imagebase (database).

- **Index**

  When used as a verb, *to index a database*, this term refers to the process in which Concordance builds files that integrate with the program and that facilitate searches. When used as a noun, *the database’s index*, it refers to the files that are created. It’s also a field attribute. Fields that are designated as indexed fields have their contents scanned and added to the files that Concordance creates to facilitate searches.

- **Issue**

  A tag that’s used to categorize a section of text within a document.

- **K - O (Key - Orphan)**

- **Key**

  A field attribute. Key fields have their contents scanned and added to special key files that integrate with Concordance and that facilitate searches on the field.

- **Keywords in Context (KWIC)**

  A custom report option that makes otherwise lengthy reports more manageable and concise by displaying just those sections of indexed fields that contain selected keywords, used especially for transcripts and depositions.

- **Matter**

  An FYI Admin Console menu tree designation on the Management tab, depicted by a briefcase icon. Matters are used to organize databases by case or topic. Databases for FYI Reviewer must be associated with a matter in order for them to be viewable online in FYI Reviewer.

- **Masking**
The use of a wildcard character to locate patterns of keywords.

- **Media key**
  
  A field attribute. Fields in Concordance are coded to link with files in Concordance Native Viewer, providing lookup information about where the associated document or image is located.

- **Metadata**
  
  Properties associated with a document that might or might not be contained within the body of the document, including the author, the creation date, and last modified date. Concordance also captures formatting metadata for font changes, bolding, underlining, and highlighting.

- **Multi-page TIFF**
  
  A specific type of Tagged Image File Format (TIFF) image file in which many pages are combined into a single .tif file.

- **Native application**
  
  The software used to activate, run, or otherwise view a digital file.

- **Non-persistent tag**
  
  A tag that’s deleted unless it’s applied to at least one database record, or at least one section of text in Browse View.

- **Notes**
  
  Subjective comments created by a reviewer and assigned to a selection of text within a document.

- **Operator**
  
  A reserved word or symbol that Concordance interprets to be part of search query syntax.

- **Optical Character Recognition (OCR)**
  
  An electronic process where the text in paper documents or digital files is extracted and prepared for eventual loading into a full-text information retrieval system.

- **Orphan**
  
  One sentence or line of text from a previous paragraph that prints at the top of page due to document page breaks and setup options. Selecting print settings for widow/orphan
controls indicates how many lines are printed when a paragraph or text content overlaps a page break in a document. Typically a minimum of two lines of text should be continued after a page break to keep paragraph or text content within context. See also: Widows.

P - T (Pack - Transcript)

Pack

The act of removing records or redlines from a database that have been marked for deletion. Packing a dictionary file removes references to textual units identified by indexing or reindexing that are no longer in the database, while optimizing the file structure for faster searches and reindexes.

Persistent Tag

A tag that exists between sessions, even if it hasn’t been applied to any database record, or any section of text in Browse View.

Production

A process where you “produce” a copy of your images based on a current Concordance query, which can be renamed and renumbered to fit your needs. Productions are often run for internal case review and to provide opposing counsel with records in preparation for trial.

Proximity Operator

The proximity operators ADJ and NEAR are used to locate words within a specified distance from each other in the same field. These operators can use optional numerical arguments. The search Apples ADJ25 Oranges locates documents where “oranges” appears within 25 words of “apples”.

Q & A pair

Used in transcript or deposition, a coupling of a question posed to an individual, and his or her reply.

Query

A request for information from a database using parameters, field values, and language.

Records

Individual objects in a full-text information retrieval system, which are primarily documents within a Concordance database.

Redaction
A blocked section of text intended to prevent others from viewing sensitive information in a document.

- **Redlines**

  Subjective text, notes, or symbols placed on a graphical image by a reviewer, which represent subjective information about the image.

- **Reindex**

  A procedure that’s functionally similar to indexing. Reindexing updates the files created during a database’s initial indexing, and is required when data changes in a database through reviewer input, or when database records are added, imported or updated.

- **Relational operator**

  Relational operators, such as less than (LT) and greater than (GT), can be used to test data against specific values.

- **Replication**

  A process that copies a Concordance database, creating a replica that contains any changes (edits, deletions, additions, tagging). Replica databases can be published to any network site. Only changes are replicated. Concordance synchronizes replica database changes from mobile connections or third-party vendor databases with a primary database. Only fields that have changes are updated with local edits, and managed on a field-by-field basis.

- **Scanning**

  An automated process that converts paper or electronic documents into a Concordance-ready format.

- **Single-page TIFF**

  A specific type of Tagged Image File Format (TIFF) image file in which many individual pages are separated into individual files. For example, a 40-page document could be represented as 40 individual .tif files.

- **Snapshot**

  A snapshot is a point-in-time image of your query session, providing a static picture of a database that includes all concatenated databases, all searches, the current record, and the current sort in effect.

- **Soft Kill**

  If you are administrating FYI and need to end a user session, a soft kill sends a message to the server requesting it to close all files, save data, and end the user’s session.
However, it does not save data currently being edited by the client. It is best practice to run a soft kill before running a hard kill.

- **Spoliate**

  To damage or ruin the original native document files by covering or cutting content.

- **Stopwords**

  Words that are so common that they are of no value in the intent of a search, such as *and*, *for*, and *the*. The more stopwords included in a list increases the indexing process and speeds data retrieval.

- **Synchronization**

  In Concordance, synchronization is a process that copies any changes between replicated databases, with changes managed on a field-by-field basis. Concordance has options for a read-only publishing, a review scenario, or full replication and synchronization.

  In the FYI Admin Console, synchronization contacts all registered databases and updates any user changes made in Concordance security.

- **Table View**

  A screen in Concordance that’s used to view several database records in a tabular format, similar to a spreadsheet, displaying one line per record.

- **Tag**

  A descriptive marker in Concordance that can be used to categorize a document or a section of text within a document (issues) in Browse or Table Views.

- **Tally**

  A method of counting the number of unique values that appear in a field across all records in a query, while tabulating document and data classifications.

- **Template**

  A preformed database shell that can be used to build a database quickly. Templates contain no records, but have predefined field names, and other field attributes.

- **Transcript**

  The memorialized minutes of a legal proceeding.

- **U - Z (Vendor - Zero Query)**
Vendor

A third-party corporate entity that specializes in processing and converting paper and electronic documents into a Concordance-ready format.

Widow

One sentence or line of text that starts a paragraph at the bottom of a document page with the remaining text printing at the top the next page due to page breaks and document setup options. Selecting print settings for widow/orphan controls indicates how many lines are printed when a paragraph or text content overlaps a page break in a document. Typically a minimum of two lines of text should be included before a page break to keep paragraph or text content within context. See also: Orphans.

Wildcard character

One of two characters used in pattern matching. The ? character is used to mask single characters. The search WOM?N locates Women and Woman. The * character is used to mask the remainder of a word. The search MIL* locates any word where the first three letters are MIL.

Zap

An action that deletes all records from the current database, erasing all associated database files except for the stopword file. All search files are erased, adding free space to the system. Only the primary database is zapped when databases are concatenated.

Zero Query

A special search number that is predefined to include all records in the database, and resorts them in their original load order.
Index

- A -
annotating
  CNV markup toolbar 231
  editing CNV markups 262
  media files 250
Annotation Report Writer 166, 198
annotations, printing 166, 198
applying markups 250
  images and stamps 255
  redactions 259
applying redlines 283
attachments
  adding to transcripts 162
Auto-restore snapshots 225

- B -
backups
  about database backups 227
  bar code mode in Concordance Image 275
Browse view
  modifying fonts 50
  printing selected text 180
  viewing records 48
bulk printing, CNV 207

- C -
CaseMap, exporting to 188
concatenating
  databases 172
  deleting concatenated sets 177
  indexing and reindexing databases 174
  opening concatenated sets 176
  printing concatenated databases 175
  saving concatenated sets 175
  saving searches 174
concatenation
  about for reviewers 171
Concordance
  about 8
  bulk printing 207
  exporting data 188
  logging on 32
  navigating 34
  preferences 53
  printing 177, 180
  productions (reviewers) 222
  protecting data 224
  using with Concordance Image 270
  using with Equivio 191
Concordance Image
  applying redlines 283
  bar code mode 275
  customizing redaction text 281
  defining viewer settings 53
  magnifying records 279
  navigating 271
  printing 177
  productions (reviewers) 222
  redlines 281
  saving images 287
  searching redlines 286
  sending to Sanction 289
  using with Concordance 270
  viewing records 275
Concordance Native Viewer
  adding images and stamps 255
  applying markups 250, 255, 259
  defining viewer settings 53
  editing headers/footers 214
  editing markups 262
  media files 230
  media information pane 231
  monitoring print jobs 217
  navigating 231
  navigating between documents 239
  opening views 241
  printing 177
  printing document sets 207
  printing single documents 203
  productions (reviewers) 222
  toolbars 231
  viewing media files 239
  viewing media information 245
creating
  records 147
  sort layouts 128
  table layouts 131

© 2018 LexisNexis. All rights reserved.
Data exporting data 188
database views in CNV 241
databases about back ups 227 about concatenation (reviewers) 171 concatenating 172 deleting concatenated sets 177 exporting data 188 indexing/reindexing .cat databases 174 opening 47 opening concatenated sets 176 printing concatenated databases 175 saving concatenated database searches 174 saving concatenated sets 175 transcript 154 deleting concatenated sets 177 sort layouts 128 table layouts 131
dictionary 70 adding words to queries 87 Ditto 147
document information pane 231, 245
documents bulk printing 207 Concordance Native Viewer 231 information pane in CNV 231, 245 printing 203

Edit view about 134 adding rich text formatting 145 changing text case 145 editing records 140 removing rich text from a field 145 editing headers/footer/watermarks 214 markups in CNV 262 records 134, 140 searching for edited records 152 e-mail

Comparing in Concordance 191
Equivio using with Concordance 191 Equivio, exporting to 188 error messages 292 exporting Concordance data 188 to CaseMap 188 to Equivio 188 to Microsoft Excel 188

Fields adding rich text formatting 145 adding to queries 87 formatting text 145 populating from a word list 140 populating using Ditto 147 removing rich text formatting from a field 145

Fonts modifying in the Browse view 50 modifying in the Table view 50

Form searches 97

Full-text searches 83
fuzzy searches 87
fuzzy words 87
FYI Administration Console 14
FYI Reviewer about 14
FYI Server about 14

Glossary 318

Headers/footers 214

Hosted FYI 14
hot keys 307

Image applying markup 255
<table>
<thead>
<tr>
<th>- N -</th>
</tr>
</thead>
<tbody>
<tr>
<td>native files</td>
</tr>
<tr>
<td>printing</td>
</tr>
<tr>
<td>navigating</td>
</tr>
<tr>
<td>Concordance Image</td>
</tr>
<tr>
<td>Concordance Native Viewer</td>
</tr>
<tr>
<td>documents</td>
</tr>
<tr>
<td>images in Concordance Image</td>
</tr>
<tr>
<td>notes</td>
</tr>
<tr>
<td>adding to transcripts</td>
</tr>
<tr>
<td>deleting from transcripts</td>
</tr>
<tr>
<td>searching transcript notes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>- O -</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCR on the Fly</td>
</tr>
<tr>
<td>about</td>
</tr>
<tr>
<td>using</td>
</tr>
<tr>
<td>operators</td>
</tr>
<tr>
<td>Boolean</td>
</tr>
<tr>
<td>context</td>
</tr>
<tr>
<td>proximity</td>
</tr>
<tr>
<td>relational search</td>
</tr>
<tr>
<td>Optical Character Recognition (OCR)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>- P -</th>
</tr>
</thead>
<tbody>
<tr>
<td>passwords</td>
</tr>
<tr>
<td>changing your password</td>
</tr>
<tr>
<td>preferences</td>
</tr>
<tr>
<td>defining Concordance settings</td>
</tr>
<tr>
<td>saving print parameters</td>
</tr>
<tr>
<td>printing</td>
</tr>
<tr>
<td>About</td>
</tr>
<tr>
<td>about printing in Concordance</td>
</tr>
<tr>
<td>annotations</td>
</tr>
<tr>
<td>bulk printing</td>
</tr>
<tr>
<td>CNV documents</td>
</tr>
<tr>
<td>editing headers/footers/watermarks</td>
</tr>
<tr>
<td>from concatenated databases</td>
</tr>
<tr>
<td>images</td>
</tr>
<tr>
<td>in the Browse view</td>
</tr>
<tr>
<td>individual records and transcripts</td>
</tr>
<tr>
<td>monitoring print jobs</td>
</tr>
</tbody>
</table>
printing
  PDF 203, 207
  saving image print settings 218
  setting CNV parameters 207
  standard reports 181
  tallying records for reports 196
  TIFF 203, 207
processing OCR text 263, 265
productions
  about (reviewers) 222
  training 224
punctuation 70

- Q -
Quick Marks 156
quick search 75
quotes, relational searches 93

- R -
records
  creating new records 147
  deleting 152
  editing 134, 140
  magnifying in Concordance Image 279
  searching for edited records 152
  sorting 127
  tagging 114
  viewing 48
  viewing in Concordance Image 275
redactions
  applying in CNV 259
  customizing redaction text 281
redlines 283
  about 281
  customizing redaction text 281
  searching 286
reindexing 70
  concatenated databases 174
relational searches
  operators - relational search 93
  quotes 93
  syntax 93
  wildcard characters - relational searches 93
reports
  printing annotation reports 166, 198
  printing standard reports 181
  tallying records for reports 196
Review view
  clearing search queries 108
  reviewing search queries 110
  saving search queries 108
rich text formatting
  adding 145
  removing from a field 145

- S -
saving
  concatenated sets 175
  images 287
searching
  about 70
  adding dictionary words to queries 87
  adding fields to queries 87
  adding fuzzy words to queries 87
  advanced 82
  available search tools 75
  by issues 104, 124
  by tags 104, 124
  by tally 103
  combining search strings 97
  for edited records 152
  full-text 70
  fuzzy 87
  operators - full-text search 83
  operators - relational search 93
  parenthesis 97
  quick search 75
  quotes 93
  redlines 286
  relational 70
  reviewing queries 110
  running complex clause searches 97
  running form searches 97
  running full-text searches 83
  running previous queries 111
  running relational searches 93
  running simple searches 76
  saving in concatenated databases 174
  saving queries 108
  saving search history 108
  stopwords 70
  synonyms 105
Index 331

searching
  transcript notes 156
  using the Advanced Search panel 87
  wildcard characters - full-text searches 83
  wildcard characters - relational searches 93
sending images, to Sanction 289
shortcuts 307
simple searches 76
snapshots
  about 225
  Auto-restore 225
  restoring 225
  saving 225
sort layouts
  using 128
split screen view 48
stamps, applying to documents 255
sticky rotate 279
sticky zoom 279
stopwords
  for searching 70
supported files, CNV 230
synonyms, creating 105

- T -
table layouts
  using 131
Table view
  modifying fonts 50
  running a field tally 103
  sorting by fields 127
  viewing records 48
tag history 124
tag statistics 125
tags 160
  about tagging 112
  applying issue tags to transcripts 160
  creating folders 119
  creating personal folders 119
  creating personal tags 119
  creating queries from a tag 114
  creating queries from folders 122
  creating queries from multiple tags 122
document versus issue tags 160
searching by issue tags 104, 124
searching by tags 104, 124
tagging records 114
  viewing statistics 125
  viewing tag history 124
tally
  for reports 196
  searching by 103
training
  for productions 224
transcripts 156
  about 154
  adding attachments 162
  adding notes 156
  adding Quick Marks 156
  applying issue tags 160
database 154
printing annotations 166, 198
printing individual transcripts 180
reviewing notes and issues 164
searching notes 156

- V -
viewing
  CNV toolbar 239
  CNV view toolbar 231
  media files 241
  media information pane 245
  records 279
  sort layouts 128
  table layouts 131
tag history 124
tag statistics 125

- W -
watermarks 214
wildcard characters
  full-text searches 83
  relational searches 93
word lists
  adding values 140
  deleting values 140
  opening 140
  populating fields with 140

- Z -
zoom 279